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 1 Введение 

Хроматографические системы NGC™ предлагают универсальную платформу для 

очистки всех типов биомолекул различными хроматографическими методами. 

Системы также позволяют разрабатывать и оптимизировать протоколы очистки. Они 

обеспечивают высокую очистку белков, пептидов, нуклеиновых кислот, 

моноклональных антител и других малых молекул. 
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Программное обеспечение ChromLab™ позволяет производить настройку и 

управление прибором NGC, разделять белки и выполнять другие операции в ручном 

режиме, программировать протоколы автоматической очистки, производить оценку 

результатов, а также генерировать и выводить на печать протоколы экспериментов. 

Данное руководство содержит инструкции по выполнению всех перечисленных 

задач. 

Основные функции системы NGC 

Хроматографические системы NGC позволяют: 

■ простое создание протоколов очистки и технического обслуживания на основе 

готовых шаблонов и фаз протоколов 

■ автоматическую многоколоночную очистку с использованием предварительно 

запрограммированных шаблонов протоколов и клапанов переключения колонок 

■ автоматический ввод нескольких образцов с использованием или 

инжекционного клапана и насоса для образца, или автосамплера C-96 

■ расширение возможностей контроля образцов с помощью модуля импорта 

сигналов (SIM) для экспорта и импорта цифровых сигналов на внешние датчики 

и от внешних датчиков 

■ сбор крупных фракций с помощью нескольких выходных клапанов с 

одновременным сбором мелких фракций с помощью коллектора фракций 

BioFrac™ 

■ автоматическую подготовку буферов с использованием предварительно 

запрограммированных протоколов смешивания буферов 

■ анализ результатов очистки через интегрирование пиков одним нажатием 

кнопки мыши, определение концентрации белков и расчет эффективности 

колонки 

■ оптимизацию автоматического протокола очистки с помощью программного 

средства поиска 

■ простое определение местоположения фракций, содержащих целевые пики, и 

определение концентрации белков в пределах каждой фракции 

■ расширение возможностей предварительно сконфигурированных систем за 

счет использования дополнительных клапанов для буферов, образцов и 

колонок 
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■ расположение модулей в порядке, обеспечивающем оптимальные 

характеристики разделения в зависимости от производительности и сложности 

методов, и минимизацию рабочего объема жидкости в системе 

■ минимизацию ошибок при подключении капилляров с помощью функции Point-

to-Plumb™ программного обеспечения ChromLab 
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Хроматографические системы NGC 

Все хроматографические системы NGC включают программное обеспечение 

ChromLab и сенсорный экран NGC. 

 

Хроматографические системы NGC доступны в нескольких исполнениях. Каждая 

система оснащена двумя системными насосами с расходом 10 мл/мин (серия 10) 

или двумя системными насосами с расходом 100 мл/мин (серия 100). 

Хроматографическая система NGC Quest™ включает: 

■ Два системных насоса 

■ Смеситель 

■ Инжекционный клапан 

■ Кондуктометрический детектор или с одноволновым УФ-детектором, или с 

многоволновым фотометрическим детектором (доступен на системах серии 

Plus) 
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Хроматографическая система NGC Scout™ включает: 

■ Все модули системы Quest 

■ Клапан-регулятор уровня pH 

■ Смесительный клапан для буферных растворов 

Хроматографическая система NGC Discover™ включает: 

■ Все модули системы Scout 

■ Клапан переключения колонок 

■ Два клапана переключения буферных растворов 

■ Насос для образца 

Хроматографическая система NGC Discover Pro: 

■ Все модули системы Discover 

■ Четвертый расширительный ярус 

■ Клапан выбора образца 

■ Выходной клапан 
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Узнайте больше 

После загрузки документации по системе NGC с DVD «Документация 

хроматографических систем NGC» вы получите доступ к руководству и учебникам 

NGC в меню «Справка» любой версии ChromLab. 

Более подробную информацию о хроматографических системах NGC и 

программном обеспечении ChromLab можно получить из следующих источников: 

■ Руководство по установке хроматографических систем NGC и программного 

обеспечения ChromLab доступно на DVD «Документация хроматографических 

систем NGC» в виде файлов .pdf. Данное руководство описывает условия 

эксплуатации, процессы установки и настройки системы NGC в лаборатории, 

установки ПО ChromLab и подключения ПО ChromLab к системе NGC. 

■ Руководство по эксплуатации хроматографических систем NGC и программного 

обеспечения ChromLab доступно на DVD «Документация хроматографических 

систем NGC» в виде файлов .pdf. Данное иллюстрированное руководство 

приводит подробное описание модулей, входящих в состав прибора NGC, и 

включает руководство по поиску и устранению неисправностей и инструкции по 

техническому обслуживанию. 

■ Для открытия «Справки» ПО ChromLab и получения доступа к соответствующей 

информации щелкните на вопросительном знаке в верхнем правом углу 

диалогового окна. Справка также доступна в меню «Справка» (Help). 

■ Видеоучебники NGC доступны на DVD «Документация хроматографических 

систем NGC» в виде файлов .mp4. 

Совет: Щелкнув на логотип Bio-Rad в левом верхнем углу любого окна ПО 

ChromLab, вы можете перейти на сайт Bio-Rad. 
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 2 Рабочее пространство 

ПО ChromLab™ предоставляет интуитивно-понятный интерфейс для разработки 

хроматографических методов, управления прибором NGC™ и анализа результатов 

экспериментов. 

ПО ChromLab представляет четыре основных рабочих пространства. 

■ Начальный экран Home 

■ Окно System Control (Управление системой) 

■ Окно Method Editor (Редактор методов) 

■ Окно Evaluation (Оценка) 

В данной главе приведено описание каждого рабочего пространства. Также 

приводится описание сенсорного экрана прибора NGC. 
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Начальный экран Home 

ПО ChromLab открывается с начального экрана Home, отображающего три секции и 

закладку System Control. 

 

Три секции окна предоставляют быстрый доступ к рабочим пространствам 

управления системой, редактора методов и оценки. Также отображается состояние 

соединения с прибором NGC. В нижней части окна располагается перечень ссылок 

на протоколы недавно проведенных анализов, недавно созданные методы и 

недавно посещенные или проанализированные протоколы анализов. 

Совет: Щелкнув на логотип Bio-Rad в левом верхнем углу любого окна ПО 

ChromLab, вы можете перейти на сайт Bio-Rad. 
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Закладки Method Editor и Evaluation появляются в окне Home при выборе задач в 

секциях Method Editor и Evaluation. 
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Опции меню File (Файл) 

Connect to System (Подключить к системе) — открывает диалоговое окно, 

позволяющее выбрать хроматографическую систему, к которой будет подключен 

компьютер. ПО ChromLab детектирует системы NGC, доступные в той же подсети, 

или системы, непосредственно подключенные к компьютеру. В таблице появляются 

имя системы, имя сети и IP-адрес. Подключиться к системе можно одним из 

следующих способов: 

■ Выберите имя в списке обнаруженных систем и щелкните на Connect 

(Подключить). 

 Примечание: Если система отсутствует в списке, щелкните на Detect 

(Детектировать). ПО ChromLab осуществит поиск доступных в сети систем 

NGC и обновит список. 

■ Выберите соответствующую зависимую кнопку, введите имя системы или 

IP-адрес и щелкните на Connect. 

 Совет: Для получения имени системы или IP-адреса выберите в 

ниспадающем меню на сенсорном экране System Information (Информация 

о системе). 

Disconnect System (Отключить от системы) — при запуске ПО ChromLab 

соединяется с системой NGC. Данная команда позволяет отключать ПО ChromLab 

от системы, после чего вы можете работать с ней автономно. 

Manual Run (Ручной режим) — открывает окно System Control в ручном режиме, 

позволяя проводить анализ или настраивать систему в ручном режиме. 

Calibrate (Калибровать) — открывает диалоговое окно Calibration (Калибровка), 

отображающее инструкции и опции для выбора модуля и его калибровки. Более 

подробная информация приведена в разделе «Калибровка» на стр. 66. 

Open Template (Открыть шаблон) — открывает диалоговое окно Template 

(Шаблон), в котором вы можете выбрать шаблон метода из папок, организованных 

по методам. 

Open Method (Открыть метод) — открывает диалоговое окно Method (Метод), в 

котором вы можете выбрать метод из списка сохраненных методов. 

New Method (Новый метод) — открывает окно Method Editor, в котором вы можете 

создать метод, используя стандартные фазы и шаги.  
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Import (Импортировать) — отображает ссылки, из которых можно импортировать: 

■ NGC File (Файл NGC) — открывает диалоговое окно, в котором вы можете 

импортировать метод, метод с протоколами анализа или протокол анализа, 

экспортированный из ПО ChromLab, выполняемом на другой системе NGC. 

Более подробная информация приведена в разделе «Импорт метода или 

протокола анализа NGC» на стр. 263. 

■ Unicorn Data (Данные Unicorn) — открывает диалоговое окно, в котором 

можно осуществлять импорт файла данных Unicorn в базу данных NGC. 

Более подробная информация приведена в разделе «Импорт файлов 

данных Unicorn» на стр. 265. 

■ DuoFlow Data (Данные DuoFlow) — открывает диалоговое окно, в котором 

можно осуществлять импорт файла данных BioLogic DuoFlow™ в базу 

данных NGC. Более подробная информация приведена в разделе «Импорт 

файлов данных BioLogic DuoFlow» на стр. 267. 

Import (Экспортировать) — отображает ссылки, из которых можно импортировать: 

■ Methods/Method Runs (Методы/Протоколы) — открывает диалоговое 

окно, в котором можно осуществлять экспорт как одного, так и нескольких 

методов, а также одного или нескольких методов с соответствующими 

протоколами анализов. 

■ Runs (Протоколы анализов) — открывает диалоговое окно, в котором 

можно осуществлять экспорт одного или нескольких протоколов анализов. 

Более подробная информация приведена в разделе «Экспорт данных в виде 

файла NGC» на стр. 269. 

Open Run/Analysis (Открыть протокол/анализ) — открывает диалоговое окно, в 

котором можно выбрать для просмотра или анализа протокол или анализ. 

Preferences (Глобальные параметры) — открывает диалоговые окна, 

позволяющие осуществлять следующие действия: 

■ Выбирать единицы давления для всех системных и программных величин 

давления. Это основная настройка. 

■ Настраивать сервер SMTP для приема сообщений о состоянии системы от 

компьютера с ПО ChromLab, передаваемых по электронной почте. 

Exit (Выход) — закрывает ПО ChromLab. 
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Опции меню Help (Справка) 

Help (Справка) — отображает тематические разделы и ссылки на установленные 

руководства. 

Export Diagnostic Logs (Экспортировать журналы диагностики) — открывает 

диалоговое окно Export Diagnostic Logs, в котором можно осуществлять экспорт всей 

важной информации, необходимой Службе технической поддержки Bio-Rad для 

диагностических целей. Файлы регистрации и данные архивируются и сохраняются в 

указанном вами месте. Более подробная информация приведена в разделе 

«Экспорт журналов диагностики» на стр. 275. 

About (О программе) — отображает  информацию об авторском праве и версии ПО 

ChromLab. 
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Окно System Control (Управление системой) 

Окно System Control позволяет управлять прибором в ручном режиме, 

контролировать выполнение протокола по заданному методу, выбирать схему 

жидкостного тракта, калибровать насосы и датчики, и проверять правильность 

подключения системы капилляров прибора. Данное окно также отображает 

хроматограмму в ходе эксперимента. Схема жидкостного тракта графически 

изображает круг циркуляции потока жидкости всех модулей системы. Над каждым 

модулем появляется панель состояния, отображающая состояние модуля в 

реальном времени. В ручном режиме щелчок на модуле отображает его элементы 

управления и настройки. Каждое действие, совершаемое в ходе выполнения 

протокола анализа, регистрируется в рабочем журнале. В закладке Run Queue 

(Очередь готовых к выполнению задач) перечисляются все протоколы анализов, 

готовые к запуску. 

 

Функции окна System Control подробно описаны в главе 3 «Управление системой». 
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Окно Method Editor (Редактор методов) 

Окно Method Editor позволяет открывать, создавать, просматривать, редактировать и 

реализовывать метод. Вы также можете создать новый шаблон, открыв и 

отредактировав шаблон метода. Функции окна Method Editor подробно описаны в 

главе 5 «Редактор методов». См. также главу 6 «Создание метода». 
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Окно Evaluation (Оценка) 

Окно Evaluation позволяет осуществлять просмотр и сравнение результатов 

анализа, интегрирование пиков и сохранение результатов. Подробное описание 

функций окна Evaluation приведены в главе 7 «Оценка результатов». 
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Сенсорный экран управления прибором 

В дополнение к ПО ChromLab, выполняемому на компьютере, прибор оснащен 

сенсорным экраном, обеспечивающим доступ к функциям управления системы. Вы 

можете использовать данный сенсорный экран для проведения анализа, управления 

и контроля процесса анализа независимо от программного обеспечения ChromLab. 

Более подробная информация приведена в Разделе «Управление системой» на 

стр. 31. 

Совет: В случае, когда система NGC находится в неактивном режиме в течение двух 

часов, светодиодные индикаторы прибора гаснут, сенсорный экран становится 

тусклым, и появляется диалоговое окно, информирующее пользователя о том, что 

система находится в режиме ожидания. Вывести систему из режима ожидания 

можно касанием кнопки OK в диалоговом окне, запуском системных насосов 

инициированием ручного режима или метода, или щелчком на модуле на схеме 

жидкостного тракта, оснащенной светодиодным индикатором. 
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Опции меню сенсорного экрана 

Calibrate (Калибровать) — открывает диалоговое окно Calibration (Калибровка), 

отображающее инструкции и опции для выбора модуля и его калибровки. Более 

подробная информация приведена в разделе «Калибровка модуля» на стр. 66. 

Point-to-Plumb — запускает функцию Point-to-Plumb™ и одновременно выключает 

светодиодные индикаторы прибора, предоставляя возможность визуальной 

проверки или изменения подключений системы капилляров прибора. Отображает 

текущую схему жидкостного тракта. Подробная информация приведена в разделе 

«Проверка системы капилляров с помощью функции Point-to-Plumb» на стр. 69. 

Change Fluidic Scheme (Изменить схему жидкостного тракта) — открывает 

диалоговое окно Fluidic Scheme Selector (Переключатель схемы жидкостного тракта), 

в котором вы можете отредактировать или выбрать схему жидкостного тракта. Более 

подробная информация приведена в разделе «Конфигурации схемы жидкостного 

тракта» на стр. 53. 

Map Fluidic Scheme (Картировать схему жидкостного тракта) — открывает 

диалоговое окно Fluidic Scheme Mapping (Картирование схемы жидкостного тракта), 

в котором вы можете проецировать устройства прибора на схему жидкостного 

тракта. Более подробная информация приведена в разделе «Картирование схемы 

жидкостного тракта» на стр. 62. 

System Settings (Настройки системы) — открывает диалоговое окно System 

Settings (Настройки системы), в котором вы можете устанавливать системные 

настройки. Более подробная информация по установке настроек системы приведена 

в разделе «Настройки системы» на стр. 71. 

System Information (Сведения о системе) — открывает диалоговое окно System 

Information (Сведения о системе), содержащее серийный номер и другую общую 

информацию об устройстве NGC, компонентах системы, процессах, а также УФ-

детекторе и фотометрическом детекторе. 

Service (Обслуживание) — только для персонала по техническому обслуживанию 

компании Bio-Rad. Не выбирать данную команду. 

Help (Справка) — отображает подробную информацию об опциях меню сенсорного 

экрана. 

About (О программе) — отображает информацию об авторском праве и версии ПО 

ChromLab. 

Shut Down (Выключение) — выключает систему NGC, включая подсоединенный 

компьютер. 
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Опции панели инструментов сенсорного экрана 

Save (Сохранить) — сохраняет в файле данных шаги анализа, проводимого в 

ручном режиме. 

Clear (Сбросить) — удаляет данные анализа, проводимого в ручном режиме, с 

сенсорного экрана. 

Autoscale (Автоматическое масштабирование) — производит автоматическое 

масштабирование основной оси Y по самому высокому пику во время анализа. 

Функция автоматического масштабирования активируется по умолчанию. 

Reset Zoom (Отменить масштабирование) — возвращает изображение к 

масштабу, позволяющему отображать хроматограмму полностью. 

Annotate (Снабдить примечанием) — добавляет примечание к хроматограмме в 

точках по оси X во время или после завершения анализа. 
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 3 Управление системой 

Окно System Control программного обеспечения ChromLab™ является главным 

интерфейсом с прибором хроматографической системы NGC™. Данный интерфейс 

также появляется на сенсорном экране прибора. Настройки окна System Control 

позволяют выполнять анализ в ручном режиме, управлять и контролировать ход 

протокола по выбранному методу, проверять систему капилляров с помощью 

функции Point-to-Plumb™, осуществлять управление и калибровку системы, а также 

проецировать два или более клапанов одного типа прибора на схему жидкостного 

тракта. 

Окно Home предоставляет доступ к окну System Control через закладку System 

Control. 

Окно System Control (Управление системой) 

Окно System Control содержит визуализатор хроматограмм и графическую схему 

жидкостного тракта. Хроматограмма – это представление данных анализа в 

зависимости от времени, объема или объема колонки, полученных от прибора. 

Схема жидкостного тракта – это представление состояния прибора и потока в 

реальном масштабе времени. 

Для улучшения просмотра можно максимально увеличить хроматограмму или схему 

жидкостного тракта с помощью кнопок Expand (Развернуть) в правой части окна. 

Данная опция особенно полезна при просмотре данных с сенсорного экрана. 

Схема жидкостного тракта графически отображает поток жидкости между модулями, 

а также конфигурацию и схему подключения системы для конкретного эксперимента. 

Рядом с каждым изображением модуля отображается его статус в реальном 

масштабе времени. Для анализов, проводимых в ручном режиме, в секции Run Log 

(Рабочий журнал) отображается перечень выполненных команд. В режиме 

выполнения анализа по разработанному методу в соответствующих закладках 

появляются фазы и шаги выполняемого протокола наряду с элементами управления 

для останова или приостановки анализа. Секция Run Queue содержит перечень всех 

готовых к выполнению протоколов анализов. Секция Run Queue доступна как в 

ручном режиме, так и в режиме выполнения протокола по заданному методу. 
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УСЛОВНЫЕ ОБОЗНАЧЕНИЯ 

1 Строка меню предоставляет быстрый доступ к опциям меню File (Файл), View 

(Просмотр), Manual (Ручной режим), Tools (Инструменты) и Help (Справка). 

2 Закладки обеспечивают быструю навигацию между открытыми окнами (Home, 

System Control, Method Editor и Evaluation). 

3 Панель инструментов закладки содержит опции для сохранения текущего 

протокола анализа, автоматического масштабирования линии УФ-детектора, 

изменения вида хроматограммы, снабжения хроматограммы примечаниями и 

удаления с экрана данных анализа, проводимого в ручном режиме. 

4 Кнопки Expand разворачивают выбранную секцию до размера экрана. 

5 Визуализатор хроматограмм отображает данные, полученные от прибора, в виде 

линий в координатах времени, объема или объема колонки. 

6 Условные обозначения хроматограммы согласовывают каждую линию с 

соответствующим типом и цветом и отображают длину волны в нанометрах для 

линий УФ-детектора. Линии детекторов можно отобразить или скрыть, щелкнув на 

них. 

7 В ручном режиме секция Run Log представляет запись шагов и событий анализа с 

метками времени. В режиме выполнения анализа по заданному методу данные 

анализа появляются в закладках Method Editor Phases (Фазы редактора методов) и 

Step (Шаг). В обоих режимах закладка Run Queue приводит перечень готовых к 

выполнению протоколов анализов. 

8 Секция Fluidic Scheme графически отображает конфигурации и способы 

подключения модулей для конкретного эксперимента. 
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Опции меню File (Файл) 

Connect to System (Подключить к системе) — подключает компьютер к системе 

NGC, если он еще не подключен. В появившемся диалоговом окне введите имя DNS 

системы NGC и щелкните на Connect (Подключить). 

Disconnect System (Отключить от системы) — при запуске ПО ChromLab вы 

автоматически входите в систему NGC, к которой подключен ваш компьютер. Данная 

команда позволяет отключать ПО ChromLab от системы, после чего вы можете 

работать с ней автономно. 

System Settings (Настройки системы) — открывает диалоговое окно System 

Settings (Настройки системы), в котором вы можете устанавливать системные 

настройки. Более подробная информация по установке настроек системы приведена 

в разделе «Настройки системы» на стр. 71. 

System Information (Сведения о системе) — открывает диалоговое окно System 

Information (Сведения о системе), содержащее серийный номер и другую общую 

информацию об устройстве NGC, компонентах системы, процессах, а также УФ-

детекторе и фотометрическом детекторе. Более подробная информация приведена 

в Разделе «Сведения о системе» на стр. 88. 

Preferences (Глобальные параметры) — открывает диалоговые окна, 

позволяющие осуществлять следующие действия: 

■ Выбирать единицы давления для всех системных и программных величин 

давления. Это основная настройка. 

■ Настраивать сервер SMTP для отправки сообщений по электронной почте о 

состоянии системы от компьютера с ПО ChromLab. Более подробная 

информация о настройке сервера SMTP приведена в разделе «Глобальные 

параметры» на стр. 91. 

Exit (Выход) — закрывает ПО ChromLab. 

Опции меню View (Просмотр) 

Show Chromatogram (Отобразить хроматограмму) — отображает хроматограмму 

данных текущего анализа. Сброс данной команды скрывает хроматограмму. 

Show Fluidics (Отобразить схему жидкостного тракта) — отображает схему 

жидкостного тракта. Сброс данной команды скрывает схему жидкостного тракта. 
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Опции меню Manual (Ручной режим) 

Enter/Exit Manual Mode (Ручной режим ВКЛ./ВЫКЛ.) — переключает ПО ChromLab 

между ручным и автоматическим режимами. 

Save Recorded Manual Run (Сохранить зарегистрированный анализ, 

выполненный в ручном режиме) — в ручном режиме сохраняет в файле данных 

шаги анализа, выполненного в ручном режиме. 

Clear Recorded Data (Сбросить записанные данные) — удаляет с экрана данные 

анализа, выполненного в ручном режиме. 

Опции меню Tools (Инструменты) 

Calibrate (Калибровать) — открывает диалоговое окно Calibration (Калибровка), 

отображающее инструкции и опции для выбора модуля и его калибровки. Более 

подробная информация приведена в разделе «Калибровка модуля» на стр. 66. 

Point-to-Plumb — запускает функцию Point-to-Plumb™ и одновременно выключает 

светодиодные индикаторы прибора, предоставляя возможность визуальной проверки 

местоположений портов во время подключения системы капилляров прибора. 

Отображает текущую схему жидкостного тракта. Серыми линиями указан путь потока 

жидкости. Щелчок на линии в окне включает светодиодные индикаторы прибора, 

соответствующие подключаемым портам. Подробная информация приведена в разделе 

«Проверка системы капилляров с помощью функции Point-to-Plumb» на стр. 69. 

Change Fluidic Scheme (Изменить схему жидкостного тракта) — открывает 

диалоговое окно Fluidic Scheme Selector (Переключатель схемы жидкостного тракта), 

в котором вы можете отредактировать или выбрать схему жидкостного тракта. Более 

подробная информация приведена в разделе «Конфигурации схемы жидкостного 

тракта» на стр. 53. 

Map Fluidic Scheme (Картировать схему жидкостного тракта) — открывает 

диалоговое окно Fluidic Scheme Mapping (Картирование схемы жидкостного тракта), 

отображающее местоположения двух или более клапанов одного типа на схеме 

жидкостного тракта, например, двух или более входных клапанов или клапанов 

переключения колонок. Можно использовать данное диалоговое окно для 

проецирования устройства прибора на схему жидкостного тракта. Более подробная 

информация приведена в разделе «Картирование схемы жидкостного тракта» на стр. 62. 

Flow Rate Converter (Преобразователь скорости потока) — открывает 

преобразователь скорости потока, позволяющий определять скорость потока для 

каждой колонки в протоколе анализа, выполняемого по заданному методу, на 

основании размера колонки и введенной начальной скорости. Значение скорости, 

введенное в «мл/мин», преобразуется в «см/ч» и «л/ч»; значение скорости, 

введенное в «см/ч», преобразуется в «мл/мин» и «л/ч». Можно скопировать 

результат в преобразователе и вставить его в метод. 
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Опции меню Help (Справка) 

Help (Справка) — отображает тематические разделы и ссылки на установленные 

руководства. 

Export Diagnostic Logs (Экспортировать журналы диагностики) — открывает 

диалоговое окно Export Diagnostic Logs, в котором можно осуществлять экспорт всей 

важной информации, необходимой Службе технической поддержки Bio-Rad для 

диагностических целей. Файлы регистрации и данные архивируются и сохраняются в 

указанном вами месте. Более подробная информация приведена в разделе 

«Экспорт журналов диагностики» на стр. 275. 

About (О программе) — отображает информацию об авторском праве и версии ПО 

ChromLab. 

Опции панели инструментов 

Save (Сохранить) — сохраняет в файле данных шаги анализа, проводимого в 

ручном режиме. 

Clear (Сбросить) — удаляет данные анализа, проводимого в ручном режиме, с экрана. 

Autoscale (Автоматическое масштабирование) — производит автоматическое 

масштабирование основной оси Y по самому высокому пику во время анализа. 

Функция автоматического масштабирования активируется по умолчанию. Когда 

данная функция деактивирована, вы можете изменять значение каждой отдельной 

линии УФ-детектора. Режим автоматического масштабирования и значения линии 

УФ-детектора сохраняются при сохранении протокола анализа. 

Reset Zoom (Отменить масштабирование) — возвращает изображение к 

масштабу, позволяющему отображать хроматограмму полностью. 

Annotate (Снабдить примечанием) — добавляет примечание к хроматограмме в 

точках по оси X во время или после завершения анализа. 

Опции контекстного меню 

Для доступа к опциям контекстного меню 

► Щелкните правой кнопкой мыши на хроматограмме и выберите команду из 

появившегося меню. 

Undo Zoom (Отменить масштабирование) — немедленно восстанавливает 

предыдущий уровень масштабирования. 

Reset Zoom (Отменить масштабирование) — возвращает изображение к 

масштабу, позволяющему отображать хроматограмму полностью. 
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Autoscale (Автоматическое масштабирование линии УФ-детектора) — 

производит автоматическое масштабирование основной оси Y по самому высокому 

пику во время анализа. Когда данная функция активна, масштаб линии УФ-

детектора не может быть задан в ручном режиме. Когда данная функция 

деактивирована, вы можете изменять значение каждой отдельной линии УФ-

детектора. Режим автоматического масштабирования и значения линий УФ-

детектора сохраняются при сохранении протокола анализа. 

Copy Chromatogram (Копировать хроматограмму) — копирует хроматограмму в 

буфер обмена, откуда ее можно вставить в другое приложение. 

Save Chromatogram As (Сохранить хроматограмму как) — сохраняет 

хроматограмму в выбранном вами формате изображения (.bmp, .gif, .jpeg, .png или 

.tiff). 

Export as .csv (Экспортировать как .csv) — экспортирует данные анализа в виде 

файла .csv, который может быть открыт в приложениях для работы с электронными 

таблицами. 
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Вид хроматограммы 

Хроматограмма отображает сбор данных во время анализа в реальном времени, а 

также результаты анализа. Она также отображает качество очистки. Хроматограмма 

записывается только при работающих насосах и сборе данных детекторами схемы 

жидкостного тракта. Хроматограмма отображает сбор данных во время анализа в 

реальном времени, а также результаты анализа. Она также отображает качество 

очистки. Хроматограмма записывается только при работающих насосах и сборе 

данных детекторами схемы жидкостного тракта. 

Условные обозначения хроматограммы согласовывают каждую окрашенную линию с 

соответствующим детектором. При разворачивании условных обозначений можно 

скрыть линии, отменив выбор кнопки-флажка рядом с линией, отредактировать 

цвета линий для проведения различий между ними и изменить масштаб оси Y линии. 

Подробная информация приведена в разделах «Изменение цветов линий 

хроматограммы» на стр. 211 и «Изменение параметров осей» на стр. 210. 

 

Когда запускается протокол анализа, визуализатор хроматограмм в окне System 

Control отображает данные, получаемые от детекторов, в виде линий в координатах 

времени, объема или объема колонки. При помещении указателя на линию 

отображается всплывающая подсказка со значениями по оси X и основной (левой) 

оси Y линии в данном положении. Условные обозначения также отображают 

значение длины волны в нанометрах для линий УФ-детектора. 
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Можно развернуть хроматограмму или схему жидкостного тракта, щелкнув на 

стрелке в верхнем правом углу соответствующей секции окна. Данная опция 

особенно удобна для просмотра хроматограммы на сенсорном экране. События, 

возникающие в ходе анализа, такие как переключения клапанов или изменение 

определенных параметров, появляются в виде маркеров событий. События ошибок, 

такие как избыточное давление, выделяются красным цветом. Данный экран также 

отображает события сбора фракций и местоположения фракций на выбранном 

штативе. 

 

Хроматограмма имеет две оси Y. Левая ось является основной. Ее линией по 

умолчанию является оптическая плотность ультрафиолета. Проводимость - линия 

по умолчанию для правой оси. Хроматограмма также отображает следующие линии, 

определенные в Таблице 1: 

■ Одноволновое/многоволновое УФ-излучение 

■ Проводимость 

■ pH 

■ Температура 

■ Градиент 

■ Давление 

□ Давление в предколонке 

□ Разница давлений в колонках 

■ Скорость потока 
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Таблица 1. Определения линий хроматограммы 

Линия Модуль Описание 

UV λ 1-4  

(λ 1-4-волнового 

УФ-излучения) 

Одноволновый УФ-

детектор и многоволновый 

фотометрический детектор  

УФ-детектор – с модулем одноволнового УФ-

детектора, показания оптической плотности 

Многоволновый детектор – с модулем 

многоволнового фотометрического детектора, до 

четырех показаний (λ 1-4) 

Conductivity 

(Проводимость) 

Одноволновый УФ-

детектор и многоволновый 

фотометрический детектор  

Значение проводимости жидкости, считанное 

кондуктометрическим детектором (мСм/см) 

%B 

(Теоретический 

градиент насоса B, 

%)  

Системный насос Программируется пользователем при разработке 

метода или в диалоговом окне System Pump 

(Системный насос) 

■ Градиент, системный насос: % от насоса B 

■ Градиент, смесительный клапан: % от клапана Q4 

■ Смесительный клапан для буферных растворов: 

% от клапана Q4 

pH Theoretical 

(Теоретический 

pH) 

pH Теоретический индекс pH, запрограммированный при 

разработке метода или в диалоговом окне System 

Pump (Системный насос). Доступен только тогда, 

когда смесительный клапан для буферов находится в 

режиме смешивания буферов 

pH pH Показания датчика pH, доступные только при наличии 

клапана детектора pH 

System Pressure 

(Давление в 

системе) 

Системный насос Измеряется на смесителе (фунты/кв. дюйм или МПа) 

PreCol Pressure 

(Давление в 

предколонке) 

Клапан переключения 

колонок 
Измеряется при наличии не менее одного клапана 

переключения колонок 

Совет: При наличии двух или более клапанов 

переключения колонок линии выделяются на 

хроматограмме различными градациями зеленого. 

Номер линии соответствует номеру клапана на схеме 

жидкостного тракта. Например, линия PreCol 

Pressure 1 в условных обозначениях и на 

хроматограмме соответствует клапану C1 на схеме 

жидкостного тракта. 
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Таблица 1. Определения линий хроматограммы (продолжение) 

Линия Модуль Описание 

ΔCoI Pressure 

(Разница давлений 

в колонках) 

Клапан переключения 

колонок 
Измеряется при наличии не менее одного клапана 

переключения колонок 

Совет: При наличии двух или более клапанов 

переключения колонок линии выделяются на 

хроматограмме различными градациями синего. 

Номер линии соответствует номеру клапана на схеме 

жидкостного тракта. Например, линия ΔCoI Pressure 1 

в условных обозначениях и на хроматограмме 

соответствует клапану C1 на схеме жидкостного 

тракта. 

Sample Pump 

Pressure 

(Давление насоса 

для образца) 

Насос для образца Давление насоса для образца (фунты/кв. дюйм или 

МПа) 

Temperature 

(Температура) 

Одноволновый УФ-

детектор и многоволновый 

фотометрический детектор  

Температура жидкости, считанная на модуле 

одноволнового УФ-детектора или многоволнового 

фотометрического детектора 

Flow Rate 

(Скорость потока) 
Системный насос Текущая скорость потока системы (мл/мин) 

Sample Pump Flow 

Rate 

(Производительно

сть насоса для 

образца) 

Насос для образца Производительность насоса для образца (мл/мин) 

Настройка параметров отображения хроматограммы 

Вы можете изменить атрибуты отображения линий и настроить другие параметры 

отображения в окне System Control. Изменения следующих параметров сохраняются 

и используются при отображении данных последующих анализов: 

■ Отображение/скрытие линии 

■ Цвет линии 

■ Диапазон шкалы оси Y линии (минимальный/максимальный масштабные 

коэффициенты оси Y) 

■ Активные единицы масштаба оси X 

■ Отображение/скрытие событий, фракций, ошибок и примечаний 
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При сохранении протокола анализа, выполняемого в ручном режиме или по 

выбранному методу, все настройки сохраняются вместе с ним. При открытии 

протокола анализа в окне Evaluation отображаются новые настройки. Некоторые 

параметры отображения хроматограммы, измененные с компьютера, автоматически 

изменяются при отображении хроматограммы на сенсорном экране, и наоборот. 

Нижеперечисленные атрибуты отображения синхронизируются: 

■ Отображение/скрытие линии 

■ Цвет линии  

■ Диапазон шкалы оси Y линии (минимальный/максимальный масштабные 

коэффициенты оси Y)  

■ Автоматическое масштабирование (вкл/выкл) 

■ Активные единицы масштаба оси X 

■ Отображение/скрытие событий, фракций, ошибок и примечаний 

■ Активный масштаб оси Y (выбранный масштаб оси Y линии) 

Отображение или скрытие линий хроматограммы 

Для отображения или скрытия линии 

1. Разверните условные обозначения хроматограммы. 

2. Выберите или отметьте выбор линии для ее отображения или скрытия. 

Совет: Инструкции по отображению всех скрытых линий приведены в разделе 

«Закладка Trace Settings (Настройки линий хроматограммы)» на стр. 76. 
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Изменение цветов линий хроматограммы 

Для изменения цвета линии 

1. Разверните условные обозначения и щелкните на цвете линии в столбце Edit 

(Редактировать). 

2. В диалоговом окне Color (Цвет) выберите цвет и щелкните на OK. 

 

Совет: Инструкции по возврату цветов линий к заводским настройкам по умолчанию 

приведены в разделе «Закладка Trace Settings (Настройки линий хроматограммы)» 

на стр. 76. 

Увеличение и уменьшение изображения 

Для увеличения изображения участка хроматограммы 

► Щелкнув на хроматограмме и удерживая кнопку мыши, «перетащите» 

указатель, выделив интересующую вас область. 

Для возврата к предыдущему масштабу  

► Дважды щелкните или щелкните правой кнопкой мыши на хроматограмме и 

выберите Undo Zoom в появившемся меню. 

Для перехода к полномасштабному изображению 

► Щелкните на Reset Zoom на панели инструментов закладки или щелкните 

правой кнопкой мыши на хроматограмме и выберите Reset Zoom в 

появившемся меню. 
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Изменение единиц и масштаба оси Х 

Для анализов, выполняемых по сохраненным методам, единицы оси Х могут быть 

изменены в единицы времени в минутах (Time (min)), объема в миллилитрах (Volume 

(ml)) или объема колонки (Column Volume (CV)). Для анализов, выполняемых в 

ручном режиме, единицы оси Х могут быть изменены в единицы времени в минутах 

(Time (min)) или объема в миллилитрах (Volume (ml)). 

Для изменения единиц и масштаба оси Х 

► Щелкните на заголовке оси Х для переключения между доступными опциями. 

Изменение масштабных коэффициентов оси Y 

Для задания масштаба хроматограммы можно изменить максимальный и 

минимальный масштабные коэффициенты оси Y в условных обозначениях. 

Для изменения масштабных коэффициентов оси Y 

1. Разверните условные обозначения в представлении хроматограммы. 

2. Введите максимальное и минимальное значения в соответствующей строке 

линии, убедившись, что максимальное значение больше минимального. 

Совет: Инструкции по возврату масштабных коэффициентов к заводским 

настройкам по умолчанию приведены в разделе «Закладка Trace Settings (Настройки 

линий хроматограммы)» на стр. 76. 

Автоматическое масштабирование линии УФ-детектора 

Функция автоматического масштабирования линии УФ-детектора изменяет масштаб 

основной оси Y для УФ-детектора на основании интенсивности сигнала. Функция 

автоматического масштабирования активируется по умолчанию. 

При наличии нескольких линий оптической плотности ультрафиолета можно: 

■ Произвести независимое автоматическое масштабирование каждой линии УФ-

детектора с помощью кнопки . 

Масштаб оси Y каждой линии устанавливается по интенсивности УФ-сигнала 

отдельной линии. 

■ Произвести автоматическое масштабирование всех линий УФ-детектора с 

помощью кнопки . 

Масштаб оси Y базируется на интенсивности сигнала линии УФ-детектора с самой 

высокой интенсивностью, и все остальные линии нормализуются до интенсивности 

данной линии. 

■ Деактивировать функцию автоматического масштабирования . 
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В случае контроля линии оптической плотности одноволнового УФ-детектора можно: 

■ Произвести автоматическое масштабирование всех линий УФ-детектора с 

помощью кнопки . 

Масштаб оси Y базируется на интенсивности сигнала линии УФ-детектора с самой 

высокой интенсивностью, и все остальные линии нормализуются до интенсивности 

данной линии. 

■ Деактивировать функцию автоматического масштабирования . 

Когда данная функция деактивирована, вы можете изменять значение каждой 

отдельной линии УФ-детектора. Режим автоматического масштабирования и 

значения линий УФ-детектора сохраняются при сохранении протокола анализа. 

Для автоматического масштабирования линии УФ-детектора 

► Выполните одно из следующих действий: 

■ Щелкните на кнопке Autoscale на панели инструментов для выбора 

статуса. 

■ Щелкните правой кнопкой мыши на хроматограмме, выберите Autoscale 

UV trace, после чего выберите статус. 

Снабжение хроматограммы примечаниями 

Вы можете добавить к хроматограмме примечания в ручном режиме в любое время 

во время или после анализа для связывания измерений с точками данных на 

хроматограмме. Диалоговое окно для создания примечаний содержит три поля: 

Location (Местоположение) (в координатах времени, объема или объема колонки), 

Title (Заголовок) и Description (Описание). Когда примечание сохраняется, его 

заголовок появляется в указанном местоположении по оси Х. Описание появляется в 

отчете об анализе. 

При проведении анализа по выбранному методу можно добавлять примечания. Тем 

не менее, если анализ завершается при открытом диалоговом окне для создания 

примечаний, примечание сохраняется, и диалоговое окно автоматически 

закрывается. После завершения анализа по выбранному методу примечания к 

хроматограмме можно добавить в окне System Control. Завершенные анализы можно 

снабдить примечаниями, открыв соответствующие протоколы в режиме Evaluation. 
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Для добавления примечаний 

1. Щелкните на Annotate на панели инструментов и «перетащите» значок на 

хроматограмму. Откроется зеленое диалоговое окно для создания примечаний 

с автоматически заполненным полем Location. 

 

Совет: При необходимости можно отредактировать поле Location. 

2. Введите заголовок для примечания. 

3. (Опционально) Введите описание для примечания. 

4. Щелкните на Save для сохранения примечания. 

Примечание: Щелчок на  закрывает диалоговое окно без сохранения 

примечания. 

Для редактирования примечания 

1. Дважды щелкните на примечании на хроматограмме для открытия диалогового 

окна. 

2. Отредактируйте примечание и щелкните на Save для сохранения изменений. 

Для удаления примечания 

► Дважды щелкните на примечании для открытия диалогового окна, после чего 

щелкните на Delete (Удалить). 
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Отображение и скрытие событий, фракций, ошибок и примечаний 

Можно отобразить или скрыть отображение фракций, событий, ошибок и 

примечаний, выбрав или отменив выбор соответствующих кнопок-флажков в нижней 

части условных обозначений. 
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При помещении указателя на линию на хроматограмме отображается всплывающая 

подсказка с показаниями в реальном времени в текущем положении. 
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Секция Fluidic Scheme (Схема жидкостного тракта) 

Секция Fluidic Scheme графически отображает каждый используемый в настоящее 

время модуль прибора. Информация о состоянии в реальном времени включает 

скорость потока буфера, скорость потока образца, давление и положение клапана в 

системе. Схема жидкостного тракта отражает способ подключения прибора, а также 

путь прохождения жидкости через различные модули системы. 

Важно: Выбранная схема жидкостного тракта должна соответствовать 

конфигурации установленных аппаратных модулей системы. 

Схема жидкостного тракта отображает путь прохождения жидкости через систему в 

реальном времени (ярко-зеленый) и в ручном режиме обеспечивает доступ к 

настройкам устройства. Путь к компонентам схемы жидкостного тракта, не входящим 

в путь прохождения жидкости, выделяется серым цветом. 
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При неработающих насосах предварительный путь прохождения жидкости 

выделяется более светлым цветом, соответствующим цвету пути напорного течения 

насоса (голубой для насоса для образца или светло-зеленый для системного 

насоса). 

 

На системе NGC Discover отображаются два пути прохождения жидкости – один для 

системного насоса (ярко-зеленый) и другой – для насоса для образца (голубой). На 

следующем экране путь серого цвета, ведущий от клапана переключения колонок до 

колонки, указывает на то, что клапан переключения колонок не располагается на 

одной линии с насосом или шприцем, а находится в режиме отключения. 
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На схеме жидкостного тракта номер активного отверстия клапана выделяется ярко-

зеленым цветом. Номер на клапане, выделенный серым цветом, обозначает, что 

клапан не используется. Прибор NGC поддерживает до четырех входных клапанов 

(два клапана переключения буферных растворов и два клапана выбора образца), 

три клапана переключения колонок и два выходных клапана. При помещении 

указателя на клапан отображается всплывающая подсказка, указывающая его тип. 

Совет: Если система включает два клапана выбора образца, схема жидкостного 

тракта идентифицирует первый клапан как S1 и отображает его как младший из двух 

в нисходящей последовательности. Второй клапан идентифицируется как S2. Если 

система включает несколько клапанов переключения колонок или выходных 

клапанов, клапаны идентифицируются количественно в восходящем порядке. 
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Модули 

Более подробное описание модулей схемы жидкостного тракта приведено в главе 2, 

«Компоненты», руководства по эксплуатации прибора. Для удобства поиска в 

Таблице 2 приведены изображения каждого модуля схемы жидкостного тракта с 

описаниями опций соответствующих диалоговых окон. 

Таблица 2. Модули схемы жидкостного тракта 

 

Системные насосы и смеситель 

Диалоговое окно данного модуля позволяет осуществлять 

управление двумя градиентными насосами системы NGC и 

отображает статус градиента. Также через него регулируется 

скорость потока, выбирается тип градиента (солевой или pH), 

задается продолжительность градиента и диапазон рабочих 

давлений системы. 

 

 

Системные насосы со смесительным клапаном для буферных 

растворов 

Диалоговое окно данного модуля позволяет осуществлять 

управление системными градиентными насосами NGC при наличии 

подключенного к модулю смесителя и отображает статусы насоса и 

градиента. Через него регулируется скорость потока, 

контролируется заполнение смесительного клапана, рецепт 

приготовления буфера, состав градиента, pH, продолжительность 

градиента и диапазон рабочих давлений системы. 

 

 

Системные насосы со смесительным клапаном для буферных 

растворов и клапаном переключения буферных растворов A и 

B 

Через диалоговое окно данного модуля осуществляется управление 

системными градиентными насосами NGC, подключенными к 

входным клапанам и смесительному клапану для буферных 

растворов. Пользователь также может управлять режимом 

градиента (градиент давления двух насосов или смесительный 

клапан для буферных растворов), скоростью потока, заполнением 

смесительного клапана, выбирает рецепт приготовления буфера, 

состав градиента, pH, продолжительность градиента и диапазон 

рабочих давлений системы. 

 

 

Инжекционный клапан 

Диалоговое окно данного модуля позволяет осуществлять 

управление инжекционным клапаном NGC. Оно используется для 

направления жидкости от градиентного насоса, насоса для образца 

и инжектора до петли, колонки и сливного отверстия в соответствии 

с требованиями эксперимента. 
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Таблица 2. Модули схемы жидкостного тракта (продолжение) 

 

Насос для образца 

Данное диалоговое окно позволяет осуществлять управление 

насосом для образца и отображает его статус.  Оно используется 

для автоматической загрузки образцов в пробоотборную петлю или 

непосредственного впрыска образцов на колонку во время анализа. 

Окно данного модуля, главным образом, используется для больших 

объемов образца. 

 

 

Клапан переключения колонок 

Диалоговое окно данного модуля позволяет осуществлять 

управление клапаном переключения колонок и отображает статус 

клапана, давление в предколонке и потерю давления на колонке 

(ΔCoI). Оно используется для выбора одной из пяти колонок, 

которые могут быть подключены к клапану, направления потока в 

обход колонок или в обратном направлении через колонки. 

 

 

УФ-детектор и кондуктометрический детектор 

Диалоговое окно данного модуля позволяет осуществлять 

управления одноволновым УФ-детектором или многоволновым 

фотометрическим детектором, а также отображает интенсивность 

УФ-излучения, температуру и статус кондуктометрического 

детектора. Оно используется для включения УФ-детектора и 

задания длины волны, на которой будет осуществляться 

мониторинг. Через него также производится обнуление базовой 

линии во время анализа. Одноволновый детектор может 

осуществлять контроль одновременно только на одной длине 

волны (255 или 280 нм). Многоволновый фотометрический детектор 

способен осуществлять одновременное детектирование на четырех 

длинах волн (от 190 до 800 нм). 

 

 

Модуль импорта сигналов 

Диалоговое окно данного модуля позволяет осуществлять 

управление модулем импорта сигналов (SIM) и отображает 

выходные сигналы подключенных внешних детекторов. К модулю 

импорта сигналов возможно подключение до двух внешних 

устройств. Данный модуль отображает выходные сигналы обоих 

устройств или выходные сигналы модуля SIM1 или SIM2, если одно 

устройство выключено. 
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Таблица 2. Модули схемы жидкостного тракта (продолжение) 

 

Детектор pH и клапан детектора pH 

Диалоговое окно данного модуля позволяет осуществлять 

управление детектором pH и отображает значение pH. Оно 

используется для переключения проточной ячейки детектора pH на 

поточный режим или режим обхода во время эксперимента. Оно 

также позволяет осуществлять калибровку датчика pH без перевода 

его в автономный режим. 

 

 

Коллектор фракций 

Диалоговое окно данного модуля предназначено для управления 

процессом сбора фракций. Оно используется для выбора штативов 

и их местоположений и запуска и останова процесса сбора 

фракций. Через него также осуществляется определение размера 

фракций и количество пробирок для сбора. 

Конфигурации схемы жидкостного тракта 

Схему жидкостного тракта можно адаптировать под конфигурацию аппаратной части 

прибора. В ручном режиме пользователь может настроить параметры большинства 

элементов через диалоговое окно Fluidic Scheme Selector. Также можно создавать 

собственные схемы жидкостного тракта. См. подраздел «Для создания новой схемы 

жидкостного тракта» на стр. 60. 

Таблица 3. Опции конфигурирования схемы жидкостного тракта 

Насосы Конфигурация Описание 

 

Только системный 

насос 
Используется для запуска и останова 

насосов, выбора буфера, градиента и 

продолжительности и диапазона 

рабочих давлений.  

 

Системный насос и 

вход A 
Выбор буфера для входа A из восьми 

различных буферов. 
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Таблица 3. Опции конфигурирования схемы жидкостного тракта (продолжение) 
 

 

Системный насос и 

вход B 
Выбор буфера для входа B из восьми 

различных буферов. 

 

Системный насос и 

входы A и B 
Выбор буферов для входов A и B из 

восьми различных буферов (всего 16). 

 

Системный насос и 

смесительный клапан 

для буферных 

растворов 

Запуск и останов создания градиента 

через смесительный клапан для 

буферных растворов и приготовление 

буфера. 

 

Системный насос и 

смесительный клапан 

для буферных 

растворов со входами 

A и B 

Запуск и останов создания градиента 

через смесительный клапан для 

буферных растворов и приготовление 

буфера. Выбор буфера из семи 

дополнительных буферов и растворов. 

Ввод образца Конфигурация Описание 

 

Инжекционный клапан Загрузка заданного объема образца на 

колонку. 
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Таблица 3. Опции конфигурирования схемы жидкостного тракта (продолжение) 
 

 

Инжекционный клапан 

с насосом для образца 
Автоматическая загрузка заданного 

объема образца в пробоотборную 

петлю или непосредственно на колонку 

с помощью насоса для образца. 

 

Инжекционный клапан 

с автосамплером 
Автоматическая загрузка образцов на 

колонку с помощью автосамплера. 

 

Инжекционный клапан 

с насосом для образца 

и одним клапанов 

выбора образца 

Для использования в качестве мини-

автосамплера; возможность выбора из 

восьми различных образцов. 

 

Инжекционный клапан 

с двумя клапанами 

выбора образца 

Для использования в качестве мини-

автосамплера; возможность выбора из 

пятнадцати различных образцов при 

шлейфовом подключении двух клапанов 

выбора образца. 
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Таблица 3. Опции конфигурирования схемы жидкостного тракта (продолжение) 
 

Колонки Конфигурация Описание 

 

Колонка Не требует разъяснений при отсутствии 

клапана переключения колонок. 

 

Колонка с клапаном 

переключения колонок 
Используется для выбора колонки из 

пяти различных колонок, обхода 

колонок или реверса потока. 

 

Два клапана 

переключения колонок 

с подключенной 

колонкой каждый 

Используется для выбора колонки из 

десяти различных колонок, обхода 

колонок или реверса потока. 

 

Три клапана 

переключения колонок 

с подключенной 

колонкой каждый 

Используется для выбора колонки из 

пятнадцати различных колонок, обхода 

колонок или реверса потока. 

Детекторы Конфигурация Описание 

 

Одноволновый УФ-

детектор с 

кондуктометрическим 

детектором 

Для выбора одноволнового УФ-

детектора с кондуктометрическим 

детектором и датчиком температуры 
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Таблица 3. Опции конфигурирования схемы жидкостного тракта (продолжение) 
 

 

Одноволновый УФ-

детектор с 

кондуктометрическим 

детектором и датчиком pH 

Для выбора одноволнового УФ-

детектора с кондуктометрическим 

детектором, датчиком температуры и 

клапаном детектора pH 

 

Многоволновый 

фотометрический детектор 

с кондуктометрическим 

детектором и датчиком 

температуры 

Для выбора многоволнового 

фотометрического детектора с 

кондуктометрическим детектором и 

датчиком температуры. 

 

Многоволновый 

фотометрический детектор 

с кондуктометрическим 

детектором, датчиком 

температуры и датчиком 

pH 

Для выбора многоволнового 

фотометрического детектора с 

кондуктометрическим детектором, 

датчиком температуры и клапаном 

детектора pH 

 

Модуль импорта сигналов 

(SIM) с одноволновым УФ-

детектором с 

кондуктометрическим 

детектором и датчиком 

температуры 

Для выбора модуля SIM с 

одноволновым УФ-детектором с 

кондуктометрическим детектором и 

датчиком температуры 

 

Модуль импорта сигналов 

(SIM) с одноволновым УФ-

детектором с 

кондуктометрическим 

детектором, датчиком 

температуры и датчиком 

pH 

Для выбора модуля SIM с 

одноволновым УФ-детектором с 

кондуктометрическим детектором, 

датчиком температуры и клапаном 

детектора pH 

 

Модуль импорта сигналов 

(SIM) с многоволновым 

фотометрическим 

детектором с 

кондуктометрическим 

детектором 

Для выбора модуля SIM с 

многоволновым фотометрическим 

детектором с кондуктометрическим 

детектором и датчиком температуры. 

 

Модуль импорта сигналов 

(SIM) с многоволновым 

фотометрическим 

детектором с 

кондуктометрическим 

детектором и датчиком pH 

Для выбора модуля SIM с 

многоволновым фотометрическим 

детектором с кондуктометрическим 

детектором, датчиком температуры и 

клапаном детектора pH. 
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Таблица 3. Опции конфигурирования схемы жидкостного тракта (продолжение) 
 

Сбор фракций Конфигурация Описание 

 

Коллектор фракций 

BioFrac™ 
Для конфигурирования коллектора 

фракций BioFrac. Используется для 

запуска и останова процесса сбора 

фракций с целью задания размеров 

фракций и количества пробирок для 

сбора. 

 

Коллектор фракций с 

выходным клапаном 
Для совместного сбора фракций 

большого и малого объемов. Выбор 

подсоединяемых выходных отверстий 

для отвода фракций, элюируемых из 

колонки, на пробоотборную 

петлю/петлю для хранения для 

последующей повторной закачки на 

вторую колонку при тандемных 

анализах.  

 

Коллектор фракций с 

двумя выходными 

клапанами 

Для совместного сбора фракций 

большого и малого объемов. Выбор 

подсоединяемых выходных портов для 

отвода фракций, элюируемых из 

колонки, на пробоотборную 

петлю/петлю для хранения для 

последующей повторной закачки на 

вторую колонку при тандемных 

анализах.  

 

Выходной клапан Для использования в качестве 

коллектора фракций; выбор до 11 

фракций большого объема. 

Выбор подсоединяемых выходных 

портов для отвода фракций, 

элюируемых из колонки, на 

пробоотборную петлю/петлю для 

хранения для последующей повторной 

закачки на вторую колонку при 

тандемных анализах.  
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Два выходных клапана Для использования в качестве 

коллектора фракций; выбор до 22 

фракций большого объема при 

шлейфовом подключении двух 

выходных клапанов. 

Выбор подсоединяемых выходных 

портов для отвода фракций, 

элюируемых из колонки, на 

пробоотборную петлю/петлю для 

хранения для последующей повторной 

закачки на вторую колонку при 

тандемных анализах.  

Работа со схемами жидкостного тракта 

Исходя из доступных модулей и требований к эксперименту, пользователь 

может сконфигурировать пять участков схемы жидкостного тракта. 

■ Насосы 

■ Ввод образца 

■ Колонки 

■ Детекторы 

■ Сбор образцов 

Для изменения схемы жидкостного тракта 

1. Выполните одно из следующих действий: 

■ В окне System Control window выберите Tools > Change Fluidic Scheme. 

■ На сенсорном экране выберите Change Fluidic Scheme из ниспадающего 

меню. 

Появится диалоговое окно Fluidic Scheme Selector. При помещении указателя 

на модуль схемы жидкостного тракта появится наглядная подсказка. 



3   I   Управление системой 

60   |   Хроматографические системы NGC™ и программное обеспечение ChromLab™  

 

2. Щелкните на вводе в секции Fluidic Scheme Selector. 

Правая секция окна отобразит выбранную схему жидкостного тракта. 

3. Щелкните на Select (Выбрать). 

Для создания новой схемы жидкостного тракта 

Примечание: Копия схемы жидкостного тракта не сохраняется. 

1. Выполните одно из следующих действий: 

■ В окне System Control window выберите Tools > Change Fluidic Scheme. 

■ На сенсорном экране выберите Change Fluidic Scheme из ниспадающего 

меню. 

2. Щелкните на New (Новый). 

Появится текущая схема жидкостного тракта с кнопками редактирования (Edit), 

позволяющими выбирать альтернативные модули в наборных счетчиках. 



Секция Fluidic Scheme (Схема жидкостного тракта) 

Руководство пользователя   |   61 

3. Щелкните на Edit под группой модулей, конфигурация которой подлежит 

изменению. 

Наборный счетчик отобразит количество модулей выбранного типа. 

 

4. Прокрутите список модулей вверх или вниз для просмотра. 

5. Выберите модуль и щелкните на Accept (Принять). 

6. Повторите шаги 3-5 для редактирования других модулей. 

7. По завершении редактирования модулей щелкните на Save (Сохранить) и 

введите название в появившемся диалоговом окне New Fluidic Scheme (Новая 

схема жидкостного тракта). 

8. Щелкните по кнопке OK. 

Для изменения настроек модулей 

1. На схеме жидкостного тракта дважды щелкните кнопкой мыши на модуле. 

2. В появившемся диалоговом окне отредактируйте опции модуля. 

3. Щелкните на Apply (Применить). 
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Картирование схемы жидкостного тракта 

Прибор NGC поддерживает до четырех входных клапанов (два клапана 

переключения буферных растворов и два клапана выбора образца), три клапана 

переключения колонок и два выходных клапана. При наличии одного или более 

установленных клапанов определенного типа программное обеспечение ChromLab 

автоматически детектирует клапаны и составляет карту жидкостного тракта с 

привязкой модулей к положениям по умолчанию на приборе NGC. Например, если в 

схеме жидкостного тракта присутствуют два или более входных клапана, ПО 

ChromLab автоматически детектирует положения клапанов на приборе NGC 

(начиная с левой стороны нижнего яруса) и назначает первому клапану вход A. 

Если конфигурация вашего прибора NGC отличается от конфигурации по умолчанию 

или если вы изменили схему жидкостного тракта, необходимо вручную проецировать 

клапаны на прибор с привязкой к их местоположениям на схеме жидкостного тракта. 

Это осуществляется с помощью диалогового окна Fluidic Scheme Mapping. 

Примечание: Если конфигурация прибора NGC включает только два входных 

клапана, и оба клапана обозначены как клапаны переключения буферных растворов, 

проецировать их нет необходимости. Система автоматически определит их 

местоположения на приборе и функции. 

Диалоговое окно Fluidic Scheme Mapping отображает в верхней секции текущую 

схему жидкостного тракта, и в нижней секции – текущую конфигурацию прибора 

NGC. ПО ChromLab автоматически определяет, какие клапаны на схеме жидкостного 

тракта могут быть картированы. Данные клапаны появляются в верхней секции с 

цветовой кодировкой. Соответствующие клапаны выделяются тем же цветом на 

карте прибора в нижней секции в положениях, соответствующих положениям 

картируемых модулей прибора NGC. Все остальные модули остаются неактивными 

в нижней секции. 
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Ниже приведена схема цветовой кодировки и маркировки для диалогового окна Fluidic 

Scheme Mapping: 

Цвет Маркировка Клапан 

Синий A и B Клапан переключения буферных растворов 

Синий S1 и S2 Клапан выбора образца 

Зеленый C1-C3 Клапан переключения колонок 

Оранжевый O1 и O2 Выходной клапан 

Для проецирования схемы жидкостного тракта на прибор необходимо сначала отменить 

проецирование текущих настроек, после чего проецировать клапаны на новую схему 

жидкостного тракта. 
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Для отмены проецирования клапанов 

1. Выполните одно из следующих действий: 

■ В окне System Control window выберите Tools > Map Fluidic Scheme. 

■ На сенсорном экране выберите Map Fluidic Scheme из ниспадающего 

меню. 

Появится диалоговое окно Fluidic Scheme Mapping с клапанами на схеме 

жидкостного тракта, привязанными к их местоположениям по умолчанию на 

карте прибора. 

2. Выберите клапан на карте прибора. Контур клапана на схеме жидкостного 

тракта выделится, индицируя, что клапан выбран. 

3. Щелкните на Unmap (Отменить проецирование). Контур клапана на карте 

прибора станет тоньше, и маркировка клапана исчезнет, что будет означать, 

что клапан больше не проецирован на схему жидкостного тракта. 

4. (Опционально) Отмените проецирование всех клапанов, подлежащих 

повторному переназначению. 

 

5. Для проецирования клапанов перейдите к подразделу «Для проецирования 

клапанов» на стр. 65.  

Для отмены операции отмены проецирования клапанов 

► Щелкните на Cancel (Отмена) для отмены операции отмены проецирования 

клапанов. Схема жидкостного тракта и карта прибора вернутся к предыдущей 

конфигурации картирования. 
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Для проецирования клапанов 

1. В диалоговом окне Fluidic Scheme Mapping выберите клапан для 

проецирования или в верхней, или в нижней секции. 

2. Выберите его местоположение на соответствующей схеме. На карте прибора 

на выбранном клапане появится маркировка, и его контур выделится, 

индицируя, что клапан проецирован. 

 

3. (Опционально) Продолжите проецирование остальных клапанов. 

4. Щелкните на Save для сохранения новой настройки. 
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Калибровка 

Калибровка прибора NGC производится на заводе-изготовителе. Как правило, 

прибор не требует дополнительной калибровки. Тем не менее, датчик pH требует 

калибровки каждый раз при использовании прибора и при наличии значительных 

колебаний температуры, так как со временем настройка датчика pH смещается. 

В дополнение к датчику pH, ПО ChromLab содержит настройки для калибровки 

следующих параметров: 

■ Pump flow rate (Производительность насоса) 

■ Sample Pump Pressure (Давление насоса для образца) 

■ System Pressure (Давление в системе) 

■ Column switching valve pressure (Давление клапана переключения колонок) 

■ Conductivity monitor (Кондуктометрический детектор) 

Калибровка данных модулей производится опционально. 

Калибровка модуля 

Примечание: Во время калибровки выполнение анализа по заданному методу 

невозможно. 

В меню Tools щелчок на Calibrate (Калибровать) отобразит диалоговое окно 

Calibration (Калибровка), в котором можно выбрать модуль для калибровки. Также 

появится окно System Control с заголовком Calibration in Progress (Выполняется 

калибровка) в строке заголовка. 

Для выбора модуля для калибровки 

► Выберите модуль в раскрывающемся списке Calibrate в верхней части 

диалогового окна Calibration. 

В диалоговом окне появятся инструкции по калибровке выбранного модуля. 
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Калибровка производительности насосов 

Если расход буфера кажется неверным, может потребоваться повторная калибровка 

насосов. 

Важно: Перед калибровкой производительности насосов необходимо обязательно 

заполнить систему водой. В противном случае калибровка будет неверной. 

Для калибровки производительности насосов 

► Выберите Pump Flow Rate в раскрывающемся списке Calibrate в верхней части 

диалогового окна Calibration. 

Диалоговое окно Calibration отобразит инструкции и параметры настройки для 

калибровки насосов. 
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Калибровка давления 

ВНИМАНИЕ! Перед калибровкой датчика давления необходимо отсоединить от него 

все капилляры. В начале калибровки датчик должен находиться при атмосферном 

давлении. 

Вы можете откалибровать давление насоса для образца, давление системы и 

давление клапана переключения колонок на ноль. Если показания давления не 

равны нулю или близки к нему, вы можете сбросить значения давления на ноль. 

Для калибровки давления 

1. Выберите требуемый модуль в раскрывающемся списке Calibrate в верхней 

части диалогового окна Calibration. 

2. Следуйте инструкциям в диалоговом окне для сброса уставки давления на 

ноль. 

Примечание: Для калибровки верхнего предельного давления обратитесь к Службе 

технической поддержки Bio-Rad. 
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Проверка системы капилляров с помощью функции 
Point-to-Plumb 

Прибор хроматографической системы NGC поставляется с подключенной системой 

капилляров. Функция Point-to-Plumb позволяет изменять конфигурацию системы 

капилляров или проверять соответствие конфигурации системы капилляров 

заданной схеме жидкостного тракта. 

Доступ к функции Point-to-Plumb осуществляется через меню сенсорного экрана или 

компьютер, работающий под управлением ПО ChromLab. (Выберите Tools > Point-to-

Plumb). 

Совет: Сенсорный экран обеспечивает удобство одновременного просмотра окна 

Point-to-Plumb и передней панели прибора. 

При выборе функции Point-to-Plumb текущая схема жидкостного тракта появляется в 

режиме Point-to-Plumb. Все светодиодные индикаторы прибора гаснут. При выборе 

линии между двумя модулями загораются светодиодные индикаторы, 

соответствующие двум подключаемым портам. 

 

В окне Point-to-Plumb правильный путь подключения капилляров выделяется серым 

цветом. Выбранные пути прохождения жидкости выделяются зеленым. 

Неподключенные элементы жидкостного тракта выделяются бледно-серым цветом, 

который не меняется при их выборе. 

Примечание: Если схема жидкостного тракта включает модуль импорта сигналов 

(SIM), он также будет отображаться в окне Point-to-Plumb. В данном случае при 

выборе пути прохождения жидкости между модулем и внешним детектором 

загорается светодиодный индикатор на выходе модуля, подключенного к внешнему 

детектору (через модуль SIM). 
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Если путь прохождения жидкости включает модуль NGC, расположенный после 

внешнего детектора, загорится светодиодный индикатор на входе данного модуля. 

Для проверки схемы подключения капилляров 

1. Держа в поле зрения окно Point-to-Plumb и переднюю панель прибора, 

щелкните на сегменте выделенной серым цветом схемы подключения 

капилляров в окне Point-to-Plumb. 

Выбранный сегмент выделится зеленым цветом, индицируя правильную схему 

подключения. 

 

В это же время зеленый светодиод на передней панели прибора замигает, 

индицируя порты, которые должны быть подключены друг к другу. 

2. Проверьте систему капилляров прибора и экран Point-to-Plumb, чтобы 

убедиться в правильности выбора сегмента системы капилляров. В противном 

случае выполните повторное подключение. 

3. Продолжите выбор и проверку правильности подключения сегментов схемы. 

4. По завершении проверки схемы подключения щелкните на Exit Point-to-Plumb 

(Выход). 

Светодиодные индикаторы прибора загорятся. В зависимости от модуля, 

светодиодные индикаторы означают: 

■ поток жидкости от насосов системы (зеленые светодиодные индикаторы) 

■ поток жидкости от насоса для образца (синие светодиодные индикаторы) 
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Настройки системы 

Диалоговое окно System Settings позволяет настраивать систему в соответствии с 

требованиями пользователя. В данном диалоговом окне вы можете: 

■ Задавать объем задержки 

■ Контролировать скорость потока для предотвращения превышения давления 

■ Осуществлять удаленный доступ к ПО ChromLab с iPad, устройства на Android 

или ПК 

■ Производить сброс линий, минимальных и максимальных масштабных 

коэффициентов оси Y и цветов линий на хроматограмме к заводским 

настройкам по умолчанию 

■ Активировать или деактивировать внешние детекторы, подключенные к 

прибору NGC через модуль SIM 

■ Активировать или деактивировать отправку УФ-сигналов на внешние 

устройства, подключенные к прибору NGC через модуль SIM 

■ Задавать датчики воздуха для детектирования конца образца или буфера 

■ Активировать функцию отправки сообщений по электронной почте о системных 

событиях списку пользователей 

■ Задавать уникальное имя для системы NGC 

Примечание: Данное диалоговое окно доступно в ручном режиме. Настройки 

сохраняются в протоколах анализа по выбранному методу наряду с синхронизацией 

коллектора фракций. 
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Закладка Delay Volume (Объем задержки) 

Объем задержки – это объем хроматографического тракта между УФ-детектором и 

выходом коллектора фракций и/или выходным клапаном. Он определяет задержку 

между детектированием пика фракций и временем, необходимым для прохождения 

данным пиком фракций объема системы капилляров и проточных ячеек до пробирки 

для сбора фракций. 

Когда задан объем задержки, коллектор фракций или выходные клапаны «ожидают», 

когда пик фракций пройдет путь от детектора до выхода (или порта) коллектора 

фракций перед началом сбора фракций. Сбор фракций может быть задержан 

относительно информации о сборе, отображаемой на хроматограмме и панелях 

состояния. При достижении в ходе анализа конца штатива или последнего отверстия 

выходного клапана хроматограмма и панель состояния перед фактическим началом 

сбора фракций могут отображать начальные пробирку и штатив или новый выходной 

порт. 

Примечание: Если в схему жидкостного тракта включен выходной клапан, и в ходе 

анализа вы изменили порт сбора или размер фракций, в первый контейнер в новой 

схеме будет производиться сбор фракций определенного размера с указанным 

объемом задержки. Во все последующие контейнеры будет производиться только 

сбор фракций определенного размера. 

Для задания объема задержки 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Delay Volume. 
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3. Выберите Synchronize with detector (Синхронизировать с детектором). 

4. Задайте внутренний диаметр используемого капилляра. 

Цвет капилляра Внутренний диаметр 

Оранжевый 0,02" (0,5 мм) 

Зеленый 0,03" (0,75 мм) 

Прозрачный 0,062" (1,6 мм) 

5. Если ваша система включает коллектор фракций BioFrac, выберите кнопку-

флажок Include BioFrac - 12 µl (Включить BioFrac – 12 мкл) и задайте длину 

капилляра между выходным портом УФ-детектора и выходом коллектора 

фракций. 

6. Если ваша система включает выходной клапан, выберите кнопку-флажок 

Include Outlet valve – 50 µl (Включить выходной клапан – 50 мкл) и задайте 

длину капилляра между выходным портом УФ-детектора и выходным 

клапаном. 
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7. Если ваша система включает и коллектор фракций BioFrac, и выходной клапан, 

выберите обе кнопки-флажка. В поле Include Outlet valve - 50 µl укажите длину 

капилляра между выходным портом УФ-детектора и выходным клапаном, а 

также длину капилляра между выходным клапаном и выходом коллектора 

фракций. 

8. Выберите или отмените выбор следующих четырех кнопок-флажков, в 

зависимости от того, присутствуют данные модули в вашей системе или нет. 

Примечание: Если ваша система включает модуль детектора pH, и вы 

выбрали кнопку-флажок для включения объема его ячейки, определите, в 

каком режиме будет работать детектор – в поточном (Inline) или обходном 

(Bypass), после чего выберите соответствующую зависимую кнопку. 

9. В случае если одна или несколько опций не применяются или вы изменили 

длину капилляра, введите соответствующие значения в поле Additional volume 

(Дополнительный объем). 

Система рассчитает объем задержки на основании технических данных вашей 

системы и отобразит результаты в мкл в нижней части диалогового окна. 

10. Щелкните на кнопке OK. 

Закладка Control Flow (Управление потоком) 

Используйте опцию управления потоком Control Flow для предотвращения 

превышения давления системы максимального предела. Опция Control Flow 

уменьшает скорость потока в два раза при достижении давления в системе 80% (по 

умолчанию) от максимального предельного давления. Опция Control Flow при 

необходимости снижает скорость потока в несколько раз. Тем не менее, она не 

способна уменьшить скорость потока ниже минимального заданного пользователем 

значения. Для анализов, проводимых по заданному методу, функция управления 

потоком производит сброс скорости потока в начале каждой фазы, после чего при 

необходимости повторно ее регулирует. Каждый раз, когда давление превышает 

максимальной предел, насосы системы немедленно останавливаются. 

Опция Control Flow, предотвращающая превышение давления, доступна в 

диалоговых окнах System Pump (Системный насос) и Sample Pump (Насос для 

образца) в ручном режиме, а также в окне Method Editor. Вы можете выбрать любую 

из данных настроек до выполнения анализа или метода для поддержания скорости 

потока в пределах данного диапазона предельных давлений, используя настройки в 

закладке Control Flow диалогового окна System Settings. 
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Если выбрана опция Control Flow, система снижает скорость потока для 

предотвращения превышения максимального давления. Как правило, опция 

управления потоком активируется, когда давление достигает 80% от максимального 

заданного давления колонки. Данный предел может быть изменен. Скорость потока 

снижается наполовину от заданной скорости. Скорость потока повышается до 

нормального значения при смене фазы и снижается только если давление 

следующей фазы продолжает превышать верхнее предельное давление колонки. 

Примечание: Если давление быстро повышается и превышает заданные пределы 

или скорость потока падает ниже заданной скорости, система отключается. 

Для управления скоростью потока 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Control Flow. 

 

3. Задайте максимальное давление в процентах, по достижении которого будет 

активироваться функция Control Flow (значение по умолчанию – 80%). 

При достижении давлением заданного значения в процентах от максимального 

давления система снизит скорость потока на 50 %. 
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4. (Опционально) Задайте минимальную скорость потока для насоса системы и 

насоса для образца, если таковой включен в систему. 

Совет: При смене крышек системных насосов ПО ChromLab при запуске прибора 

проверяет, соответствует ли последняя используемая уставка скорости потока в 

закладке Control Flow диалогового окна System Settings допустимому диапазону для 

новых крышек. Если нет, скорость потока устанавливается на минимальное 

значение, поддерживаемое новыми крышками насосов. 

Закладка Remote Access (Удаленный доступ) 

Вы можете осуществить удаленный доступ к ПО ChromLab с iPad, устройства на 

Android или ПК, используя сервис вычисления в виртуальной сети (VNC). 

Для активации удаленного доступа к ПО ChromLab 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Remote Access. 

3. Выберите Enable VNC service (Активировать сервис VNC) для показа 

удаленного рабочего стола. 

Закладка Trace Settings (Настройки линий 
хроматограммы) 

ПО ChromLab сохраняет изменения настроек отображения линий детекторов и 

применяет их при выполнении анализов в ручном режиме или по выбранному 

методу. Вы можете вернуть нижеприведенные настройки к заводским настройкам по 

умолчанию: 

■ Отображение/скрытие линии (Trace Legend) 

■ Диапазон шкалы оси Y линии (минимальный/максимальный масштабные 

коэффициенты оси Y) (Min and Max Y Scale) 

■ Цвет линии (Trace Color)  

Примечание: При возврате настроек отображения к заводским настройкам по 

умолчанию изменения применяются к текущему и всем последующим анализам, 

выполняемым в ручном режиме или по выбранному методу. Изменения не влияют 

на ранее сохраненные или подвергнутые оценке анализы. 
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Для возврата настроек отображения линий к заводским настройкам по 

умолчанию 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Trace Settings. 

 

3. Выполните одно или несколько из следующих действий: 

■ Для отображения всех линий в условных обозначениях в окне System 

Control щелкните на Show All (Отобразить все). 

■ Для возврата масштабных коэффициентов оси Y к заводским настройкам 

по умолчанию щелкните на Reset (Сбросить). 

■ Для возврата всех цветов линий к заводским настройкам по умолчанию 

щелкните на Reset. 

4. Щелкните на кнопке OK. 
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Закладка Device Input (Вход устройства) 

Вы можете импортировать аналоговый сигнал (напряжения) от одного или двух 

внешних устройств и преобразовать его в цифровые данные NGC через модуль 

импорта сигналов (SIM). Модуль SIM импортирует и преобразовывает сигнал в 

соответствующие единицы измерения линии через свои каналы. Когда модуль SIM 

активирован, в условных обозначениях хроматограммы появляется подробная 

информация, на хроматограмме отображается линия, и данные могут быть 

проанализированы в окне Evaluation. Для каждого устройства вы можете 

определить: 

■ Имя линии (Trace Name) 

■ Минимальное и максимальное выходные напряжения (в вольтах) (Range (Volt)) 

■ Тип единиц измерения линии (отображается в условных обозначениях 

хроматограммы) (Trace Unit) 

■ Минимальную и максимальную единицы (Scale (Units)) 

Для осуществления измерений от внешних детекторов 

1. Убедитесь, что модуль SIM подключен к прибору NGC. 

2. На задней панели модуля SIM определите, какие внешние устройства 

подключены к портам 1 и 2 модуля SIM. 

3. Выберите File > System Settings для открытия диалогового окна System Settings. 
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4. Выберите закладку Device Input. 

 

5. Поля в данном диалоговом окне деактивированы по умолчанию. Выберите 

кнопку-флажок Enabled (Вкл.) для SIM 1 и введите следующую информацию 

для активации соединения с первым детектором: 

а. Введите имя линии для детектора в поле Trace Name. 

 Примечание: Данное поле имеет ограничение в 20 символов. 

б. Диапазон напряжений – выход детектора. Задайте минимальное и 

максимальное напряжения. 

в. Введите тип единиц измерения для линии в поле Trace Unit. 

 Примечание: Данное поле имеет ограничение в 5 символов. 

г. Система преобразует выходной сигнал в единицы измерения линии. 

Задайте минимальную и максимальную единицы (масштабный 

коэффициент оси Y). 
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6. (Опционально) Выберите кнопку-флажок Enabled для SIM 2 и повторите шаги 

5а – 5г для второго внешнего детектора. 

7. Щелкните на кнопке OK. 

Для деактивации соединения 

► В закладке Device Input отмените выбор кнопки-флажка Enabled для устройства 

и щелкните на OK. 

Примечание: Деактивация соединения с модулем SIM не отключает детектор. 

Закладка Device Output (Выход устройства) 

Вы можете преобразовать цифровые данные NGC в аналоговое напряжение через 

модуль SIM и вывести напряжение на внешнее регистрирующее устройство, такое 

как детектор светорассеяния. Модуль SIM преобразовывает и выводит данные 

линии прибора NGC в виде напряжения через каналы цифро-аналогового 

преобразователя (ЦАП). Когда модуль SIM активирован, внешнее устройство может 

принимать преобразованные данные линии детектора. Для данного устройства вы 

можете определить: 

■ Тип сигнала (Signal) 

■ Минимальное и максимальное выходные напряжения (от 0 до 10 вольт) (Range 

(0-10) Volt) 

■ Минимальную и максимальную единицы (Scale (mAU)) 

Для активации вывода данных на внешние устройства 

1. Убедитесь, что модуль SIM подключен к прибору NGC. 

2. Взгляните на заднюю панель модуля SIM и убедитесь, что устройство 

подключено к ЦАП А. 

3. Выберите File > System Settings для открытия диалогового окна System Settings. 

4. Выберите закладку Device Output. 
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5. Поля в данном диалоговом окне деактивированы по умолчанию. Выберите 

кнопку-флажок Enabled для Signal Output A (Сигнальный выход А) и введите 

следующие данные: 

а. Выберите тип сигнала из раскрывающегося списка Signal. 

б. Система преобразует единицы измерения линии в тип входного сигнала 

устройства. Задайте минимальную и максимальную единицы 

(масштабный коэффициент оси Y). 

в. Диапазон напряжений – выходной сигнал, подаваемый на устройство. 

Выход каналов ЦАП модуля SIM – от 0 до 10 В. Рекомендуемые настройки 

в пределах данного диапазона характерны для внешнего устройства. 

Более подробная информация приведена в руководстве по эксплуатации 

прибора. 

6. Щелкните на кнопке OK. 

Для деактивации соединения 

► В закладке Device Output отмените выбор кнопки-флажка Enabled и щелкните 

на OK. 

 Совет: Деактивация соединения с модулем SIM не отключает внешнее 

устройство. 
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Закладка Air Sensors (Датчики воздуха) 
Система поддерживает до двух модулей датчиков воздуха и до восьми датчиков 

воздуха. Каждый модуль может включать до четырех датчиков воздуха. Система 

детектирует количество датчиков воздуха, подключенных к прибору. 

Датчики воздуха могут быть настроены на детектирование конца буфера и 

последовательно подключаться к насосам системы. Когда датчик воздуха 

детектирует конец буфера, система останавливает системные насосы и прекращает 

выполнение анализа. Выполнение анализа можно продолжить после долива буфера 

и промывки линий. 

Датчики воздуха могут быть настроены на детектирование конца образца и 

последовательно подключаться к насосу для образца. Когда используется насос для 

образца для загрузки образца в ручном режиме, и датчик воздуха детектирует конец 

образца, система останавливает насос для образца, не давая ему закачивать воздух 

на колонку. Когда датчик воздуха детектирует конец образца во время ввода 

образца, насос для образца останавливается. В данном случае анализ 

продолжается до следующей фазы. 

Для активации датчиков воздуха 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Air Sensors. 

По умолчанию активны только датчики воздуха, детектируемые системой. 

Остальные датчики деактивированы. 
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3. Для активации одного или более датчиков воздуха выберите соответствующую 

кнопку-флажок и из раскрывающегося списка выберите или Sample (Образец) 

(для детектирования конца образца), или Buffer (Буфер) (для детектирования 

конца буфера). 

4. Щелкните на кнопке OK. 

Для деактивации датчика воздуха 

► В закладке Air Sensors отмените выбор соответствующей кнопки-флажка и 

щелкните на OK. 
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Закладка Email Notifications (Уведомления по 
электронной почте) 

Вы можете подключить ПО ChromLab к своему серверу исходящей электронной 

почты для отправки уведомлений списку пользователей. Когда данная опция 

активирована, ПО ChromLab осуществляет отправку сообщений, информирующих 

пользователей о таких определенных событиях, как: 

■ Останов насосов (Pumps stopped) 

■ Успешное завершение анализа по выбранному методу (Method run successfully 

completed) 

■ Прекращение анализа по выбранному методу (Method is stopped) 

■ Потеря соединения с системой NGC (Connection to the NGC system is lost) 

Электронное уведомление определяет: 

■ Тип события 

■ Время наступления события 

■ Название метода, выполняемого в момент наступления события 

■ Время, прошедшее с момента начала выполнения метода до момента 

наступления события 

Для установления соединения между ПО ChromLab и сервером SMTP обратитесь к 

подразделу «Для установления соединения ПО ChromLab с сервером электронной 

почты» на стр. 92.  

Для настройки передачи уведомлений по электронной почте 

1. Выберите File > System Settings для открытия диалогового окна System Settings. 

2. Выберите закладку Email Notifications. 

По умолчанию опция передачи уведомлений по электронной почте выключена. 



Настройки системы 

Руководство пользователя   |   85 

 

3. Выберите Enable Email Notification (Активировать передачу уведомлений по 

электронной почте). 

Примечание: Если соединение ПО ChromLab с сервером SMTP не 

установлено, появится сообщение об ошибке, информирующее о том, что ПО 

ChromLab не может установить соединение с сервером электронной почты. 

Щелкните на кнопке OK. Появится диалоговое окно Email Server (Сервер 

электронной почты). Для установления соединения между ПО ChromLab и 

сервером SMTP обратитесь к подразделу «Для установления соединения ПО 

ChromLab с сервером электронной почты» на стр. 92.  

4. Под окном Email Recipients (Получатели электронной почты) щелкните на Add 

(Добавить). Появится диалоговое окно Add Email Address (Добавить адрес 

электронной почты). 

5. Введите адрес электронной почты в текстовое поле и щелкните на OK. 

Повторите процедуру для каждого пользователя, желающего получать 

информацию электронной почтой от ПО ChromLab. Вы также можете ввести 

адрес электронной почты группы пользователей для отправки уведомлений 

группе пользователей. 
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Все добавленные пользователи получают уведомления по электронной почте 

от DoNotReply_NGC о том, что они зарегистрированы для получения 

уведомлений о событиях системы NGC. 

6. В секции Event Types (Типы событий) отмените выбор кнопок-флажков для 

событий, о которых вы не желаете получать уведомления по электронной 

почте. 

Примечание: Все получатели электронной почты получат сообщение обо всех 

выбранных типах событий. 

7. Щелкните на OK для сохранения изменений и выхода из диалогового окна. 

Для редактирования имени в секции Email Recipients 

1. Дважды щелкните на имени в списке Email Recipients. Появится диалоговое 

окно Edit Email Address (Редактировать адрес электронной почты). 

2. Измените адрес электронной почты и щелкните на OK. 

Для удаления имени из списка Email Recipients  

► В секции Email Recipients выберите получателя электронной почты и щелкните 

на Remove (Удалить). 

Для отмены отправки всех уведомлений по электронной почте 

► В закладке Email Notifications отмените выбор кнопки-флажка Enable Email 

Notifications и щелкните на OK. 
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Закладка System Name (Имя системы) 

Вы можете задать уникальное имя для прибора NGC. ПО ChromLab использует 

данное имя для идентификации системы, к которой подключен компьютер. Имя 

системы появляется в окне Home при установлении соединения ПО ChromLab с 

системой NGC. Оно также появляется в отформатированных отчетах об анализе для 

идентификации системы, в которой был проведен анализ. 

Примечание: Длина имени системы ограничивается 10 буквенно-цифровыми и 

специальными символами в любой комбинации. 
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Сведения о системе 

Диалоговое окно System Information предоставляет доступ к общей информации о 

системе, а также компонентах, процессах системы и фотометрических детекторах. 

Примечание: Доступ к данному диалоговому окну осуществляется в ручном режиме 

и из меню на сенсорном экране. 

Закладка General (Общие параметры) 

Данная закладка отображает подробную информацию о приборе NGC, включая: 

■ Тип конфигурации (например, NGC Discover 10) 

■ Серийный номер системы 

■ Имя системы NGC  

■ Имя компьютера, работающего под управлением ПО ChromLab  

■ Версию ПО ChromLab, выполняемого на системе 

■ IP-адрес системы 

■ Сетевое имя системы 

■ Доступное пространство на жестком диске системы 

■ Сведения о BIOS системы (включая версию и дату выпуска BIOS) 

Закладка Devices (Устройства) 

Данная закладка отображает подробную информацию о каждом модуле прибора 

NGC, включая его номер версии и серийный номер. Данная информация полезна 

при заказе сменных модулей. 

Закладка Process (Процесс) 

Данная закладка отображает подробную информацию о процессах, протекающих в 

приборе NGC, а также на компьютере с ПО ChromLab и сенсорном экране. 
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Закладка Detector (Детектор) 

Данная закладка отображает подробную информацию об использовании ламп УФ-

детектора или фотометрического детектора, позволяющую определять 

необходимость замены ламп. Система определяет, какой модуль детектора 

установлен, и отображает информацию о данном модуле. 

Одноволновый детектор 

Система детектирует состояния обеих ламп (255 нм и 280 нм) и отображает 

эталонное напряжение, широтно-импульсную модуляцию в процентах и общее 

количество часов работы каждой лампы в закладке Detector. 

Система должна прекратить работу перед определением состояния ламп. Если 

насосы работают, при щелчке на Get Lamp Status (Узнать состояние лампы) 

появляется предупреждающее сообщение о невозможности определить состояние 

лампы по причине занятости системы. 

Когда насосы останавливаются, система выключает работающую лампу. Затем она 

снова включает лампу, что обновляет процент широтно-импульсной модуляции. 

Система устанавливает длину волны 255 нм, ожидает опорного сигнала для 

стабилизации и считывает данные опорного сигнала. Затем система устанавливает 

длину волны 280 нм и выполняет тот же протокол. После определения данных для 

обеих длин волн в закладке Detector появляются значения. 

Для определения оставшегося ресурса лампы можно руководствоваться 

количеством часов работы лампы или процентом широтно-импульсной модуляции.  

Чем выше процентное значение, тем меньше оставшийся срок службы лампы.  

После замены ламп сбросьте часы работы ламп для отражения ресурсов новых 

ламп. 

Для отображения сигнала и времени эксплуатации ламп 

1. Выберите File > System Settings для открытия диалогового окна System 

Information. 

2. Выберите закладку Detector. Появится пустой экран детектора. 

3. Щелкните на Get Lamp Status (Узнать состояние лампы). 

4. Щелкните на Close (Закрыть) для закрытия диалогового окна System Information. 
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Для сброса часов работы ламп 

► В закладке Detector щелкните на Reset Lamp Time (Сбросить время работы 

лампы). 

Примечание: Появится диалоговое окно, предупреждающее о невозможности 

отмены выполненной операции сброса. Щелкните на No (Нет), если вы не хотите 

производить сброс часов работы лампы. 

Многоволновый детектор 

Закладка отображает измеренное количество сигналов на конкретных длинах волн. 

Она также отображает время работы (в часах) как вольфрамовой, так и дейтериевой 

ламп. 

Система должна прекратить работу перед определением состояния ламп. Если 

насосы работают, при щелчке на Get Lamp Status (Узнать состояние лампы) 

появляется предупреждающее сообщение о невозможности определить состояние 

лампы по причине занятости системы. 

Примечание: Лампы должны быть включены и находиться в режиме ожидания. Если 

лампы выключены, при щелчке на Get Lamp Status появляется предупреждающее 

сообщение о том, что лампы должны быть включены, и детектор должен находиться 

в режиме ожидания. В ручном режиме включите лампы и подождите отображения 

статуса «Standby» (Режим ожидания). Это может занять некоторое время. 

Когда насосы находятся в холостом режиме, и лампы генерируют стабильный 

сигнал, система устанавливает дейтериевую лампу на 240 нм и вольфрамовую 

лампу – на 600 нм. После завершения измерений закладка отображает контрольный 

счет и данные об использовании лампы (в часах). После закрытия диалогового окна 

система перед запуском процедуры восстанавливает ранее заданную длину волны. 

Для определения оставшегося ресурса лампы можно руководствоваться 

количеством часов работы лампы. 

Для отображения контрольного счета и времени эксплуатации ламп 

1. Выберите File > System Settings для открытия диалогового окна System 

Information. 

2. Выберите закладку Detector. Появится пустой экран детектора. 

3. Щелкните на Get Lamp Status (Узнать состояние лампы). 

4. Щелкните на Close (Закрыть) для закрытия диалогового окна System Information. 
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Глобальные параметры 

Диалоговое окно Preference позволяет выбирать единицы измерения давления для 

всех величин давления системы и программного обеспечения. Это основная 

настройка. 

Данное диалоговое окно также позволяет устанавливать соединение ПО ChromLab в 

вашим внутренним сервером электронной почты. ПО ChromLab затем отправляет 

информацию электронной почтой о конкретных событиях системы. 

Закладка Email Server (Сервер электронной почты) 

Примечание: Для установления соединения ПО ChromLab с внутренним сервером 

электронной почты обратитесь к системному администратору. 

Вы можете подключить ПО ChromLab к своему внутреннему серверу электронной 

почты и отправлять уведомления о событиях системы списку пользователей. 

Электронное уведомление определяет: 

■ Тип события 

■ Время наступления события 

■ Название метода, выполняемого в момент наступления события 

■ Время, прошедшее с момента начала выполнения метода до момента 

наступления события 

Информация об активации опции уведомления по электронной почте приведена в 

подразделе «Для настройки передачи уведомлений по электронной почте» на стр. 

84. 
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Для установления соединения ПО ChromLab с сервером электронной почты 

1. В ПО ChromLab выберите File > Preferences. 

2. Выберите закладку Email Server Setup (Установление соединения с сервером 

электронной почты). 

 

3. Предоставьте следующую информацию о своей компании: 

■ SMTP server name (Имя сервера SMTP) — имя сервера исходящей 

электронной почты в вашей компании. 

■ Port (Порт) — номер порта сервера SMTP.  Значение по умолчанию: 25. 

■ Use SSL (Использовать протокол SSL) — по умолчанию протокол 

безопасных соединений (SSL) деактивирован. Если ваша компания 

использует протокол SSL, выберите данную кнопку-флажок. 

■ From address (С адреса) — имя сервера электронной почты в вашей 

компании.  
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■ Authentication (Аутентификация) — по умолчанию данная опция 

деактивирована.  Если на вашем объекте требуется аутентификация 

учетной записи, выберите данную кнопку-флажок. Поля Authenticated 

Account и Account Password активируются. 

■ Authenticated Account (Аутентифицированная учетная запись) — имя 

аутентифицированного пользователя.  

■ Account Password (Пароль) — пароль аутентифицированного 

пользователя. 

4. Для проверки правильности настроек сервера SMTP введите действительный 

адрес электронной почты в поле Test Email Address (Проверить адрес 

электронной почты) и щелкните на Send Test Email (Отправить тестовое 

сообщение). 

5. Щелкните на OK для закрытия диалогового окна. 
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 4 Выполнение анализа в 
ручном режиме 

Прибор хроматографической системы NGC™ работает в двух режимах: ручном и 

автоматическом по запрограммированному методу. В ручном режиме  вы можете 

полностью контролировать каждый насос, клапан, детектор и коллектор фракций 

системы NGC.  Данный режим используется, главным образом, для 

неавтоматизированных процессов, таких как заполнение и очистка или промывка 

системы, но также может применяться для загрузки образцов, оптимизации 

хроматографических параметров и выполнения простых экспериментов. 

Режим выполнения анализа по заданному методу позволяет автоматически 

выполнять запрограммированные шаги. Информация о работе в данном режиме 

приведена в главе 5 «Редактор методов» и главе 6 «Создание метода». 

При включении системы NGC сенсорный экран прибора отображает окно Home в 

ручном режиме. По умолчанию система остается в ручном режиме за исключением 

случаев выполнения калибровки или анализа по заданному методу. 

Вы можете ввести требуемые настройки прибора, дважды щелкнув на отдельных 

диалоговых окнах модулей на схеме жидкостного тракта. Данная глава приводит 

описание этих настроек. См. также главу 3 «Подготовка прибора» в Руководстве по 

эксплуатации хроматографических систем NGC и программного обеспечения 

ChromLab для получения более подробной информации о задачах, описанных в 

данной главе. 

Задачи, выполняемые в ручном режиме, выполняются в окне System Control с 

помощью компьютера, подключенного к прибору NGC, или на сенсорном экране. 

Анализы, проводимые в ручном режиме, могут быть сохранены в базе данных 

ChromLab™, расположенной в памяти компьютера. 

Примечание: Системой NGC можно управлять в ручном режиме без подключенного 

компьютера. 
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Подготовка системы 

Подготовка системы включает заполнение системы для удаления воздуха из 

насосов, капилляров и клапанов с последующей промывкой системы струйной 

автоматики для удаления буфера для хранения, очищающих растворов или старого 

буфера. Заполнение системы производится в ручном режиме, в то время как 

процедуры промывки и очистки могут выполняться как в ручном режиме, так и во 

время прохождения запрограммированных фаз метода.  Более подробная 

информация по работе с данными методами приведена в главе 5 «Редактор 

методов». 

Заполнение и промывка системы 

Для заполнения и промывки ваших систем NGC выполните последовательно 

следующие процедуры. 

Важно: Каждый раз при добавлении или удалении модуля, или изменении, или 

обновлении аппаратной конфигурации вашей системы NGC необходимо 

производить повторное подключение системы капилляров и повторное заполнение 

системы. 

Для заполнения системы 

1. Включите систему NGC и подключенный к ней компьютер. 

2. Для перехода на ручной режим выполните одно из следующих действий: 

■ На компьютере щелкните на Manual Run (Анализ в ручном режиме) в окне 

Home ПО ChromLab или щелкните на закладке System Control, а затем – 

на схеме жидкостного тракта. 

■ На сенсорном экране щелкните на Enter Manual Mode (Перейти на ручной 

режим), если система еще не находится в ручном режиме. 

3. (Опционально) Если аппаратная конфигурация была изменена, выберите 

схему жидкостного тракта, соответствующую текущей конфигурации системы. 

а. Выберите Tools > Change Fluidic Scheme. 

б. Выберите соответствующую схему жидкостного тракта в секции Fluidic 

Scheme Selector. 

в. Щелкните на Select (Выбрать) для выбора схемы жидкостного тракта в 

ручном режиме. 

4. Опустите соответствующие впускные линии в буфер, раствор для хранения 

и/или очищающие растворы, которыми будет заполнена и промыта система. 
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5. Заполните систему. (Подробные инструкции см. в главе 3 «Заполнение и 

промывка систем» в Руководстве по эксплуатации хроматографических систем 

NGC и программного обеспечения ChromLab). 

Для промывки системных насосов NGC Quest 

1. На схеме жидкостного тракта коснитесь или щелкните на модуле 

инжекционного клапана для открытия его диалогового окна. 

2. Установите инжекционный клапан в положение System Pump Waste 

(Системный насос – отходы). 

 

3. На схеме жидкостного тракта коснитесь или щелкните на модуле системного 

насоса для открытия его диалогового окна. 
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4. В диалоговом окне System Pump (Системный насос): 

а. Установите скорость потока (Flow Rate) на 10 мл/мин. 

б. (Опционально) Установите продолжительность (Duration) на не менее чем 

1 мин. 

в. Если кнопка-флажок Enable Air Sensor (Активировать датчик воздуха) 

выбрана, отмените ее выбор. 

г. Щелкните на Start. 
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Для промывки смесительного клапана для буферных растворов 

1. На схеме жидкостного тракта коснитесь или дважды щелкните на модуле 

системного насоса для открытия его диалогового окна. 

2. Выберите Priming (Заполнение) в раскрывающемся списке Mode (Режим). 

 

■ Для продувки отдельной линии для удаления воздушных пузырьков 

перейдите к шагу 3 на стр. 100. 

■ Для последовательной продувки всех линий для удаления воздушных 

пузырьков перейдите к шагу 4 на стр. 100. 

Совет: Доступные режимы смесительного клапана для буферных растворов 

определены следующим образом: 

Режим Описание 

Buffer Blending 

(Смешивание 

буфера) 

Смешивание исходных кислотных, щелочных, водных и 

солевых растворов для создания буфера для изократического 

или градиентного элюирования с определяемой 

пользователем концентрацией и pH с помощью модуля 

смесительного клапана для буферных растворов. 

Priming 

(Заполнение) 

Открытие входных отверстий смесительного клапана для 

буферных растворов для заполнения системы, включение 

насосов для заполнения входной линии и насосов буфером со 

всех четырех портов. 

Gradient via Inlet 

Valves (Градиент 

через входные 

клапаны) 

Выбор буферов через входной клапан. Градиенты создаются 

насосами A и B с использованием выбранных буферов. 
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Режим Описание 

Gradient via 

Blending Valve 

(Градиент через 

смесительный 

клапан для 

буферных 

растворов) 

(высокий расход) 

В качестве впускных отверстий для буферов A и B 

используются отверстия Q1 и Q4 смесительного клапана для 

буферных растворов. Градиенты создаются смесительным 

клапаном для буферных растворов, а не насосами. Это 

позволяет каждому насосу работать с максимальной 

производительностью, в два раза превышающей общую 

производительность, например, до 20 мл/мин для насосов F10. 

3. Для продувки отдельной линии для удаления воздушных пузырьков и 

заполнения ее буфером: 

а. Выберите порт для открытия. 

б. (Опционально) Измените скорость потока, заданную по умолчанию. 

Скорость потока по умолчанию составляет 20 мл/мин. 

в. Щелкните на Start. 

г. Повторите шаги 3а-в для другого порта. 

4. Для продувки всех линий для удаления воздушных пузырьков и заполнения их 

буфером: 

а. Щелкните на All (Все). 

б. (Опционально) Измените скорость потока, заданную по умолчанию. 

Скорость потока по умолчанию составляет 20 мл/мин. 

в. Щелкните на Start. 

5. Проконтролируйте давление насоса и выходной поток, чтобы убедиться в 

нормальном течении жидкости. 

Насосы системы и смесительный клапан для буферных растворов начинают 

работать с заданной скоростью потока, заменяя раствор во входных линиях и 

удаляя захваченные воздушные пузырьки, в циклическом режиме через порты 

Q1 - Q4. По истечении заданного времени насосы немедленно 

останавливаются, в то время как смесительных клапан для буферных 

растворов переключается на порт Q3 для промывки линий водой перед 

закрытием клапана. Во время данного процесса с заданной 

продолжительностью изменения не допускаются. 

Примечание: Вы можете остановить цикл до его завершения щелчком на 

кнопке Stop. Перед тем как остановить цикл промывки, убедитесь, что все 

линии подачи буфера перед выполнением анализа были заполнены 

соответствующими буферными растворами. 
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Для промывки клапанов переключения буферных растворов (если имеются) 

1. Откройте диалоговое окно System Pump и выберите режим Priming в 

раскрывающемся списке Mode. 

Примечание: В режиме Priming инжекционный клапан направляет поток от 

системных насосов в отходы (W2). После завершения процесса инжекционный 

клапан переключает системный насос на режим ручной загрузки колонки через 

петлю. 

 

2. Выберите первый входной порт для заполнения, например, Buffer A1. 

3. (Опционально) Измените скорость потока, заданную по умолчанию. 

 Скорость потока по умолчанию составляет 10 мл/мин. 

4. Щелкните на Start. 

5. Повторите шаги 2-4 для остальных портов клапана переключения буферных 

растворов. 
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Для промывки насоса для образца (если имеется) 

1. На схеме жидкостного тракта дважды щелкните на модуле насоса для образца 

для открытия его диалогового окна. 

 

2. Установите скорость потока (Flow Rate) на 10 мл/мин. 

3. Щелкните на Change Position (Изменить положение) для перевода 

инжекционного клапана в положение Sample Pump Waste и закрытия 

диалогового окна. 

 

4. (Опционально) При наличии датчика воздуха выберите Enable Air Sensor в 

диалоговом окне Sample Pump для останова насоса при детектировании конца 

образца. 

5. Щелкните на Start. 

6. Проконтролируйте давление насоса и выходной поток, чтобы убедиться в 

отсутствии воздуха в линиях и нормальном течении жидкости. 
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Для промывки клапанов выбора образца (если имеются) 

1. На схеме жидкостного тракта дважды щелкните на модуле насоса для образца 

для открытия его диалогового окна. 

 

2. Выберите порт, через который будет осуществляться промывка. 

■ Если имеется только один клапан выбора образца, выберите S1 Port 8 из 

раскрывающегося списка. 

■ При наличии двух клапанов выбора образца щелкните на Valve 2 и 

выберите S2 Port 8 из раскрывающегося списка. 

3. Установите скорость потока (Flow Rate) на 10 мл/мин. 

4. Щелкните на Change Position (Изменить положение) для перевода 

инжекционного клапана в положение Sample Pump Waste и закрытия 

диалогового окна. 

5. (Опционально) При наличии датчика воздуха выберите Enable Air Sensor в 

диалоговом окне Sample Pump для останова насоса при детектировании конца 

образца. 

6. Щелкните на Start. 

7. Проконтролируйте давление насоса и выходной поток, чтобы убедиться в 

отсутствии воздуха в линиях и нормальном течении жидкости. 
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Очистка системы 

Процедура очистки системы состоит из споласкивания системы для удаления 

буферов, промывки основанием для гидролизации адсорбированного белкового 

материала из жидкостной системы и повторного споласкивания для удаления 

основания. Очистку системы можно также производить в режиме выполнения 

анализа по заданному методу. Подробная информация приведена в главе 5 

«Редактор методов». 

Для очистки системы в ручном режиме 

1. Переведите колонку в автономный режим. 

2. Поместите обе входные линии насосов в воду, установите %B на 50% и 

промойте систему, одновременно переключая положения клапанов. 

3. Поместите обе входные линии насосов в 1 M гидроксид натрия, установите %B 

на 50% и промойте систему, одновременно переключая положения клапанов. 

Контролируйте процедуру очистки системы с помощью одноволнового или 

многоволнового кондуктометрического детектора. Промывайте систему до тех 

пор, пока показания кондуктометрического детектора не достигнут постоянного 

значения максимальной проводимости. 

4. Поместите обе входные линии насосов в воду, установите %B на 50% и 

тщательно промойте систему для полного удаления гидроксида натрия, 

одновременно переключая положения клапанов. Контролируйте процедуру 

споласкивания системы с помощью кондуктометрического детектора. 

Споласкивайте систему до тех пор, пока показания кондуктометрического 

детектора не достигнут нуля. 

5. (Опционально) Поместите обе входные линии насосов в раствор для хранения 

(например, 20% этиловый спирт), установите %B на 50% и промойте систему 

раствором, одновременно переключая положения клапанов. 
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Выполнение эксперимента 

Важно: При выполнении эксперимента в ручном режиме перед запуском насоса 

убедитесь, что клапаны находятся в правильных положениях. 

Щелчок на кнопке Start в диалоговом окне System Pump запустит процедуру анализа. 

Вы можете изменять положения клапанов при работающем насосе в ходе 

выполнения анализа в ручном режиме. Протокол анализа можно остановить на 

любом этапе с последующим его сохранением. После этого можно снова запустить 

насосы и продолжить анализ под другим именем. 

Примечание: Для выполнения анализа в ручном режиме выполните 

последовательно следующие процедуры. 

Для выбора схемы жидкостного тракта и установки аксессуаров 

1. (Опционально) Если аппаратная конфигурация вашей системы была изменена, 

выполните одно из следующих действий: 

■ Перейдите к режиму ручного управления на сенсорном экране. 

■ На компьютере запустите ПО ChromLab и щелкните на Manual Run в окне 

Home. 

2. Выберите Tools > Change Fluidic Scheme, после чего выберите схему 

жидкостного тракта, соответствующую конфигурации устройств, подключенных 

к вашей системе NGC. 

 Примечание: Если ваша система NGC включает несколько клапанов одного 

типа, и данная схема жидкостного тракта используется впервые, появится 

диалоговое окно Fluidic Scheme Mapping. Используйте данное диалоговое окно 

для проецирования вашей системы NGC на схему жидкостного тракта. 

3. Установите аксессуары, необходимые для проведения эксперимента: 

а. Подключите колонку. 

б. Установите штативы и пробирки коллектора фракций. 
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Для задания параметров эксперимента на схеме жидкостного тракта 

1. Дважды щелкните на модуле коллектора фракций и выберите в появившемся 

диалоговом окне следующие настройки. 

 

а. В раскрывающемся списке Rack Type (Тип штатива) выберите 

установленный тип штатива. 

б. Под Collection Scheme (Схема сбора) выберите начальный штатив (Start 

Rack) и начальную пробирку (Start Tube), количество пробирок для сбора 

(Tubes to Collect) и размер фракций (Fraction Size). 

в. Нажмите на Collect (Собрать). 

2. (Опционально) Дважды щелкните на модуле детектора pH (если имеется) и 

задайте положение клапана: 

■ Выберите Bypass (Обход) для обхода pH-электрода. 

■ Выберите pH для прямого потока через проточную ячейку детектора pH и 

контроля уровня pH в ходе анализа. 

3. Дважды щелкните на модуле одноволнового или многоволнового УФ-детектора 

с кондуктометрическим детектором, выберите следующие настройки, после 

чего закройте диалоговое окно. 

а. Выберите длины волн для контроля эксперимента: 280 нм – для белков, 

содержащих триптофаны и тирозины; 255 нм – для нуклеиновых кислот и 

(только для детектирования на нескольких длинах волн) 215 нм – для 

аминокислот, соединенных амидной связью. 

б. Включите лампу (On), если она выключена. 

в. Щелкните на Zero Baseline (Обнулить базовую линию) для обнуления УФ-

лампы. 
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4. (Опционально) Дважды щелкните на модуле клапана переключения колонок, 

если он установлен, выберите следующие настройки и закройте диалоговое 

окно. 

 

а. Выберите положение колонки или щелкните на Bypass. 

б. (Опционально) Выберите кнопку-флажок Reverse Flow Direction (Изменить 

направление потока на обратное), чтобы поток буфера проходил через 

колонку снизу вверх, а не сверху вниз. 

5. Дважды щелкните на модуле инжекционного клапана и переведите клапан в 

положение Manual Load Loop (Ручная загрузка петли). 
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6. Дважды щелкните на модуле насоса для образца и выберите в появившемся 

диалоговом окне следующие настройки. 

 

а. При наличии одного или двух подключенных клапанов выбора образца 

выберите порт, из которого будет осуществляться забор образца. 

б. Под Flow Control (Управлять потоком) выберите скорость потока. 

в. Под Pressure Limits (Диапазон рабочих давлений) выберите нижнее и 

верхнее предельные давления. 

г. (Опционально) Выберите Control Flow для предотвращения превышения 

давления. Данная настройка обеспечит автоматическое снижение 

скорости потока при выходе за пределы заданного диапазона давлений. 

д. Щелкните на Change Position, если данная опция еще не выбрана, и 

выберите положение инжекционного клапана. 

е. (Опционально) Выберите Enable Air Sensor, если подключены датчики 

воздуха, и выберите функцию детектирования конца образца. 

Важно: Перед нажатием на кнопку Start выберите настройки управления потоком 

для анализа. Щелчок на кнопке Start запустит процедуру анализа. 
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7. Дважды щелкните на модуле насоса для образца и выберите в появившемся 

диалоговом окне следующие настройки. 

 

а. Если подключен модуль смесительного клапана для буферных растворов, 

выберите режим (Mode): (lsocratic (Изократический) или Gradient 

(Градиентный)) под Flow Control. 

б. Под Pressure Limits (Диапазон рабочих давлений) выберите нижнее и 

верхнее предельные давления. 

в. (Опционально) Выберите Control Flow для предотвращения превышения 

давления. Данная настройка обеспечит автоматическое снижение 

скорости потока при выходе за пределы заданного диапазона давлений. 

г. (Опционально) Выберите Enable Air Sensor, если подключены датчики 

воздуха, и выберите функцию детектирования конца буфера. 

Важно: Перед нажатием на кнопку Start выберите настройки управления потоком 

для анализа. Щелчок на кнопке Start запустит процедуру анализа. 
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Для выполнения этапа эксперимента 

1. Изократический или градиентный режим: 

а. В диалоговом окне модуля насоса для образца System Pump под Flow Control 

задайте скорость потока (Flow Rate), режим (Mode) (lsocratic (Изократический) 

или Gradient (Градиентный)), значение %B, значения Start и End (в градиентном 

режиме) и продолжительность (Duration) (опционально для изократического 

режима) для анализа. 

б. Щелкните на Start для запуска процедуры анализа. 

в. Сверните диалоговое окно Sample Inject Valve. 

2. Этап ввода образца: 

а. С клапаном в положении Manual Load Loop с помощью шприца введите 

образец через порт ввода образца в пробоотборную петлю. 

 

б. Смените положение клапана с Manual Load Loop на Inject Sample. 

в. После завершения ввода образца верните клапан в положение Manual 

Load Loop. 
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Изменение настроек модулей 

Совет: Для некоторых модулей перед изменением настроек требуется остановить 

насосы. 

Для изменения настроек модулей 

1. На схеме жидкостного тракта дважды щелкните кнопкой мыши на модуле. 

2. В появившемся диалоговом окне отредактируйте опции модуля. 

3. Щелкните на Apply (Применить) (в необходимых случаях). 

Останов анализа, выполняемого в ручном режиме 

Для останова анализа, выполняемого в ручном режиме 

► Щелкните на кнопке Stop в диалоговом окне System Pump. 

Удаление данных анализа 

Перед выполнением анализа по выбранному методу необходимо удалить данные 

анализа, выполняемого в ручном режиме. Вы можете удалить данные и запустить 

новый анализ в ручном режиме или анализ, проводимый по выбранному методу. 

Для удаления данных анализа 

► Щелкните на Clear на панели инструментов окна System Control. 

Сохранение анализа, выполняемого в ручном режиме 

При сохранении протокола анализа, выполняемого в ручном режиме, сохраняются 

хроматографические данные и рабочий журнал. Вы можете открыть сохраненную 

хроматограмму в окне Evaluation. 

Для сохранения анализа, выполняемого в ручном режиме 

► Щелкните на Save на панели инструментов окна System Control для сохранения 

данных анализа, выполняемого в ручном режиме. 

Важно: Если вы не сохраните протокол анализа, выполняемого в ручном режиме, 

перед переключением на анализ по выбранному методу, данные анализа, 

выполняемого в ручном режиме, будут потеряны. 
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Сохранение анализа, выполняемого в ручном режиме, 
на сенсорном экране 

Для сохранения анализа, выполняемого в ручном режиме, на сенсорном 

экране 

1. Щелкните на Save на панели инструментов сенсорного экрана. 

Откроется диалоговое окно Save Manual Run (Сохранить анализ, выполняемый 

в ручном режиме). 

2. Выполните одно из следующих действий: 

■ В секции Projects (Проекты) выберите проект или подпроект. 

■ На панели инструментов щелкните на соответствующей кнопке для 

создания нового проекта, подпроекта или корневого проекта и введите 

имя проекта в поле над секцией Projects. 

3. Наберите имя анализа в окне Manual Run Name (Имя анализа, выполняемого в 

ручном режиме). 

4. (Опционально) В поле Notes (Примечания) введите информацию об анализе. 

5. Щелкните на кнопке Save. 
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Просмотр данных анализа 

Примечание: Подробная информации об анализе результатов приведена в главе 7 

«Оценка результатов». 

При выборе одного сохраненного протокола анализа в диалоговом окне Open 

Run/Analysis в нижней части диалогового окна появляется изображение 

хроматограммы данного анализа с доступом только для чтения. 

Щелчок на закладке Analysis отображает данные сохраненного анализа, если 

таковые имеются. Щелчок на закладке Notes отображает текст, введенный при 

сохранении протокола анализа. 

 

Для просмотра данных сохраненного анализа в окне Evaluation  

1. В окне Home щелкните на Open Run/Analysis в секции Evaluation. Откроется 

диалоговое окно Open Run/Analysis. 

 По умолчанию протоколы анализов сохраняются в папке My Projects (Мои 

проекты), отображаемой в левой секции окна. Все сохраненные файлы 

протоколов анализов отображаются в правой секции окна. 

2. Выделите файл для просмотра хроматограммы сохраненного протокола 

анализа с доступом только для чтения в закладке Chromatogram 

(Хроматограмма). 

Информация по переименованию и удалению протоколов анализов приведена в 

разделе «Управление протоколами анализов» на стр. 221. 
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 5 Редактор методов 

Данная глава приводит концепции и функции программы Method Editor (Редактор 

методов) программного обеспечения ChromLab™ и подготавливает пользователя к 

созданию метода, что является основной темой главы 6. 

Метод состоит из последовательно выполняемых стандартных или 

пользовательских фаз. Каждая фаза состоит из группы шагов. Все эти шаги и фазы 

связаны с элементами схемы жидкостного тракта. При изменении схемы 

жидкостного тракта настройки Редактора методов также меняются в соответствии со 

схемой. 

Редактор методов автоматизирует хроматографические анализы. Создайте план 

метода, используя стандартные фазы хроматографического анализа, такие как 

уравновешивание, ввод образца, элюирование образца и регулировка параметров 

для соответствия требованиям эксперимента. 

Редактор методов упрощает и ускоряет создание метода и является достаточно 

гибким и мощным инструментом для создания сложных методов. Функции Редактора 

методов: 

■ Стандартные фазы для быстрого создания методов 

■ Схема жидкостного тракта, отображающая устройства, присутствующие в 

системе, и путь прохождения жидкости между ними. 

■ Градиентная кривая, отображающая профиль элюции метода как функцию от 

%B 

■ Возможность редактирования шагов метода и создания пользовательских фаз 

■ Возможность сохранения пользовательских фаз для специальных областей 

применения 

■ Возможность сохранения шаблонов методов для повторного использования 

■ Возможность экспортирования методов и распечатки отчетов по методам 
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Вводные сведения 

Перед началом работы с Редактором методов очень важно задать по умолчанию 

схему жидкостного тракта, соответствующую системе капилляров и конфигурации 

вашей системы NGC. При выполнении анализа по заданному методу ПО ChromLab 

предполагает, что система капилляров будет точно соответствовать схеме 

жидкостного тракта. Выбранная схема жидкостного тракта также определяет уставки 

параметров фаз, отображаемые в секции Method Settings (Настройки метода). 

Более подробная информация приведена в разделе «Конфигурации схемы 

жидкостного тракта» на стр. 53. 

Доступ к функциям Редактора методов 

В окне Home секция Method Editor отображает команды, обеспечивающие доступ к 

следующим функциям: 

■ Открытие шаблона метода 

■ Просмотр, редактирование или выполнение метода 

■ Создание нового метода 

■ Выбор метода из списка новых методов 
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Открытие метода 

При выборе Open Method (Открыть метод) появляется диалоговое окно Open 

Method. 

 

Данное диалоговое окно содержит в левой секции перечень сохраненных проектов. 

Сохраненные методы в выбранном проекте перечисляются в верхней правой секции. 

Нижняя правая секция отображает информацию о выбранном методе в трех 

закладках: 

■ Закладка Gradient отображает градиентную кривую для выбранного метода. 

■ Закладка Runs отображает перечень протоколов анализов в выбранном 

методе. 

■ Закладка Notes отображает текст, введенный при сохранении протокола 

анализа. 

Для открытия метода 

1. Выполните одно из следующих действий: 

■ В окне Home щелкните на Open Method. 

■ В окне Method Editor выберите File > Open Method. 

2. В диалоговом окне Open Method выберите метод и щелкните на Open для 

запуска метода в окне Method Editor. 
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Окно Method Editor 

Через окно Method Editor можно создавать, открывать, импортировать, 

экспортировать, просматривать, редактировать и выполнять метод или 

переопределенный шаблон метода. Окно Method Editor содержит несколько секций, 

отличающихся друг от друга в зависимости от выбранного вида. По умолчанию окно 

Method Editor отображает настройки для выбранного метода. 

  

УСЛОВНЫЕ ОБОЗНАЧЕНИЯ 

1 Закладки, через которые осуществляется доступ к основным функциональным 

областям. 

2 Команды панели инструментов, обеспечивающие быстрый доступ к опциям меню. 
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УСЛОВНЫЕ ОБОЗНАЧЕНИЯ 

3 Левая секция, отображающая кнопки режимов просмотра метода: 

■ Method Settings (Настройки метода) — (вид по умолчанию) отображает 

схему жидкостного тракта и настройки для выбранного метода. 

■ Method Outline (План метода) — отображает план метода, градиентную 

кривую и параметры фаз для выбранного метода. 

■ Method Steps (Шаги метода) — отображает план метода, градиентную 

кривую и шаги для выбранного метода. 

4 Главная секция отображает подробную информацию о методе, в зависимости от 

выбранного вида. 

5 Строка состояния отображает подключенный прибор NGC. 

Опции меню File (Файл) 

New Method (Новый метод) — открывает окно Method Editor, в котором вы можете 

создать метод. 

Open Method (Открыть метод) — открывает диалоговое окно, в котором вы можете 

выбрать проект и открыть метод.  

Open Template (Открыть шаблон) — открывает диалоговое окно, содержащее 

перечень всех шаблонов методов с подробной информацией о них, а также с 

отображаемым градиентом метода. 

Save (Сохранить) — сохраняет текущий метод.  

Save As (Сохранить как) — сохраняет текущий метод под новым именем. 

Save As Template (Сохранить как шаблон) — сохраняет текущий метод как 

шаблон. 

Rename (Переименовать) — открывает диалоговое окно Rename Method 

(Переименовать метод), содержащее имя текущего метода. Для переименования 

метода можно использовать до 50 символов. 

Delete (Удалить) — удаляет только текущий открытый метод или метод и 

соответствующие протоколы анализов.  Не удаляет соответствующий протокол 

анализа, открытый в окне Evaluation или являющийся частью анализа, состоящего из 

нескольких анализов. 

Start Run (Запустить анализ) — отправляет запрограммированный метод на 

прибор для однократного или многократного выполнения.  

Close Method (Закрыть метод) — закрывает текущий метод и осуществляет 

возврат к окну Home. 
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Export Method (Экспортировать метод) — экспортирует сохраненный регулярный 

или поисковый метод на рабочий стол или в файл директории под выбранным вами 

именем с добавленным расширением .ngcMethod. Экспортированные методы могут 

быть импортированы в другую систему NGC. 

Export Method with Runs (Экспортировать метод с протоколами анализов) — 

экспортирует сохраненный метод с протоколами анализов на рабочий стол или в 

файл директории под выбранным вами именем с добавленным расширением 

.ngcMethodRuns. Экспортированные методы с соответствующими протоколами 

анализов могут быть импортированы в другую систему NGC. Если метод был 

сохранен несколько раз, данная команда экспортирует последний по времени 

сохраненный метод и соответствующие протоколы анализов. 

Import (Импортировать) — открывает диалоговое окно, в котором вы можете 

выбрать проект и файл метода (включая файл поискового метода), выбрать 

уникальное имя для файла метода, и затем импортировать файл в проект. 

Method Report (Отчет по методу) — генерирует отчет в табличной форме, 

содержащий всю информацию о текущем методе. Отчет можно распечатать и 

сохранить в виде файла в форматах .pdf, .ppt и .doc. 

Preferences (Глобальные параметры) — открывает диалоговые окна, 

позволяющие осуществлять следующие действия: 

■ Выбирать единицы давления для всех системных и программных величин 

давления. Это основная настройка. 

■ Настраивать сервер SMTP для отправки сообщений по электронной почте о 

состоянии системы от компьютера с ПО ChromLab. 

Exit (Выход) — закрывает ПО ChromLab. 

Опции меню Edit (Правка) 

Delete Phase (Удалить фазу) — открывает диалоговое окно, в котором вы можете 

подтвердить удаление фазы и удалить ее.  

Save As New Phase (Сохранить как новую фазу) — открывает диалоговое окно, в 

котором вы можете указать имя новой пользовательской фазы и сохранить фазу. 

Rename Phase (Переименовать фазу) — открывает диалоговое окно, в котором вы 

можете переименовать фазу. 
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Опции меню View (Просмотр) 

Show Gradient Graph (Отобразить градиентную кривую) — отображает 

градиентную кривую текущего метода.  Сброс данной команды скрывает 

градиентную кривую. 

Опции меню Tools (Инструменты) 

Flow Rate Converter (Преобразователь скорости потока) — открывает 

преобразователь скорости потока, позволяющий определять скорость потока для 

каждой колонки в протоколе анализа, выполняемого по заданному методу, на 

основании размера колонки и введенной начальной скорости. Значение скорости, 

введенное в «мл/мин», преобразуется в значение в «см/ч» и «л/ч»; значение 

скорости, введенное в «см/ч», преобразуется в значение в «мл/мин» и «л/ч». Можно 

скопировать результат в преобразователе и вставить его в метод. 

Опции меню Help (Справка) 

Help (Справка) — отображает тематические разделы и ссылки на установленные 

руководства. 

Export Diagnostic Logs (Экспортировать журналы диагностики) — открывает 

диалоговое окно Export Diagnostic Logs, в котором можно осуществлять экспорт всей 

важной информации, необходимой Службе технической поддержки Bio-Rad для 

диагностических целей. Файлы регистрации и данные архивируются и сохраняются в 

указанном вами месте. Более подробная информация приведена в разделе 

«Экспорт журналов диагностики» на стр. 275. 

About (О программе) — отображает информацию об авторском праве и версии ПО 

ChromLab. 

Опции панели инструментов 

New (Новый) — открывает окно Method Editor, в котором вы можете создать метод. 

Open (Открыть ) — открывает диалоговое окно, в котором вы можете выбрать 

проект и открыть метод.  

Open Template (Открыть шаблон) — открывает диалоговое окно, содержащее 

перечень всех шаблонов методов с подробной информацией о них, а также с 

отображаемым градиентом метода. 

Save (Сохранить) — сохраняет текущий метод.  

Save As (Сохранить как) — сохраняет текущий метод под новым именем. 

Save As Template (Сохранить как шаблон) — сохраняет текущий метод как 

шаблон. 
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Scout (Поиск) — открывает программу-мастер поиска, позволяющую создавать 

протоколы анализов на основании фаз текущего отображаемого метода. Более 

подробная информация по использованию мастера поиска приведена в разделе 

«Определение параметров в пределах метода» на стр. 184. 

Start Run (Запустить анализ) — отправляет запрограммированный метод на 

прибор для однократного или многократного выполнения.  

Отображение настроек метода 

Секция Method Settings по умолчанию отображает схему жидкостного тракта и 

настройки для выбранного метода. При создании нового метода секция Method 

Settings отображает схему жидкостного тракта прибора NGC. 
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Секция Fluidic Scheme (Схема жидкостного тракта) 

Схема жидкостного тракта (только для наглядного представления) отображает 

текущую конфигурацию прибора и путь прохождения жидкости. Параметры, 

доступные в каждой фазе, являются специфичными для устройств схемы 

жидкостного тракта, принимающих участие в данной фазе. 

Информация по изменению схемы жидкостного тракта приведена в разделе «Схема 

жидкостного тракта» на стр. 133. 

Секция Method Settings (Настройки метода) 

Секция Method Settings отображает настройки для выбранного метода. 

 

В данной секции вы можете определять параметры каждой фазы метода. 

Параметры различаются в зависимости от фазы и устройств, задействованных в 

работе системы, то есть участвующих в данной фазе метода. Некоторые 

глобальные параметры метода, определенные в секции Method Settings, можно 

изменять для каждой фазы. К таким параметрам относятся скорость потока, выбор 

буфера, pH и объема фракций. 

Подробная информация о настройках метода приведена в разделе «Параметры 

настроек метода» на стр. 133. 
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Представление плана метода 

Method Outline (План метода) отображает план метода, градиентную кривую и 

параметры фаз для выбранного метода. При создании нового метода 

представление плана метода отображает библиотеку фаз (Phase Library), из которой 

вы можете «перетащить» фазы в план метода для создания пользовательского 

метода. 
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Секция Method Outline (План метода) 

Секция Method Outline, которая становится видимой при выборе или Method Outline, 

или Method Steps в левой секции окна, отображает фазы в порядке их выполнения. 

 

Фазы, «перетаскиваемые» из библиотеки фаз в секцию Method Outline, появляются в 

порядке их добавления. Вы можете переупорядочить фазы, «перетащив» их в новое 

местоположение. Можно также удалять фазы из плана метода щелчком правой 

кнопкой мыши на фазе и выбором Delete в появившемся меню или выбором фазы и 

нажатием клавиши Delete на клавиатуре. Фазу можно сохранить как новую 

пользовательскую фазу или переименовать ее щелчком правой кнопкой мыши на 

фазе и выбором соответствующей команды в появившемся меню. 

Выбор фазы в плане метода выделяет ту же самую фазу в секции градиентной 

кривой. При выборе Method Outline в левой секции окна в нижней секции появляются 

параметры выбранной фазы. При выборе Method Steps в левой секции окна 

выбранная фаза выделяется в таблице шагов метода в нижней секции. 

Совет: Для быстрой навигации между фазами, которые могут не попасть в поле 

зрения в пределах секции окна, используйте движок под планом метода. 

Секция Gradient Graph (Градиентная кривая) 

Градиентная кривая, отображаемая в плане метода, отображает 

запрограммированные точки градиента и прерывания для участков пути 

прохождения жидкости в градиентном режиме.  
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Участки на кривой соответствуют фазам в плане метода. Вы можете 

отредактировать продолжительность градиента и наклон «перетаскиванием» черных 

точек в новые местоположения. Изменения отражаются в уставках параметров фаз 

в секции Method Outline. 

Скрытие секции Gradient Graph 

Вы можете скрыть секцию градиентной кривой, если для просмотра параметров фаз 

или шагов метода требуется больше пространства. 

Для скрытия секции градиентной кривой 

► Выберите View > Show Gradient Graph для отмены выбора кнопки-флажка и 

скрытия градиентной кривой. 

Библиотека фаз 

Библиотека фаз (Phase Library), которая становится видимой при выборе New 

Method в окне Method Editor или щелчке на кнопке Add Phase (Добавить фазу) в 

секции Method Outline, содержит как стандартные, так и пользовательские фазы, 

которые вы можете использовать для создания методов. 
 

 

Каждая фаза включает ряд запрограммированных 

шагов, представляющих собой хроматографический 

процесс.  Вы можете добавлять или удалять шаги из 

фазы для адаптации ее к конкретному применению.  

Вы также можете сохранять модифицированные фазы 

как пользовательские в закладке Custom, где они будут 

доступны для всех пользователей программного 

обеспечения ChromLab. Описание стандартных фаз 

приведено далее в разделе «Стандартные фазы» на 

стр. 146. 
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Таблица 4. Стандартные фазы 
 

Фаза Описание 

Equilibration (Уравновешивание) Уравновешивание колонки до или после 
элюирования. 

Sample Application (Ввод образца) Ввод образца на колонку. Определяет режим 
ввода образца – прямой или через 
пробоотборную петлю, объем образца, 
скорость потока и буферы, используемые для 
загрузки образца. 

Column Wash (Промывка колонки) Вымывание несвязавшихся белков 
(непрерывный поток) после ввода образца. 
При использовании данной фазы после 
элюирования определенные условия 
обеспечат удаление белков, прочно 
связанных со средой, при условиях, 
используемых для элюирования. 

Elution (Элюирование) Элюирование образца из колонки. 

System CIP-Storage (Очистка 
системы на месте/помещение на 
хранение) 

Споласкивание системы очищающим 
раствором. Для данной фазы используется 
один очищающий раствор или раствор для 
хранения. 

Примечание: Очистка системы на месте 
должна быть единственной фазой в методе. 
Вы можете добавить в метод несколько фаз 
очистки на месте, если требуется 
использование нескольких очищающих 
растворов. 

Column Preparation-Activation 
(Подготовка колонки/активация) 

Перед использованием колонки производится 
удаление раствора для хранения и 
уравновешивание колонки. Повторяя данную 
фазу несколько раз, можно последовательно 
использовать несколько подготовительных 
растворов. 

Column Performance Test (Проверка 
эффективности колонки) 

Проверка эффективности наполненной 
колонки в единицах высоты, эквивалентной 
теоретической тарелке (HETP), и 
коэффициента ассиметрии пика (AS). 
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Таблица 4. Стандартные фазы (продолжение) 
 

Фаза Описание 

System Preparation (Подготовка 
системы) 

Удаление раствора для хранения и 
заполнение системы и впускных отверстий 
буферным раствором перед выполнением 
анализа. Для данной фазы используется один 
буферный раствор каждый раз при ее 
использовании. 

Примечание: Подготовка системы должна 
быть единственной фазой в методе. Вы 
можете добавить в метод несколько фаз 
подготовки системы, если требуется 
циклическое переключение между 
несколькими растворами. 

Create New Phase (Создание новой 
фазы) 

Добавление шагов из библиотеки шагов (Step 
Library) для создания фазы и сохранения ее в 
пользовательской библиотеке фаз. 

Добавление фазы в метод 

Для добавления фазы в метод 

1. В секции Method Outline щелкните на кнопке Add Phase для отображения 

библиотеки фаз, если она еще не открыта. 

2. Выполните одно из следующих действий: 

■ «Перетащите» фазу в соответствующее местоположение в плане метода. 

■ Дважды щелкните на фазе для добавления ее после текущей выбранной 

фазы в плане. 

Совет: Убедитесь, что фаза добавлена после выбранной фазы, а не в 

конце плана метода. При необходимости переставьте фазу 

«перетаскиванием». 
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Секция Phase Parameters (Параметры фазы) 

Секция Phase Parameters отображает подробные сведения о фазе, выбранной в 

плане метода. Фаза представляет собой часть метода, состоящую из отдельного 

блока шагов, созданных для выполнения конкретной задачи. Используйте данную 

секцию для изменения параметров каждой фазы при добавлении ее в план метода. 

Подробная информация об элементах управления и параметрах фаз приведена в 

разделе «Элементы управления и параметры фаз» на стр. 144. 
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Представление шагов метода 

Представление шагов метода отображает план метода, градиентную кривую и шаги 

для выбранного метода. В представлении шагов метода также отображается 

библиотека шагов (Step Library), из которой вы можете выбирать конкретные шаги 

для добавления их в отдельные фазы в пределах метода. 
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Секция Method Steps (Шаги метода) 

Секция Method Steps отображает таблицу всех шагов, связанных с методом, и их 

настройки. Используйте данную секцию для модификации фаз и создания 

пользовательских фаз. 

 

Если схема жидкостного тракта включает модуль SIM с автосамплером, при 

активации автосамплера в столбце Step Description (Описание шага) появляется 

устройство управления модулем SIM. Если схема жидкостного тракта включает 

модуль SIM без автосамплера, в столбце Step Description появляется устройство 

управления модулем SIM, а в столбце Step Parameters (Параметры шага) 

появляются имя и тип сигнала устройства. Тип сигнала изменяется с High (Сильный) 

на Low (Слабый) в момент впрыска образца и возвращается к High по завершении 

впрыска. 

Если метод является поисковым, таблица содержит столбец Scout. Шаги данного 

метода идентифицируются «галочкой» в столбце Scout. 

Библиотека шагов 

Библиотека шагов (Step Library) содержит необходимые для создания фазы шаги. 

Шаги определяют отдельные события, происходящие в системе, например, 

изменения положений клапанов. Двойной щелчок на имени шага добавляет шаг в 

текущую фазу. Вы можете добавить в один метод несколько однотипных шагов. 

Библиотека шагов включает следующие шаги: 

■ Gradient Segment (Градиентный участок) 

■ Load/Inject Sample (Загрузка/впрыск образца) 
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■ Fraction Collection (Сбор фракций) 

■ Change Valve (Сменить положение клапана) 

■ Lamp Control (Управление лампой) 

■ Zero Baseline (Обнулить базовую линию) 

■ Hold Until (Поддерживать до…) 

■ Pause (Приостановить) 

■ System Wash (Промывка системы) 

Для получения подробной информации о шагах метода 

► В окне Method Editor выберите Help > Method Steps, после чего выберите шаг в 

появившемся раскрывающемся списке. 

Просмотр информации о шаге 

Для просмотра информации о шаге 

► Щелкните правой кнопкой мыши на таблице шагов и выберите Show Step 

Details (Показать информацию о шаге) в появившемся меню. 

Добавление, изменение и удаление шагов 

Для добавления шага в таблицу шагов 

1. Выберите шаг в таблице шагов. 

2. Дважды щелкните на шаге в библиотеке шагов. 

Шаг немедленно появится в таблице под выбранным шагом. 

Для изменения шага в таблице шагов 

► Дважды щелкните на шаге для открытия его диалогового окна, в котором вы 

сможете изменить настройки шага. 

Для удаления шага из таблицы шагов 

► Щелкните правой кнопкой мыши на шаге и выберите Delete Step (Удалить шаг) 

в появившемся меню. 
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Параметры настроек метода 

Настройки метода представляют собой общие параметры, влияющие на метод в 

целом. Данные настройки включают схему жидкостного тракта, выбор колонки, 

настройки детекторов, выбор единиц измерения, клапан детектора pH, сбор фракций 

и выбор буфера. 

Fluidic Scheme (Схема жидкостного тракта) 

Текущая конфигурация прибора отображается в верхней секции представления 

настроек метода. Параметры, доступные в каждой фазе, являются специфичными 

для устройств схемы жидкостного тракта, принимающих участие в данной фазе. См. 

«Конфигурации схемы жидкостного тракта» в главе 3. 

Для изменения схемы жидкостного тракта 

1. В секции Method Settings под Fluidic Scheme щелкните на Change (Изменить) 

для открытия диалогового окна Fluidic Scheme Selection (Выбор схемы 

жидкостного тракта). 

2. Измените или отредактируйте выбранную схему жидкостного тракта под 

устройства вашей системы. 

3. Щелкните на Save для сохранения конфигурации. 

Важно: Изменение схемы жидкостного тракта метода, включающего фазы, может 

сделать недействительными некоторые фазы. Компания Bio-Rad рекомендует 

выбирать схему жидкостного тракта до добавления фаз в метод. 
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Column Selection (Выбор колонки) 

Под Column Selection (Выбор колонки) вы выбираете колонку и параметры колонки 

для метода. Параметры объема и давления колонки задаются автоматически при 

выборе типа колонки из списка предварительно определенных колонок. 

Если ваша схема жидкостного тракта включает один клапан переключения колонок 

или более, вы можете задать параметры как для одной колонки, так и для 

нескольких. Если в методе используются несколько колонок, фазы метода 

применяют параметры давления для всех подключенных для данной фазы колонок. 

Для включения двух или трех колонок в один метод можно использовать шаги 

метода. В данных случаях событие высокого давления генерируется, когда перепад 

давления для одного из клапанов переключения колонок достигает предельного 

значения, определенного в Method Settings для подключенных колонок. 

Вы можете сконфигурировать свойства нескольких колонок, по одной на каждый 

порт каждого клапана переключения колонок, и добавить их в метод, используя 

диалоговое окно Configure Ports (Конфигурировать порты). При выборе данной 

кнопки-флажка по умолчанию задается одна колонка. Значение по умолчанию для 

объема колонки используется на протяжении всего анализа по выбранному методу 

независимо от других используемых в методе колонок. Кроме того, метод по 

умолчанию использует максимальное давление в предколонке и максимальную 

разницу давлений в колонках при отсутствии других подключенных колонок. Если 

подключены две колонки или более, метод использует максимальное давление в 

предколонке для первой колонки. 

Если колонка больше не используется, ее можно удалить из списка, сбросив 

назначенный порт. К порту затем можно добавить другую колонку. Можно также 

добавить в метод порт без назначенной колонки, используя шаг смены положения 

клапана (Change Valve) из библиотеки шагов. При сохранении метода появляется 

сообщение, напоминающее о необходимости назначить данному порту диапазон 

рабочих давлений. С помощью диалогового окна Configure Ports можно назначить 

диапазон рабочих давлений без назначения колонки порту. Данная функция полезна 

при использовании чувствительных к давлению петель для конкретных процедур 

многоколоночной очистки. Если порту не назначен диапазон рабочих давлений, по 

умолчанию применяется диапазон рабочих давлений системы. 

Примечание: Если клапаны переключения колонок находятся в обходном режиме 

или в случае отсутствия подключенных портов система использует значение 

максимального давления в предколонке (Max Pre-Column Pressure (Bypass All)), 

задаваемое пользователем в диалоговом окне Configure Ports. 
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Вы можете добавить колонки в библиотеку колонок, используя диалоговое окно Add 

User Defined Column (Добавить определенную пользователем колонку). 

Добавленные колонки появляются в виде уникальных типов колонок в категории 

User Defined (Определенные пользователем). Добавленные колонки также 

отображаются в перечне выбора колонок в мастере поиска, если вы производите 

поиск колонок. 

Определенные пользователем колонки можно удалить из библиотеки колонок, 

используя диалоговое окно Remove User Defined Column (Удалить определенную 

пользователем колонку). При удалении колонки, используемой в сохраненном 

методе, метод сохраняет информацию о колонке. Тем не менее, после удаления из 

библиотеки колонок она больше не будет отображаться в перечне выбора колонок и 

не будет доступна для анализов, выполняемых по заданному методу. После 

создания другой определенной пользователем колонки можно повторно 

использовать для нее имя удаленной колонки. 

Для конфигурирования параметров для нескольких колонок 

1. В секции Column Selection выберите Multiple Columns (Несколько колонок). 

Появится кнопка Configure Ports. 

 Примечание: Данная кнопка появляется только после выбора опции Multiple 

Columns. 

2. Щелкните на Configure Ports. Появится диалоговое окно Configure Ports. 

 

3. Выберите положение колонки для конфигурирования из раскрывающегося 

списка. 

4. (Опционально) Отобразите колонки, доступные для конкретного метода, из 

раскрывающегося списка. 

5. Выберите тип колонки. Выполните одно из следующих действий: 

■ Выберите тип колонки из раскрывающегося списка. Параметры объема и 

давления для данного типа колонки задаются автоматически. 
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■ Выберите Custom из раскрывающегося списка и задайте параметры 

объема и давления для колонки с данным портом.  

6. Щелкните на Add. 

7. Повторите шаги 3-6 для остальных портов. 

Примечание: Первая добавленная колонка задается как колонка по 

умолчанию. Колонка по умолчанию определяет объем колонки, используемый в 

качестве основного для всего метода, и определяет исходный диапазон 

рабочих давлений для данного метода. Для замены колонки по умолчанию на 

другую колонку выберите данную кнопку-флажок. 

8. Щелкните на кнопке Save. 

Для удаления назначенного положения колонки из метода 

► В диалоговом окне Configure Ports выберите колонку, которую вы хотите 

удалить, щелкните на Remove, и затем – на Save. 

Для добавления определенных пользователем колонок 

1. В секции Column Selection выполните одно из следующих действий: 

■ Выберите Single Column (Одна колонка) и щелкните на . 

■ Выберите Multiple Columns (Несколько колонок), щелкните на Configure 

Ports и на  в диалоговом окне Configure Columns. 
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Появится диалоговое окно Add User Defined Column (Добавить определенную 

пользователем колонку). 

 

Совет: Единицы давления выбираются на основании значений давления в File 

> Preferences. 

2. Предоставьте для колонки необходимую информацию. Красная «звездочка» (*) 

указывает, что поле требует заполнения. 

Примечание: Поле Column Name (Имя колонки) имеет ограничение в 45 

символов. 

Параметры Column Volume (Объем колонки), Column Diameter (Диаметр 

колонки) и Column Bed Height (Высота слоя колонки) связаны. При вводе или 

изменении значений для любых двух полей система автоматически 

рассчитывает значение для третьего поля. 

Поля Recommended Linear Flow Rate (Рекомендуемая линейная скорость 

потока) и Max Linear Flow Rate (Максимальная линейная скорость потока) 

доступны только для чтения. Значения данных полей автоматически 

рассчитываются при вводе значений в поля Recommended Flow Rate и Max 

Flow Rate fields, соответственно. 
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3. Щелкните на кнопке Save. 

Новая колонка появится в раскрывающемся списке Column Type (Тип колонки) 

в категории User Defined. 
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Для удаления определенных пользователем колонок 

1. В секции Column Selection выполните одно из следующих действий: 

■ Выберите Single Column (Одна колонка) и щелкните на . 

■ Выберите Multiple Columns, щелкните на Configure Ports и на  в 

диалоговом окне Configure Columns. 

Появится диалоговое окно Remove User Defined Column (Удалить 

определенную пользователем колонку). 

 

2. Выберите одну или несколько колонок для удаления. 

3. Щелкните на Remove. 

Detector Settings (Настройки детектора) 

Под Detector Settings (Настройки детектора) задайте одну длину волны для УФ-

детектора или несколько длин волн для фотометрического детектора, которые будут 

использоваться для мониторинга хода анализа. Для одноволнового детектора 

выберите или 280 нм, или 255 нм. (Наиболее широко используемая длина волны для 

белков – 280нм). Для многоволнового детектора выберите любые четыре длины 

волн от 190 до 800 нм. 

Unit Selection (Выбор единиц измерения) 

Method Base Unit (Базовые единицы измерения метода) — задает для 

хроматограммы единицы оси Х по умолчанию. 

Flow Rate Unit (Единицы измерения скорости потока) — единицы измерения 

скорости потока по умолчанию.  
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pH Valve (Клапан детектора pH) 

Enable pH monitoring (Активировать контроль pH) — если присутствует 

клапан детектора pH, данная кнопка-флажок выбирается по умолчанию. Для 

обхода клапана-детектора pH отмените выбор данной кнопки-флажка. 

Fraction Collection (Сбор фракций) 

Device Type (Тип устройства) — отображает текущий выбранный коллектор 

фракций. Если ваша схема жидкостного тракта включает: 

■ только коллектор фракций, данное диалоговое окно отображает «BioFrac» 

и тип штатива 

■ только выходные клапаны, данное диалоговое окно отображает «Outlet 

Valve» 

■ коллектор фракций и выходные клапаны, данное диалоговое окно 

отображает «Outlet Valve», «BioFrac» и тип штатива 

Щелкните на Configure для конфигурирования устройства сбора фракций и 

контур сбора. 

 

Важно: Минимальный рекомендуемый размер фракций для систем NGC 

составляет 10% от скорости потока. 
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BioFrac Settings (Настройки BioFrac) — по умолчанию сбор фракций 

начинается в первую пробирку первого штатива. Размер фракций задается по 

умолчанию для каждого типа штатива. 

BioFrac Collection Pattern (Контур сбора коллектора фракций BioFrac) — по 

умолчанию выбран змеевидный контур (Serpentine). В случае микропланшетов 

сбор фракций может производиться рядами или столбцами. 

Outlet Valve Settings (Настройки выходного клапана) — по умолчанию сбор 

фракций начинается с выходного клапана 1, порт 2 ((O1) Port 2.) Порт 1 

выходного клапана 1 (O1 Port 1) подключается к коллектору фракций BioFrac™, 

если таковой имеется, или направляет поток в отходы, если коллектор фракций 

отсутствует. Размер фракций по умолчанию – 50 мл. 

Flow (Поток) 

Flow Rate (Скорость потока) — отображает скорость потока по умолчанию 

для выбранного метода. 

Control the flow to avoid overpressure (Контролировать поток для 

предотвращения превышения давления) — контролирует давление и снижает 

скорость потока на 50%, когда давление достигает определенного процента от 

максимального (значение по умолчанию – 80%, см. «Закладка Control Flow 

(Управление потоком)» в главе 3 для получения более подробной информации). 

Detect end of buffer with air sensor (Детектировать конец буфера датчиком 

воздуха) — останавливает системные насосы при детектировании воздуха в одной 

из линий, подключенных к датчикам воздуха, установленным на детектирование 

конца буфера. Настройки датчиков воздуха определяется в закладке Air Sensors 

диалогового окна System Settings. (Более подробная информация приведена в 

разделе «Закладка Air Sensors (Датчики воздуха) в главе 3). 

Buffer Selection (Выбор буфера) 

Примечание: Если конфигурация не включает смесительный клапан для буферных 

растворов, настройки буфера неактивны. 

Вы можете выбрать один из трех режимов выбора буфера: 

■ Manually Prepared (Приготовленный вручную) — буферы подготавливаются 

пользователем и подаются непосредственно в насосы или выбираются через 

клапаны переключения буферных растворов. 

■ Manually Prepared via Blending Valve (Приготовленный вручную, подача 

через смесительный клапан для буферных растворов) — буферы 

подготавливаются пользователем и подаются в насос через порты 

смесительного клапана для буферных растворов Q1 и Q4. Градиенты 

создаются через смесительный клапан, а не через насосы. Поэтому оба насоса 

могут одновременно работать на полной мощности, что удваивает доступный 

диапазон производительности. 
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■ Buffer Blending (Смешивание буфера) — смешивание кислоты, основания, 

воды и соли для приготовления буферного раствора с заданными pH, 

концентрациями буфера и соли. Для использования выбирается буферная 

система (рецепт), после чего осуществляется приготовление растворов 

кислоты, основания, воды и соли, которые подаются насосам через порты 

смесительных клапанов для буферных растворов Q1-Q4. Градиенты создаются 

через смесительный клапан, а не через насосы. Поэтому оба насоса могут 

одновременно работать на полной мощности, что удваивает доступный 

диапазон производительности. 

Щелчок на Rename Ports (Переименовать порты) позволяет переименовывать порты 

на клапанах переключения колонок, клапанах переключения буферных растворов и 

клапанов выбора образца. Например, вы можете переименовать порты на клапане 

переключения колонок для отображения имени колонок, подключенных к каждому 

конкретному порту. После переименования портов новые имена появляются в 

методе вместо имен портов клапанов. 

Для выбора режима буфера по умолчанию для выбранного метода используйте 

Таблицу 5. Доступные опции зависят от выбранной схемы жидкостного тракта и 

клапанов, подключенных к вашей системе. Инструкции по заданию объема задержки 

приведены в разделе «Настройки системы» на стр. 71. 

Таблица 5. Режимы выбора и типы подачи буферных растворов 
 

Режимы выбора буфера 

Тип подачи буфера 
Приготовленный 
вручную 

Приготовленный вручную, 
подача через смесительный 
клапан для буферных 
растворов 

Смешивание 
буфера 

Входы насосов    

Насос + входные клапаны    

Насос + смесительный клапан для 
буферных растворов 

   

Насос + смесительный клапан для 
буферных растворов + входные 
клапаны 

   

Если вы работаете со схемой жидкостного тракта, включающей несколько входных 

клапанов, вы можете осуществлять переключение буферных растворов. 

Примечание: Для смешивания буфера требуется смесительный клапан для 

буферных растворов. 

Смешивание может использоваться для разведения буферных растворов. 

Определите pH элюирования и выберите буферы для достижения данного pH. 
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Select Buffer (Выбрать буфер) — открывает диалоговое окно Buffer Recipes 

(Рецепты приготовления буфера), в котором вы можете выбрать рецепт 

приготовления буфера и присвоить буферам имена.  

 

Для выбора буфера 

1. В диалоговом окне Buffer Recipes под Recipe Selection (Выбор рецепта) вы 

можете отфильтровать перечень рецептов, выбрав тип титрования в 

раскрывающемся списке. 

2. В раскрывающемся списке Sort by (Сортировать по…) выберите Name (Имя) 

или pH для просмотра перечня названий рецептов в предпочитаемом вами 

порядке. 

3. Выберите рецепт в раскрывающемся списке Recipe Name (Название рецепта). 
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Available Range (Доступный диапазон) — доступные диапазоны концентраций и 

значений pH различаются в зависимости от выбранного вами рецепта. Приводимые 

диапазоны являются рекомендуемыми. Вы можете выбрать значения, 

превышающие верхний предел диапазона, но это потребует дополнительных 

регулировок для обеспечения точности. В большинстве рецептов вы можете 

изменить концентрацию буфера, уменьшив концентрацию исходного раствора на 1/2 

- 1/8 для кислотно-основного титрования и до ¼ для титрования кислоты или 

основания. Концентрация исходного раствора для большинства рецептов 

составляет 0,2 М. 

Трис-буфер и фосфатный буфер – наиболее широко используемые рецепты, в 

зависимости от типа хроматографической процедуры. 

pH Correction (Стабилизация pH) — используется для стабилизации измеренного 

pH (Observed pH) для обеспечения его соответствия показателю pH, заданного для 

анализа (Desired pH) в диалоговом окне System Pump или в секции Phase Parameters 

представления плана метода. При стабилизации pH используется разница между 

заданным pH и измеренным pH. 

Совет: Для обеспечения точности показаний pH регулярно производите калибровку 

датчика pH. 

Элементы управления и параметры фаз 

Редактор методов включает несколько стандартных фаз. Подробная информация 

приведена в разделе «Стандартные фазы» на стр. 146. 

Фаза представляет собой часть метода, состоящую из отдельного блока шагов, 

созданных для выполнения конкретной задачи. Каждая фаза включает элементы 

управления и параметры, специфичные для конкретной выполняемой задачи. 

Ниже приведены элементы и параметры, используемые в отдельных фазах: 

■ Gradient Segments (Градиентные участки) — определяют 

продолжительность элюирования и состав буфера (%B) для изократических 

или градиентных режимов. 

Совет: Каждая фаза проходит с одной скоростью потока. Для изменения 

скорости потока выберите другую фазу. 

В изократических режимах исходный и конечный составы буфера должны быть 

равны. На прямых участках исходный и конечный составы буфера не зависят 

друг от друга. 
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На градиентных участках меньшие количества дают возрастающие градиенты. 

Большие количества дают отрицательные градиенты. 

■ Load/Inject Sample (Загрузка/впрыск образца) — контролирует загрузку 

пробоотборной петли, впрыск образца и промывку петли.  

■ Fraction Collection (Сбор фракций) — запускает процесс сбора фракций для 

фазы, задает схему сбора фракций, позволяет выбирать основное устройство 

сбора фракций (коллектор фракций BioFrac или выходной клапан), задает 

стартовый капилляр или порт и размер фракций. 

■ Change Valve (Сменить положение клапана) — переводит выбранный клапан 

в выбранное положение.  

■ Lamp Control (Управление лампой) — задает длину волны и 

включает/выключает лампу для выбранного на схеме жидкостного тракта 

детектора. 

■ Zero Baseline (Обнулить базовую линию) — обнуляет базовую линию для 

УФ-детектора, выбранного на схеме жидкостного тракта. 

■ Hold Until (Поддерживать до…) — поддерживает текущий состав фазы до 

нажатия кнопки, паузы или достижения порогового значения. 

■ Pause (Приостановить) — приостанавливает анализ по выбранному методу 

до нажатия кнопки или достижения времени ожидания. 

■ System Wash (Промывка системы) — последовательно переключает насосы, 

клапаны и пробоотборные петли, и пропускает определенные объем 

очищающего раствора с определенной скоростью через каждое положение. 

Примечание: Данный шаг не поддерживается, если метод содержит шаги 

Gradient Segments или Load/Inject Sample. 
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Стандартные фазы 

Некоторые стандартные фазы используют идентичные параметры. Например, фаза 

промывки колонки и фаза элюирования отображают одинаковые параметры. Пример 

параметров каждой фазы включен в ее описание. 

Примечание: Изображения в данном разделе приводят параметры и настройки для 

схемы жидкостного тракта системы NGC Discover Pro. Ваши параметры и настройки 

могут различаться в зависимости от используемых схемы жидкостного тракта и 

метода. 

Параметры ввода образца 

Для фазы ввода образца необходимо определить, каким образом образец будет 

подаваться на колонку. В зависимости от конфигурации системы, вы можете подать 

образец на колонку вручную через пробоотборную петлю или непосредственно 

через насос для образца или автосамплер (если подключен). 

Для всех конфигураций предоставляется опция продолжения впрыска образца до 

достижения конкретного показания УФ-детектора. Также предоставляется 

возможность предварительного заполнения всех линий заданным объемом буфера, 

когда загрузочный буфер отличается от буфера, используемого в предыдущей фазе. 

Если ваша схема жидкостного тракта включает смесительный клапан для буферных 

растворов, и вы выбираете подачу вручную приготовленного буфера через входные 

клапаны в окне Method Settings, вам предоставляется возможность использовать 

входные порты, определенные в Method Settings, или выбрать конкретные буферы 

от каждого порта. 
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Загрузка петли с помощью насоса для образца 

Если для загрузки петли используется насос для образца, вы можете определить 

скорость потока, объем загрузки петли и, соответственно, объем образца, 

впрыскиваемого на колонку. Вы также можете прервать загрузку петли при 

детектировании воздуха. Если вы выбрали данную кнопку-флажок, и в любой из 

линий, подключенных к датчикам воздуха, настроенным на детектирование конца 

образца, детектируется воздух, система останавливает насос для образца, и анализ 

по выбранному методу продолжается до следующего шага. 

 

Схема жидкостного тракта включает клапан выбора образца 

Если ваша схема жидкостного тракта включает хотя бы один клапан выбора 

образца, и вы производите загрузку петли через насос для образца, вы можете 

перед впрыском образца выполнить промывку насоса для образца, линий и петли 

буфером. Если вы выбрали данную кнопку-флажок, вы можете выбрать порт на 

клапане выбора образца, из которого будет поступать буферный раствор. Вы 

можете определить скорость потока и объем буфера для промывки перед впрыском 

образца. 

Также предоставляется опция промывки насоса для образца и соответствующих 

соединений после впрыска образца. Кроме того, вы можете выбрать порт на клапане 

выбора образца, из которого будет поступать буферный раствор, и определить 

скорость потока и объем буфера для промывки перед впрыском образца. 
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Можно сменить порт на клапане выбора образца, из которого будет осуществляться 

загрузка образца (порт по умолчанию – Port 1). Также можно осуществить 

заполнение системы капилляров образцом перед анализом. Если вы выбираете 

данную кнопку-флажок, вы можете определить скорость потока и объем образца для 

заполнения системы капилляров. 

И наконец, вы можете прервать загрузку петли при детектировании воздуха. Если вы 

выбрали данную кнопку-флажок, и в любой из линий, подключенных к датчикам 

воздуха, настроенным на детектирование конца образца, детектируется воздух, 

система останавливает насос для образца, и анализ по выбранному методу 

продолжается до следующего шага. 
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Впрыск образца напрямую через насос для образца 

Если в схеме жидкостного тракта присутствует насос для образца, и образец 

напрямую впрыскивается на колонку, вы можете воспользоваться опцией 

прерывания процесса впрыска при детектировании воздуха. Если вы выбрали 

данную кнопку-флажок, и в любой из линий, подключенных к датчикам воздуха, 

настроенным на детектирование конца образца, детектируется воздух, система 

останавливает насос для образца, и анализ по выбранному методу продолжается до 

следующего шага. 

 

Схема жидкостного тракта включает клапан выбора образца 

Если ваша схема жидкостного тракта включает хотя бы один клапан выбора 

образца, и вы производите впрыск образца непосредственно на колонку, вы можете 

перед впрыском образца выполнить промывку насоса для образца, линий и петли 

буфером. Если вы выбрали данную кнопку-флажок, вы можете выбрать порт на 

клапане выбора образца, из которого будет поступать буферный раствор. Вы 

можете определить скорость потока и объем буфера для промывки перед впрыском 

образца. 

Также предоставляется опция промывки насоса для образца и соответствующих 

соединений после впрыска образца. Кроме того, вы можете выбрать порт на клапане 

выбора образца, из которого будет поступать буферный раствор, и определить 

скорость потока и объем буфера для промывки перед впрыском образца. 
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Можно сменить порт на клапане выбора образца, из которого будет осуществляться 

загрузка образца (порт по умолчанию – Port 1). Также можно осуществить 

заполнение системы капилляров образцом перед анализом. Если вы выбираете 

данную кнопку-флажок, вы можете определить скорость потока и объем образца для 

заполнения системы капилляров. 

И наконец, вы можете прервать впрыск образца при детектировании воздуха. Если 

вы выбрали данную кнопку-флажок, и в любой из линий, подключенных к датчикам 

воздуха, настроенным на детектирование конца образца, детектируется воздух, 

система останавливает насос для образца, и анализ по выбранному методу 

продолжается до следующего шага. 
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Впрыск образца с помощью автосамплера 

Если ваша схема жидкостного тракта включает автосамплер, и вы выбираете подачу 

вручную приготовленного буфера через входные клапаны в окне Method Settings, 

вам предоставляется возможность использовать входные порты, определенные в 

Method Settings, или выбрать конкретные буферы от каждого порта. 

 

Параметры промывки колонки 

Данная фаза осуществляет промывку колонки от примесей и несвязавшегося 

образца. Можно запрограммировать продолжительность или объем промывки, а 

также ее продолжение до достижения определенного показания УФ-детектора или 

кондуктометрического детектора. В ходе данной фазы можно также активировать 

процедуру сбора фракций. 
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Несмотря на то, что данная фаза обычно используется после ввода образца или 

фазы элюирования, она может применяться отдельно в любой момент при 

возникновении необходимости промывки колонки. 

Параметры элюирования 

В данной фазе элюирование образца из колонки осуществляется с использованием 

градиентного или изократического потока при определенных концентрациях соли 

(%B) за определенное время, объем или объем колонки. Вы можете 

отредактировать параметры на градиентном участке или добавить к данному участку 

шаги градиентного или изократического режима. Данная фаза может использовать 

скорость потока, глобально определенную в фазе Method Settings, или скорость 

потока, отличную от скорости в других фазах. 

 

Сбор фракций активируется по умолчанию в данной фазе, и система предоставляет 

опции сбора всех фракций, сбора фракций при достижении определенного 

порогового показания УФ-детектора или кондуктометрического детектора или сбора 

фракций в пределах определенных интервалов. При сборе фракций по достижению 

порогового значения вы можете выбрать сбор фракций, выходящих за пределы 

определенного диапазона пороговых величин, используя объемы фракций, 

отличные от объемов, заданных для пороговых фракций. 

Система предоставляет следующие опции выбора метода элюирования: 

■ Isocratic (Изократический) – определите продолжительность элюирования 

(CV, см/ч, время, объем) и состав буфера (%B). 

■ Gradient (Градиентный) – определяет линейный градиент (%B; значение по 

умолчанию = 0-100%) и наклон/продолжительность градиента (CV, время, 

объем). В данном случае насосы останавливаются по истечении заданного 

периода времени. 
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Параметры очистки системы на месте/помещения на хранение 

Примечание: Очистка системы на месте должна быть единственной фазой в 

методе. Вы можете добавить в метод несколько фаз очистки на месте, если 

требуется использование нескольких очищающих растворов. Компания Bio-Rad 

рекомендует сохранять процедуру очистки системы на месте в качестве отдельного 

метода. 

Если система была подвергнута воздействию опасного биологического материала, 

выполните очистку на месте системы и колонки для промывки всей системы 

капилляров дезинфицирующим раствором (например, NaOH) с последующим 

споласкиванием нейтральным буфером и дистиллированной водой перед 

обслуживанием или ремонтом. 

Данная фаза производит очистку системы после процедур очистки белков 

посредством промывки системы очищающим раствором. Производите очистку 

системы на месте по мере необходимости, например, между анализами, 

использующими различные образцы и буферы, или перед помещением системы на 

хранение. Это поможет предотвратить перекрестную контаминацию между 

анализами и предотвратит рост бактерий в приборе во время хранения. 

В зависимости от модулей, включенных в схему жидкостного тракта, определите 

объем очистки, выбрав кнопки-флажки для различных клапанов, портов, насосов, 

положений колонки, модулей и петель, для очистки и заполнения элементов 

системы очищающим раствором. Метод очистки системы на месте включает две 

фазы очистки на месте для упрощения использования двух различных растворов, 

например, NaOH, буферного раствора или дистиллированной воды. Выберите 

значения скорости потока, объема на положение и времени инкубации. 

Примечание: Каждая фаза использует один очищающий раствор. Все входные 

линии, выбранные для одной фазы, должны быть погружены в тот же очищающий 

раствор. 

Особенности 

Когда схема жидкостного тракта включает смесительный клапан для буферных 

растворов, системы NGC производят очистку системы на месте по-разному, в 

зависимости от способов приготовления и подачи буфера: подача вручную 

приготовленного буфера через смесительный клапан для буферных растворов, 

смешивание буфера через смесительный клапан для буферных растворов или 

подача вручную приготовленного буфера через клапаны переключения буферных 

растворов. Обратите внимание на следующие моменты, касающиеся очистки 

системы на месте с использованием смесительного клапана для буферных 

растворов в схеме жидкостного тракта. 
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Системы NGC Scout 

 

Выбор буфера: Приготовленный вручную буфер, подача через смесительный 

клапан для буферных растворов 

■ Компоненты для очистки: 

□ Пробоотборная петля 

□ Смесительный клапан для буферных растворов 

□ Проточная ячейка детектора pH 

■ Промывочный раствор подается через порт Q1 для пробоотборной петли и 

проточной ячейки детектора pH. 

■ Порты Q1 и Q4 промываются отдельно объемом 5 мл. 

Выбор буфера: Смешивание буфера 

■ Компоненты для очистки 

□ Пробоотборная петля 

□ Смесительный клапан для буферных растворов 

□ Проточная ячейка детектора pH 

■ Промывочный раствор подается через порт Q1 для пробоотборной петли и 

проточной ячейки детектора pH. 

■ Порты Q1, Q2, Q3 и Q4 промываются отдельно объемом 5 мл. 



Элементы управления и параметры фаз 

Руководство пользователя   |   155 

Системы NGC Discover и NGC Discover Pro 

Примечание: Для проведения очистки на месте для смесительного клапана для 

буферных растворов и клапанов переключения буферных растворов необходимо 

создать отдельные методы, которые можно поставить в очередь в программе-

планировщике анализов Run Scheduler. 

Выбор буфера: Приготовленный вручную буфер, подача через смесительный 

клапан для буферных растворов 

 

■ Компоненты для очистки: 

□ Пробоотборная петля 

□ Смесительный клапан для буферных растворов 

□ Проточная ячейка детектора pH 

□ Насос для образца 

□ Клапаны переключения колонок 

□ Выходные клапаны 

□ Клапаны выбора образца 

■ Промывочный раствор подается через порт Q1 для пробоотборной петли, 

проточной ячейки детектора pH, клапана переключения колонок и выходного 

клапана. 
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■ Клапаны выбора образца промываются с помощью насоса для образца, 

подающего промывочный раствор через порты 1-8 на клапане выбора образца 

S1 (при наличии только одного клапана выбора образца) или порты 1-7 на 

клапане выбора образца S1 и порты 1-8 на клапане выбора образца S2 (при 

наличии двух клапанов выбора образца). 

■ Порты Q1 и Q4 промываются отдельно объемом 5 мл. 

■ Порты A1-7 и B1-7 клапанов переключения буферных растворов не 

промываются. 

Выбор буфера: Приготовленный вручную буфер, подача через входные 

клапаны 

 

■ Компоненты для очистки: 

□ Пробоотборная петля 

□ Проточная ячейка детектора pH 

□ Насос для образца 

□ Клапаны переключения колонок 

□ Клапаны переключения буферных растворов 

□ Выходные клапаны 

□ Клапаны выбора образца 
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■ Промывочный раствор подается через порты клапана переключения буферных 

растворов для пробоотборной петли, проточной ячейки детектора pH и клапана 

переключения колонок. 

■ Клапаны выбора образца промываются с помощью насоса для образца, 

подающего промывочный раствор через порты 1-8 на клапане выбора образца 

S1 (при наличии только одного клапана выбора образца) или порты 1-7 на 

клапане выбора образца S1 и порты 1-8 на клапане выбора образца S2 (при 

наличии двух клапанов выбора образца). 

■ Системные насосы, осуществляющие подачу при 0%B и 100%B каждый от 

портов A1-7 и B1-7 клапанов переключения буферных растворов. 

■ Порты Q1, Q2, Q3 и Q4 не промываются. 

Выбор буфера: Смешивание буфера 

 

■ Компоненты для очистки: 

□ Пробоотборная петля 

□ Смесительный клапан для буферных растворов 

□ Проточная ячейка детектора pH 

□ Насос для образца 
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□ Клапан переключения колонок 

□ Выходной клапан 

□ Клапаны выбора образца 

■ Промывочный раствор подается через порт Q1 для пробоотборной петли, 

проточной ячейки детектора pH и клапана переключения колонок. 

■ Клапаны выбора образца промываются с помощью насоса для образца, 

подающего промывочный раствор через порты 1-8 на клапане выбора образца 

S1 (при наличии только одного клапана выбора образца) или порты 1-7 на 

клапане выбора образца S1 и порты 1-8 на клапане выбора образца S2 (при 

наличии двух клапанов выбора образца). 

■ Порты Q1, Q2, Q3 и Q4 промываются отдельно объемом 5 мл. 

■ Порты A1-7 и B1-7 клапанов переключения буферных растворов не 

промываются. 

Для полной очистки путей прохождения жидкости 

► Очистите вручную порт ручного ввода и клапан детектора pH. 

Убедитесь, что датчик pH снят с клапана детектора pH, и что все порты колонки 

подключены к обходной трубке. 

Для очистки клапанов детектора pH 

1. Откройте окно System Control. 

2. Выберите Tools > Calibrate для открытия диалогового окна Calibration. 

Примечание: В данной процедуре калибровка не производится. 

3. Выберите pH в раскрывающемся списке Calibrate. 

4. Щелкните на Start для задания пути прохождения жидкости. 

5. Наполните шприц 1 M NaOH, подсоедините шприц к порту ввода 

калибровочных растворов CaI In клапана детектора pH и впрысните раствор. 
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6. Наполните шприц 1 M NaOH, подсоедините шприц к порту ввода 

калибровочных растворов CaI In клапана детектора pH и впрысните раствор. 

7. Щелкните на Close в диалоговом окне Calibration для входа из режима 

калибровки. 

8. Переключите клапан обратно в положение по умолчанию. 

Подготовка колонки – активация 

Данная фаза используется для подготовки колонки перед использованием 

посредством удаления раствора для хранения или активации колонки для 

связывания образца перед его вводом. Если активация требует инкубации колонки в 

буфере для активации, выберите Pause Until Resume (Приостановить до 

возобновления) и определите время, необходимое для инкубации колонки. 
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Параметры проверки эффективности колонки 

Данная проверка объединяет три основные фазы, необходимые для анализа 

(уравновешивание, ввод образца и элюирование). После уравновешивания колонки 

неадсорбирующий образец, такой как ацетон или соль, впрыскивается через 

пробоотборную петлю и элюируется при изократических условиях. После анализа 

проверьте эффективность колонки в единицах высоты, эквивалентной 

теоретической тарелке (HETP), и коэффициента ассиметрии пика (AS). 
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Параметры подготовки системы 

Данная фаза удаляет раствор для хранения и заполняет систему капилляров и 

входную линию системы перед анализом буферным раствором. Выбираются входы, 

выходы и положения подготавливаемой колонки, и система заполняется 

соответствующим буферным раствором. Так как каждый входной порт может быть 

подключен к другому буферу или образцу, в каждой фазе могут использоваться 

несколько буферов и образцов. 

Примечание: Подготовка системы должна быть единственной фазой в методе. Вы 

можете добавить в метод несколько фаз подготовки системы, если требуется 

циклическое переключение между несколькими растворами. Компания Bio-Rad 

рекомендует сохранять процедуру подготовки системы в качестве отдельного 

метода. 
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Параметры создания новой фазы 

Данная фаза позволяет создавать новую фазу добавлением шагов из библиотеки 

шагов в текущую фазу в представлении шагов метода. Создаваемые фазы можно 

сохранять в библиотеке пользовательских фаз для повторного использования в 

других методах. 

 

Закладка Scout Parameters (Параметры поиска) 

Закладка Scout Parameters появляется в представлении плана метода после 

задания параметров поискового метода и отображает таблицу всех анализов, 

связанных с поисковым методом, и их настройки. Данная секция доступна только 

для чтения и не подлежит модификации. 
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 6 Создание метода 

В хроматографической системе NGC™ методы используются для оформления 

целого осуществляемого процесса. Методы состоят из фаз. Фаза состоит из 

последовательности шагов хроматографического анализа и свойств, связанных с 

каждым шагом. Программное обеспечение ChromLab™ включает стандартные 

методы, а также инструменты для создания, редактирования методов и управления 

ими. Вы можете редактировать фазы в пределах метода и определять настройки в 

пределах каждой фазы. 

Методы создаются в окне Method Editor. Метод может быть создан следующими 

способами: 

■ Из стандартных фаз, шаги которых редактируются 

■ Из стандартного шаблона 

■ Из другого определенного метода 

Подробная информация о функциях Редактора методов приведена в главе 5 

«Редактор методов». 
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Шаблоны стандартных методов 

Шаблоны стандартных методов включают следующие фазы: 

■ Уравновешивание 

■ Ввод образца 

■ Промывка колонки 

■ Элюирование 

■ Промывка колонки 

■ Повторное уравновешивание для следующего анализа 

ПО ChromLab включает следующие восемь шаблонов стандартных методов: 

Таблица 6. Шаблоны стандартных методов 

Шаблон метода Описание 

Affinity (Аффинность) Аффинная хроматография представляет собой разделение 

биомолекул на основании высокоспецифичных взаимодействий. 

Например: антитело/антиген или антитело/белок A, хелирование 

(полигистидин-меченый/никель), фермент/субстрат (глутатиод-s-

трансфераза/глутатион). 

Anion Exchange (Анионный обмен) Анионообменная хроматография использует положительно 

заряженную матрицу колонки для связывания отрицательно 

заряженных молекул белка. Белки элюируются из матрицы с 

помощью градиента возрастающей ионной силы (обычно NaCI). 

Выберите буферную систему с показателем pH ниже показателя 

pl целевого белка для улучшения связывания белков. 

Cation Exchange (Катионный обмен) Катионообменная хроматография использует отрицательно 

заряженную матрицу колонки для связывания положительно 

заряженных молекул белка. Белки элюируются из матрицы с 

помощью градиента возрастающей ионной силы (обычно NaCI). 

Выберите буферную систему с показателем pH выше показателя 

pl целевого белка для улучшения связывания белков. 
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Таблица 6. Шаблоны стандартных методов (продолжение) 

Шаблон метода Описание 

Хроматофокусирование Хроматофокусирующая хроматография использует заряженную 

матрицу для связывания молекул белка. Градиент pH 

используется для элюирования связанных белков, что 

происходит, когда pH равен pl целевого белка (общий заряд = 0). 

Для выполнения градиента pH в большом диапазоне требуются 

специальные буферные системы. 

Desalting (Обессоливание) Обессоливание обычно используется для замены буфера. Белки 

не связываются с матрицей колонки и обычно элюируются 

изократически в свободном объеме колонки. Выберите 

буферную систему, обеспечивающую максимальную 

стабильность целевого белка. 

Hydrophobic Interaction 

(Гидрофобное взаимодействие) 
Хроматография с гидрофобным взаимодействием использует 

высокосолевые буферы для адсорбирования целевых белков на 

гидрофобной матрице колонки. Затем для элюирования и 

разделения связанных белков концентрация соли снижается. 

Mixed Mode (Смешанный режим) Хроматография смешанного режима использует матрицу 

колонки с гидрофобным взаимодействием и взаимодействием 

заряженных ионов. Белки могут элюироваться с помощью 

градиента pH (элюирование при pH = pl целевого белка) или 

соли (повышение концентрации соли для элюирования из 

заряженной части или понижение концентрации соли для 

элюирования из гидрофобной части матрицы колонки). 

Multicolumn Sequential 

(Многоколоночная 

последовательная очистка) 

Многоколоночная последовательная очистка использует данные 

шаблоны при разделении нескольких образцов на нескольких 

колонках. Образцы впрыскиваются последовательно или с 

помощью насоса для образца с клапаном выбора образца, или 

через пробоотборные петли. Каждый образец загружается на 

колонку и промывается для удаления загрязнений, способных 

ухудшить свойства образца. Затем с колонок производится 

элюирование с последовательным использованием протоколов 

ступенчатого или линейного градиента. Сбор фракций 

производится с помощью коллектора фракций BioFrac™ или 

выходного клапана. 
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Таблица 6. Шаблоны стандартных методов (продолжение) 

Шаблон метода Описание 

Multicolumn Tandem 

(Многоколоночная тандемная 

очистка) 

Многоколоночная тандемная очистка использует данные 

шаблоны при объединении двух различных 

хроматографических методов в один. Сначала производится 

впрыск образцов, связывание на колонке и промывка для 

удаления основных загрязняющих примесей. Затем целевые 

фракции элюируются и либо последовательно попадают на 

другую колонку, либо временно хранятся в пробоотборной 

петле или контейнере. Находящиеся на хранении фракции 

впоследствии снова впрыскиваются на вторую колонку. В 

любом случае, со второй колонки затем производится 

элюирование, и очищенные фракции собираются коллектором 

фракций BioFrac или выходным клапаном. 

Reverse Phase (Обращенная фаза) Хроматография с обращенной фазой использует гидрофобные 

области на целевых белках для связывания с гидрофобной 

матрицей колонки. Для элюирования белков с матрицы колонки 

используется градиент возрастающей концентрации 

органического растворителя/показатель. 

Size Exclusion (Исключение по 

размеру) (гель-фильтрация) 
Эксклюзионная/гельфильтрационная хроматография 

осуществляет разделение белков по молекулярному размеру 

или массе. Белки не связываются с матрицей колонки и обычно 

элюируются в изократическом режиме. Выберите буферную 

систему, обеспечивающую максимальную стабильность 

целевого белка. 

System Test (Проверка системы) Данные методы осуществляют проверку эффективности 

системы NGC, оснащенной УФ-детектором. Они 

предназначены для оценки точности скорости потока и 

градиента системных насосов, функциональности смесителя и 

откликов УФ-детектора и кондуктометрического детектора. В 

большинстве случаев эффективность системы может 

подтвердить визуальное изучение результирующей 

хроматограммы. 
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Создание метода из шаблона 

Стандартные методы предоставляются в виде шаблонов. Перед использованием 

шаблона необходимо сохранить его в качестве метода. 

Для выбора шаблона метода и сохранения его в качестве метода 

1. Выполните одно из следующих действий: 

■ В окне Home щелкните на Open Method Template (Открыть шаблон 

метода). 

■ В окне Method Editor щелкните на Open Template на панели инструментов. 

Появится диалоговое окно Open Template. Шаблоны стандартных методов 

располагаются в папках по методикам. 
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2. В левой секции окна щелкните на папке и выберите шаблон из списка, который 

появится в верхней правой секции окна. 

В нижней правой секции закладка Gradient отображает градиентную кривую 

выбранного шаблона. Закладка Notes отображает пояснительный текст, 

который можно отредактировать в секции Phase Parameters представления 

плана метода. Закладка Overview (если доступна) отображает графическое 

представление шагов очистки. 

Примечание: Закладка Overview доступна для выбора, только если выбран 

шаблон многоколоночной очистки. 

3. Для открытия шаблона дважды щелкните на его имени. 

По умолчанию метод открывается в представлении настроек метода окна 

Method Editor. 

4. В секции Method Settings отредактируйте общие настройки, такие как тип 

колонки, базовые единицы измерения метода и длину волны. 

ПО ChromLab автоматически рассчитывает правильные значения объема, 

скорости потока и давления. 

5. В окне Method Editor выберите File > Save As для открытия диалогового окна 

Save Method As (Сохранить метод как…). 
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6. Выполните одно из следующих действий: 

■ Выберите папку с проектом. В поле Method Name введите имя метода и 

щелкните на Save. 

■ Щелкните на New SubProject (Новый подпроект) или New Root Project 

(Новый корневой проект) и введите имя для нового проекта в поле Enter 

Project Name (Ввести имя проекта), которое появится в секции Projects. 

Щелкните на кнопке Save. 

Создание метода из стандартных фаз 

При создании метода из стандартных фаз вы задаете в представлении настроек 

метода общие настройки, которые будут применяться ко всему методу. Данные 

настройки включают выбор колонки, диапазон рабочих давлений, скорость потока, 

базовые единицы измерения метода, pH, тип штатива коллектора фракций и объем 

фракций. Доступные параметры различаются в зависимости от устройств, 

включенных в схему жидкостного тракта. Например, настройка pH доступна только 

если в схеме присутствует клапан детектора pH. 

Ниже приведена процедура создания метода из стандартных фаз: 

■ Создайте метод. 

■ В представлении настроек метода выберите схему жидкостного тракта. 

Важно: Схема жидкостного тракта должна соответствовать конфигурации 

прибора NGC. Если это не так, измените схему жидкостного тракта или 

создайте новую схему, соответствующую конфигурации прибора NGC. См. 

«Для изменения схемы жидкостного тракта» на стр. 170 в данном разделе. 

■ В представлении плана метода добавьте фазы в метод «перетаскиванием» их 

из библиотеки фаз в секцию Method Outline в порядке их выполнения. 

■ Отредактируйте свойства фаз. 

■ Сохраните метод. 
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Каждый элемент схемы жидкостного тракта связан с настройками в представлении 

настроек метода. При изменении схемы жидкостного тракта настройки метода также 

меняются в соответствии со схемой. 

Для создания метода 

► Выполните одно из следующих действий: 

■ В окне Home секции Method Editor выберите New Method. 

■ Если закладка Method Editor уже доступна для выбора, щелкните на New 

на панели инструментов окна Method Editor. 

Новый метод откроется в представлении настроек метода. Его настройки 

появятся в секции Method Settings, а текущая схема жидкостного тракта – в 

секции Fluidic Scheme. 

Для изменения схемы жидкостного тракта 

1. Под Fluidic Scheme в секции Method Settings щелкните на Change. 

Появится диалоговое окно Fluidic Scheme Selector, в котором вы можете 

выбрать другу схему жидкостного тракта или создать новую схему, щелкнув на 

New. См. подраздел «Для создания новой схемы жидкостного тракта» на 

стр. 60. 
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2. Выберите схему жидкостного тракта, соответствующую конфигурации вашего 

прибора NGC, и щелкните на Select. 

Примечание: Общие настройки для схемы жидкостного тракта появятся в секции 

Method Settings. Общие настройки различаются в зависимости от выбранной схемы 

жидкостного тракта. Более подробная информация приведена в разделе «Схема 

жидкостного тракта» на стр. 133. 

Для задания общих настроек 

1. В секции Method Settings щелкните на Run Name (Имя анализа) и укажите имя в 

диалоговом окне, после чего щелкните на OK. 

2. (Опционально) Щелкните на Notes и введите или отредактируйте содержимое в 

появившемся диалоговом окне Notes. Как только новый метод будет сохранен, 

введенный здесь текст появится в закладке Notes диалогового окна нового 

метода Open Method. 

3. Под Column Selection выберите метод в раскрывающемся списке Show By 

Technique (Отобразить по методике). Данное действие отфильтрует перечень 

типов колонок. 

4. Выберите тип колонки в раскрывающемся списке Column Type. 

ПО ChromLab автоматически задаст настройки объема и давления колонки. 

Совет: Щелкните на Column Properties (Свойства колонки) для просмотра 

полного перечня выбранных свойств и значений колонки. 
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5. В зависимости от метода, могут быть выбраны или настройки одноволнового 

УФ-детектора (Single Wave UV Detector Settings), или настройки многоволнового 

фотометрического детектора (Multi-Wave UV/Vis Detector Settings). Выберите 

соответствующие значения длин волн, на которых будет производиться 

поглощение УФ-лучей, для контроля хода анализа. 

Совет: Одноволновый УФ-детектор контролирует поглощение УФ-лучей на 

одной длине волны. Вы можете выбрать или 255 на, или 280 нм по умолчанию. 

Многоволновый фотометрический детектор осуществляет контроль на 

нескольких (до четырех) длинах волн в диапазоне 190-800 нм. 

6. Под Unit Selection выберите Method Base Unit: объем (мл), время (мин) или в 

объем колонки (CV). 

7. Под Fraction Collection щелкните на Configure для выбора штатива из 

изображений в диалоговом окне Configure Fraction Collector Scheme 

(Конфигурировать схему сбора коллектора фракций) и выберите доступный 

контур сбора и размер фракций. 

Контур по умолчанию – «Serpentine» (Змеевидный). В случае микропланшетов 

сбор фракций может производиться рядами или столбцами. Для выбранного 

штатива появятся возможные варианты выбора. 
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Если ваша схема жидкостного тракта содержит выходные клапаны, выберите 

начальные клапан и порт, и измените размер фракций. 

 

8. Под Flow укажите скорость потока по умолчанию для выбранного метода.  

При необходимости вы можете изменить скорость потока по умолчанию в 

пределах отдельных фаз. 

Выберите кнопку-флажок Control the flow to avoid overpressure, если вы хотите, 

чтобы система снижала скорость потока, и анализ по выбранному методу 

продолжал выполняться в случае достижения системой верхнего предельного 

давления. Если данная кнопка-флажок не выбрана, в случае превышения 

давления система остановит насосы, и анализ по выбранному методу будет 

приостановлен. 

Если конфигурация вашей системы включает установленный датчик воздуха, и 

вы хотите, чтобы насосы системы остановились при детектировании в линиях 

воздуха, выберите кнопку-флажок Detect end of buffer with Air Sensor. 

Примечание: Если выполнение анализа по выбранному методу 

приостановлено вследствие поступления сигнала о детектировании конца 

буфера, перед возобновлением анализа необходимо заполнить линии. Так как 

кнопка Purge (Промывка) деактивирована в режиме Method, необходимо 

заполнить насосы вручную. Информация о заполнении системы приведена в 

разделе «Заполнение и промывка системы» на стр. 96. 
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9. Выберите тип крышки насоса. Для задания параметров управления обратитесь 

к разделу «Закладка Control Flow (Управление потоком)» на стр. 74. 

10. Под Buffer Selection выберите буферы для каждой входной линии или 

буферную систему и pH, если вы используете модуль смесительного клапана 

для буферных растворов. См. также «Buffer Selection (Выбор буфера)» на стр. 

141. 

11. Щелкните на Rename Ports для замены имен Buffer A и Buffer B на более 

описательные термины. 

Выбранные здесь имена появятся в отчете по методу. 

Добавление фаз 

Когда вы добавляете фазу в метод, в секции Phase Parameters появляются 

параметры для добавляемой фазы. 

Для добавления фаз в метод 

1. Выберите Method Outline в левой секции окна. 

2. Щелкните на кнопке Add Phase в секции Method Outline для открытия 

библиотеки фаз. 

3. «Перетащите» фазу из библиотеки фаз в требуемое положение в секции 

Method Outline. 

4. Продолжите добавление фаз до завершения составления метода. 

5. Сохраните метод. 

Редактирование методов и фаз 

Изменения, внесенные в представлении настроек метода, влияют на метод в целом. 

Изменения, внесенные в конкретные фазы, применяются только к данным фазам. 

Для редактирования фаз в секции Phase Parameters 

1. Выберите секцию Method Outline, в которой выберите фазу. 

Настройки для выбранной фазы появятся в секции Phase Parameters. 

2. Отредактируйте уставки параметров фаз. 
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3. Повторяйте шаги 1 и 2 до завершения редактирования настроек фаз для 

выбранного метода. 

4. Сохраните метод для фиксации изменений. 

Примечание: Изменения параметров фаз в отношении продолжительности 

шагов процедуры и солевых градиентов графически представляются в секции 

Gradient Graph. И наоборот, изменения градиентной кривой отражаются на 

параметрах фаз. 

Переименование фаз 

Фазы, находящиеся в библиотеке фаз, не могут быть переименованы. 

Переименование фазы в секции Method Outline изменяет ее имя только для 

текущего метода. Тем не менее, переименованные фазы могут быть сохранены как 

пользовательские фазы для использования в других методах. 

Для переименования фазы в секции Method Outline 

1. В секции Method Outline выберите фазу для переименования. 

2. Выполните одно из следующих действий: 

■ Выберите Edit > Rename Phase. 

■ Щелкните правой кнопкой мыши на выбранной фазе и выберите Rename 

Phase. 

Появится диалоговое окно Rename Phase. 

3. Отредактируйте имя фазы и щелкните на Save. 

Перегруппировка фаз 

Для перегруппирования фаз в методе 

1. Выберите фазу в секции Method Outline 

2. «Перетащите» фазу в новое положение. 
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Удаление фаз 

Для удаления фазы из метода 

1. В секции Method Outline выберите фазу для удаления. 

2. Выполните одно из следующих действий: 

■ Выберите Edit > Delete Phase. 

■ Щелкните правой кнопкой мыши на выбранной фазе и выберите Delete 

<phase_name>. 

3. Для подтверждения операции удаления выбранной фазы щелкните на Yes (Да) 

в появившемся диалоговом окне. 

Открытие метода 

Для открытия метода 

1. Выполните одно из следующих действий: 

■ В окне Home щелкните на Open Method. 

■ В окне Method Editor щелкните на Open на панели инструментов. 

Появится диалоговое окно Open Method. Данное диалоговое окно содержит 

перечень всех пользовательских методов по умолчанию. 

2. Щелкните на имени метода для его открытия. 

Выбранный метод откроется в представлении настроек метода. Схема 

жидкостного тракта выбранного метода появится в секции Fluidic Scheme, а в 

секции Method Settings появятся его общие настройки. 
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Выполнение анализа по выбранному методу и сбор 
фракций 

Вы можете задать немедленный запуск анализа по выбранному методу или 

добавить метод в очередь анализов. Немедленный запуск анализа возможен только 

при отсутствии в очереди анализов запланированного метода. Если в очереди нет 

методов, новые методы добавляются в конец очереди. Находящиеся в очереди 

методы запускаются последовательно. Вы также можете удалить запланированный 

метод из очереди, если анализ по нему не выполняется в данный момент, но 

перестроить очередь невозможно. Запустить ожидающие в очереди методы можно в 

ручном режиме или с сенсорного экрана, или в ПО ChromLab. 

При планировании нескольких анализов по выбранному методу вы можете задать 

добавление или наложение фракций. 

Сбор фракций с использованием коллектора фракций BioFrac 

Append Fractions (Добавлять фракции) — в процессе сбора система пропустит 

пробирку между анализами и перейдет к следующей доступной пробирке. 

Overlay Fractions (Наложить фракции) — во всех анализах в процессе сбора 

система будет использовать один набор пробирок для фракций. 

Сбор фракций с использованием выходных клапанов 

Append Fractions (Добавлять фракции) — в процессе сбора система после 

каждого анализа будет осуществлять переход к следующему доступному порту без 

пропуска порта. После использования последнего порта система возобновит сбор, 

начиная с порта, определенного в методе. 

Overlay Fractions (Наложить фракции) — система будет начинать сбор с порта, 

определенного в методе, и использовать те же порты во всех анализах. После 

использования последнего порта система возобновит сбор, начиная с порта, 

определенного в методе. 
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Сбор фракций при заданной очередности анализов 

При наличии методов в очереди процесс сбора будет начинаться с пробирки или 

порта, определенного для первого в очереди метода. 

Сбор фракций с использованием коллектора фракций BioFrac 

После завершения анализа по первому методу система в процессе сбора пропустит 

пробирку и перейдет к следующей доступной пробирке (как если бы очередь 

анализов была установлена на режим Append Fractions). Например, если в ходе 

анализа Run 01 производится сбор фракций в пробирки A1-A10, в ходе анализа 

Run 02 система пропустит пробирку A11 и начнет с пробирки A12. Данный процесс 

пропуска пробирки продолжается для каждого анализа в очереди. 

Если следующий в очереди метод используется для нескольких анализов в режиме 

наложения, система в первом анализе пропустит пробирку и начнет повторно 

производить сбор в пробирки, начиная с первой в первом анализе. 

Примечание: Если текущий ожидающий в очереди метод был приостановлен и 

затем возобновлен, сбор фракций продолжится в следующую доступную пробирку. 

Если текущий ожидающий в очереди метод был приостановлен, выполнение 

очередности начнется снова в следующем анализе. В данном случае система во 

время сбора пропустит пробирку и продолжит сбор в следующую доступную 

пробирку. 

Сбор фракций с использованием выходных клапанов 

После завершения анализа по первому методу система в процессе сбора перейдет к 

следующему доступному порту (как если бы очередь анализов была установлена на 

режим Append Fractions). Например, если в ходе анализа Run 01 сбор фракций будет 

производиться от портов P2-P10, сбор фракций в ходе анализа Run 02 начнется с 

порта P11. Данный процесс будет продолжаться для каждого анализа в очереди. 

После использования последнего порта система начнет сбор с порта, определенного 

в текущем методе. 

Примечание: Если текущий ожидающий в очереди метод был приостановлен и 

затем возобновлен, сбор фракций продолжится со следующего доступного порта. 

Если текущий ожидающий в очереди метод был приостановлен, выполнение 

очередности начнется снова в следующем анализе. В данном случае сбор фракций 

начнется с порта, определенного в данном новом методе. 
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Для выполнения анализа по выбранному методу 

1. Откройте метод. 

2. На панели инструментов щелкните на Start Run. Появится диалоговое окно 

Schedule Run (Запланировать анализ). 

 

3. (Опционально) Введите имя для анализа. Имя анализа может включать до 85 

символов. 

4. Для запуска анализа щелкните на Start Run. 

Для добавления анализов в очередь анализов 

1. В окне Method Editor щелкните на Start Run. Появится диалоговое окно 

Schedule Run, отображающее сообщение о том, что метод будет запущен 

после завершения всех анализов, ожидающих в очереди. 

 

2. Щелкните на Schedule Run. Метод будет добавлен в конец очереди в окне 

System Control. 
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3. Повторяйте шаги 1-2 для добавления в очередь требуемого количества 

методов. 

4. Если первый анализ не выбран для немедленного выполнения, щелкните на 

зеленой стрелке на первом анализе в очереди Run Queue для запуска методов 

в очереди. 

 

Совет: Для удаления анализа из очереди анализов щелкните на . 

Для многократного последовательного выполнения анализа по выбранному 

методу 

1. В диалоговом окне Schedule Run выберите Multiple Runs (Несколько анализов). 

2. Укажите число раз выполнения анализа по выбранному методу, а также режим 

сбора фракций (добавление или наложение). 

3. Выполните одно из следующих действий: 

■ Щелкните на Start Run для немедленного запуска анализа по выбранному 

методу. 

■ Щелкните на Schedule Run для помещения метода в очередь анализов 

для выполнения анализа по данному методу позднее. 
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Сохранение метода 

Метод можно модифицировать – независимо от того, использовался он или нет – и 

сохранить под тем же именем. Модификации не применяются к ранее сохраненным 

анализам по данному методу. Сохраненные анализы будут отображать параметры, 

которые использовались методом до его модификации. 

Для сохранения метода 

► Щелкните на Save на панели инструментов. 

Метод сохранится в текущем проекте. 

Для сохранения модифицированного метода или сохранения шаблона в 

качестве метода 

1. Щелкните на Save As на панели инструментов. 

2. Откроется диалоговое окно Save Method As с именем текущего проекта, 

выбранного в секции Projects. 

3. (Опционально) Выберите другой проект в секции Projects. 

4. Введите имя для метода в поле Method Name и щелкните на Save. 

Для сохранения метода в качестве шаблона 

1. Щелкните на Save As Template на панели инструментов. 

Откроется диалоговое окно Save Method As Template (Сохранить метод как 

шаблон). В поле Template Name появится тип шаблона текущего метода. 

Совет: Рекомендуется включать тип шаблона в имя шаблона в качестве 

префикса. 
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2. Введите имя для нового шаблона и щелкните на Save. 

Переименование метода 

Открытый метод можно переименовать. В то время как опция Save As фиксирует 

исходный метод и сохраняет модифицированный метод под новым именем, при 

переименовании исходный метод сохраняется под новым именем. 

Для переименования метода 

1. Откройте метод для переименования. 

2. Выберите File > Rename. 

 Появится диалоговое окно Rename Method. 

3. Введите новое имя для метода и щелкните на Rename. 
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Удаление метода 

Открытый метод можно удалить. Если метод связан с анализами, можно удалить 

только один метод или метод и соответствующие анализы. 

Для удаления метода 

1. Откройте метод для удаления. 

2. Выберите File > Delete. 

3. (Опционально) Если с методом связаны анализы, выберите одну из следующих 

опций в появившемся диалоговом окне: 

■ Delete Method Only (Удалить только метод) — система скроет метод. При 

последующем открытии метода через связанный с ним анализ, система 

отобразит удаленный метод. Удаленный метод можно сохранить под 

новым именем. 

■ Delete Method and Runs (Удалить метод и анализы) — система удалит 

метод и соответствующие протоколы анализов. 
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Определение параметров в пределах метода 

Данная процедура используется для систематического определения параметров, 

оказывающих наиболее значительное влияние на разрешение пиков, и оптимизации 

данных параметров для достижения требуемых целей в области очистки белков 

(например, высокая степень чистоты, большой выход, высокая стабильность или 

активность). Молекулы отличаются друг от друга зарядом, реактивностью, 

зависящей от гидрофобности и растворимости, субстратной специфичностью и 

межмолекулярными взаимодействиями. Протокол очистки, являющийся 

удовлетворительным для одного типа молекул, может не работать для другого типа. 

На качество разделения в процедуре очистки влияют несколько факторов. Данные 

факторы включают состав буфера (pH, ионная сила, совместные растворы), тип 

элюирования (градиент и продолжительность градиента), скорость потока, 

химический состав колонки и состав образца. В принципе, каждый из данных 

факторов может быть отрегулирован на достижение максимальной эффективности 

очистки. В частности, только несколько из данных факторов были подвергнуты 

общей проверке из соображений времени и стоимости. Выполнение ряда 

автоматических анализов по поисковым методам позволяет значительно сократить 

время и ресурсы, необходимые для оптимизации протокола. 

Используя программу-мастер поиска ПО ChromLab, вы можете легко генерировать 

ряд методов, определяющих параметр в пределах определенных частей метода. 

Методы, используемые в поисковых экспериментах, могут генерироваться из 

существующего метода, создаваться с нуля или загружаться из шаблонов методов 

Bio-Rad. 

Поисковые методы могут сохраняться с помощью опции Save As. После создания 

ряда поисковых методов изменение плана метода сделает данные методы 

недействительными, и система порекомендует снова произвести поиск метода и 

сохранить его как новый поисковый метод. 
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Мастер поиска 

Мастер поиска проведет вас по трем страницам: Choose a Scouting Parameter 

(Выберите параметр поиска), Select Method Steps to Scout (Выберите шаги метода 

для поиска) и Generate Scout Sequence (Сгенерируйте последовательность поиска). 

Данный раздел приводит подробные инструкции по использованию каждой 

страницы. 

Страница 1: Choose a Scouting Parameter (Выберите параметр 
поиска) 

 

На данной странице вы выбираете параметр, по которому будете производить 

поиск. Вы можете выбрать только один параметр на метод. 

■ Flow Rate (Скорость потока) — оптимизируйте производительность насоса 

для шагов адсорбирования и элюирования. 

■ %B — измените состав буфера для изократического и градиентного режимов 

или исходный/конечный состав буфера для режимов линейного градиента. 

■ Duration (Продолжительность) — измените продолжительность шага 

элюирования по объему. 

■ pH — определите оптимальный pH для метода в режиме смешивания буферов 

(требуется смесительный клапан для буферных растворов). 



6   I   Создание метода 

186   |   Хроматографические системы NGC™ и программное обеспечение ChromLab™  

■ Column (Колонка) — протестируйте до пяти типов колонок для каждого 

используемого клапана переключения колонок. Данный параметр требует 

наличия в схеме жидкостного тракта не менее одного клапана переключения 

колонок. 

 Примечание: Страницы 2 и 3 мастера поиска отличаются при поиске колонок и 

образцов. Более подробная информация приведена в разделе «Использование 

мастера поиска для определения колонок» на стр. 189 или «Использование 

мастера поиска для определения образцов» на стр. 191. 

■ Sample (Образец) — протестируйте до семи различных образцов при 

использовании одного клапана выбора образца или до 14 различных образцов 

при использовании двух клапанов выбора образца (порт 8 зарезервирован для 

промывки). Данный параметр требует наличия в схеме жидкостного тракта не 

менее одного клапана выбора образца. 

 Совет: Данная опция доступна, если в фазе ввода образца (Sample Application) 

вы производите загрузку пробоотборной петли через насос для образца или 

впрыск образца непосредственно на колонку. Данная опция недоступна, если 

вы производите загрузку пробоотборной петли в ручном режиме. 

Страница 2: Select Method Steps to Scout (Выберите шаги метода 
для поиска) 

 

На данной странице вы выбираете шаги метода, поиск которых будете производить. 

На экран выводятся шаги метода, включающие параметр, выбранный вами на 

странице 1 мастера поиска. 
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В зависимости параметра, выбранного на странице 1, вы можете выбрать 

отдельные шаги для поиска или кнопку-флажок для поиска всех шагов в методе, в 

которых в настройках метода активированы свойства данного параметра. Все 

выбранные вами шаги выделяются. 

Если вы выбираете Include all steps where <параметр> from Method Settings is 

enabled (Включить все шаги, в которых активирован <параметр> из окна 

Method Settings), применяются следующие правила: 

■ Шаги, содержащие выбранный активированный в настройках метода параметр 

(Use <параметр> from Method Settings is enabled (Использовать 

<параметр>, активированный в Method Settings)), автоматически 

включаются в поиск. 

■ Шаги, не содержащие вышеприведенный выбранный активированный в 

настройках метода параметр, в поиск не включаются. 

■ Шаги, не включенные в поиск, могут все еще оставаться выбранными. Шаги, 

включенные в поиск, могут быть отменены. В обоих случаях выбор кнопки-

флажка Include all steps where <параметр> from Method Settings is enabled 

отменен. 

Если вы не выбираете Include all steps where <параметр> from Method Settings is 

enabled, применяются следующие правила: 

■ Могут быть выбраны только шаги, включающие определенный параметр. 

■ Несколько шагов могут использовать одну исходную настройку. В данных 

случаях выбор одного шага выбирает все шаги в группе. 

■ Шаги, которые не могут быть выбраны, выделяются серым цветом. 

■ Если значения определенного параметра не совпадают во всех выбранных 

шагах, под таблицей появляется следующее сообщение: «You have selected 

steps with different starting values. Please deselect these steps or change the 

starting value to proceed» (Вы выбрали шаги с различными начальными 

значениями. Чтобы продолжить, отмените выбор данных шагов или измените 

начальное значение). 

Вы можете отменить выбор ранее выбранных шагов. Применяются следующие 

правила: 

■ Можно отменить выбор отдельных шагов или группы шагов. 

■ Если вы отменяете выбор шага, для которого выбран параметр Include all 

steps where <параметр> from Method Settings is enabled, выбор кнопки-

флажка также отменяется. Другие шаги остаются выбранными и будут 

включены в поиск. 



6   I   Создание метода 

188   |   Хроматографические системы NGC™ и программное обеспечение ChromLab™  

Страница 3: Generate Scout Sequence (Сгенерируйте 
последовательность поиска) 

 

На данной странице вы задаете количество анализов, которые будут выполнены, 

присваиваете каждому анализу имя и задаете параметры для определенных шагов. 

■ Number of runs (Количество анализов) — задает количество анализов, 

которые будут выполнены в рамках поискового эксперимента. 

■ Starting Value (Начальное значение) — задает начальное значение для 

параметра, выбранного для поиска. Значением по умолчанию является 

начальное значение в базовом методе. 

■ Increment Value (Значение приращения) — задает значения приращения для 

анализа по поисковому методу. Значение приращения может быть 

положительным или отрицательным. 

Таблица последовательности поиска содержит следующие столбцы: 

■ Run # (Анализ №) — номер анализа по поисковому методу. Данное поле не 

редактируется. 
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■ Run Name (Имя анализа) — имя анализа по поисковому методу. 

Автоматически генерируемое имя обуславливается параметром, выбранном на 

странице 1 мастера поиска, а также начальным значением и значением 

приращения. Данное поле является редактируемым. 

Совет: Для простого редактирования столбца Run Name создайте список в 

Microsoft Word или Excel. Скопируйте и вставьте список в столбец для замены 

автоматически сгенерированных имен. 

■ <Параметр> — значение определенного параметра для данного анализа, 

определенное на основании начального значения базового метода и значения 

приращения. Данное поле является редактируемым. 

■ Include in Scout Sequence (Включить в последовательность поиска) — 

определяет, включен ли анализ в поисковый метод. По умолчанию включены 

все анализы. Данное поле является редактируемым. 

Использование мастера поиска для определения колонок 

Данный раздел приводит инструкции по подготовке страниц 2 и 3 мастера поиска 

при поиске колонок. 

Примечание: Данный раздел применяется, только если на странице 1 выбран поиск 

колонок. Если выбран другой параметр, обратитесь к изображениям в предыдущем 

разделе. 

Страница 2: 
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На данной странице вы можете выбрать для поиска до пяти колонок для каждого 

клапана переключения колонок. Раскрывающийся список колонок содержит все 

колонки из библиотеки колонок, включая определяемые пользователем колонки (см. 

«Для добавления определенных пользователем колонок» на стр. 136). Мастер 

поиска отображает значения объема колонки, максимального давления в 

предколонке и максимальной разницы давлений в колонках для каждой выбранной 

колонки. 

Альтернативно, вы можете выбрать Custom из раскрывающегося списка и изменить 

данные значения для создания пользовательской колонки. 

Страница 3: 

 

На данной странице вы можете дать имя каждому анализу и включить (или 

исключить) колонку в последовательность поиска. Таблица последовательности 

поиска содержит следующие столбцы: 

■ Run # (Анализ №) — номер анализа по поисковому методу. Данное поле не 

редактируется. 

■ Run Name (Имя анализа) — имя анализа по поисковому методу. 

Автоматически генерируемое имя обуславливается положением колонки на 

модуле клапана переключения колонок и именем колонки, выбранном на 

странице 2. Данное поле является редактируемым. 

 Совет: Для простого редактирования столбца Run Name создайте список в 

Microsoft Word или Excel. Скопируйте и вставьте список в столбец для замены 

автоматически сгенерированных имен. 
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■ Port (Порт) — положение колонки на модуле клапана переключения колонок. 

Данное поле не редактируется. 

■ Include in Scout Sequence (Включить в последовательность поиска) — 

определяет, включен ли анализ в поисковый метод. По умолчанию включены 

все анализы. Данное поле является редактируемым. 

Использование мастера поиска для определения образцов 

Данный раздел приводит инструкции по подготовке страниц 2 и 3 мастера поиска 

при поиске образцов. 

Примечание: Данный раздел применяется, только если на странице 1 выбран поиск 

образцов. Если выбран другой параметр, обратитесь к изображениям в предыдущих 

разделах. 

Страница 2: 

 

На данной странице вы можете выбрать до 14 образцов для поиска. Для каждого 

анализа выберите клапан выбора образца и номер порта из раскрывающегося 

списка и измените объем впрыска образца для данного порта. Вы можете выбирать 

один порт несколько раз, если вы хотите определить различные значения для 

данного образца. 

Совет: Вы можете увидеть сообщение, предупреждающее о том, что вы не можете 

включить в метод шаг промывки насоса для образца перед впрыском образца. 

Промывка обеспечивает вымывание оставшегося образца из пути прохождения 

жидкости перед впрыском следующего образца для предотвращения перекрестного 

загрязнения.  
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Если вы щелкните на Yes (Да) в окне сообщения для включения шага промывки 

насоса для образца перед впрыском, метод обновится, и вы перейдете к странице 3. 

Если вы щелкните на No (Нет) в окне сообщения (или, например, вы используете тот 

же образец), вы перейдете к странице 3 без обновления метода. 

Страница 3: 

 

На данной странице вы можете дать имя каждому анализу и включить (или 

исключить) образец в последовательность поиска. Таблица последовательности 

поиска содержит следующие столбцы: 

■ Run # (Анализ №) — номер анализа по поисковому методу. Данное поле не 

редактируется. 

■ Run Name (Имя анализа) — имя анализа по поисковому методу. 

Автоматически генерируемое имя обуславливается модулем клапана выбора 

образца и номером порта данного клапана. Данное поле является 

редактируемым. 

 Совет: Для простого редактирования столбца Run Name создайте список в 

Microsoft Word или Excel. Скопируйте и вставьте список в столбец для замены 

автоматически сгенерированных имен. 

■ Sample Port Position (Положение порта клапана выбора образца) — данное 

поле не редактируется. 

■ Injection Volume (ml) (Объем впрыска (мл)) — данное поле не редактируется. 
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■ Include in Scout Sequence (Включить в последовательность поиска) — 

определяет, включен ли анализ в поисковый метод. По умолчанию включены 

все анализы. Данное поле является редактируемым. 

Создание поискового метода 

Примечание: Перед запуском мастера поиска убедитесь в правильности настроек 

метода и протокола. После создания ряда поисковых методов любые изменения 

потребуют повторного запуска мастера поиска. 

Для создания поискового метода 

1. Создайте новый метод, скопируйте существующий метод или используйте 

шаблон метода Bio-Rad. 

2. Щелкните на Scout на панели инструментов Method. Запустится мастер поиска. 

3. На первой странице мастера поиска выберите один параметр 

4. На второй странице выберите шаги метода. 

5. На последней странице задайте параметры последовательности: 

■ Измените значения параметров последовательности. 

■ Дважды щелкните на имени анализа для редактирования значения 

данного поля. 

Отмените выбор кнопок-флажков, которые вы не хотите включать в поисковый 

метод. 

6. Щелкните на Finish для настройки параметров поиска и закройте программу 

поиска. 
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Особенности 

Правила генерирования последовательностей поиска могут различаться в 

зависимости от параметра, выбранного для поиска. В данном разделе приведен 

перечень особенностей, которые необходимо учитывать при генерации 

последовательности поиска. 

Генерирование последовательностей определения %B 

■ Вы можете осуществлять поиск по двум или более шагам, имеющим 

одинаковые начальные значения %B. Если вы выбираете два или более шагов 

с различными начальными значениями, необходимо отменить выбор шагов с 

различными значениями. 

■ Когда для поиска выбран линейный градиент, и значение для следующего или 

предыдущего шага %B равно выбранному градиенту, данный шаг 

автоматически выбирается для поиска. Отмените выбор данного шага, если он 

не требуется. 

 Примечание: Если для поиска выбран изократический шаг, программа 

автоматически отменяет выбор других шагов. Выбрать другие шаги можно в 

ручном режиме. 

■ Когда начальное значение для %B составляет 100, приращения (на странице 3) 

по умолчанию являются отрицательным значением. 

Генерирование последовательностей определения pH 

■ Данная опция доступна только когда схема жидкостного тракта включает 

смесительный клапан для буферных растворов, и в настройках метода 

выбрано смешивание буфера. 

■ Минимальный и максимальный диапазон поиска pH определяется выбором 

буфера, произведенным в настройках метода. 

Генерирование последовательностей определения продолжительности 

■ Выбор двух или более шагов с различными начальными значениями или 

единицами измерения не поддерживается. Для продолжения отмените выбор 

шагов с различными начальными значениями или единицами измерения. 
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Генерирование последовательностей определения колонок 

■ Данная опция доступна только когда схема жидкостного тракта включает 

клапан переключения колонок. 

■ Если в качестве типа колонки вы выбираете Custom и меняете значения по 

умолчанию для объема колонки, максимального давления в предколонке и/или 

максимальной разницы давлений в колонках, ваши пользовательские 

настройки должны быть в пределах, определенных настройками метода. Если 

ваши пользовательские значения находятся за пределами данного диапазона, 

вокруг числа появится красная рамка. Мастер поиска не позволит вам 

продолжить, пока не будет введено действительное число. 

Генерирование последовательностей определения образцов 

■ Данная опция доступна только когда схема жидкостного тракта включает не 

менее одного клапана выбора образца, и вы выбрали загрузку пробоотборной 

петли через насос для образца или впрыск образца непосредственно на 

колонку в фазе ввода образца (Sample Application). Данная опция недоступна, 

если вы производите загрузку пробоотборной петли в ручном режиме. 

■ Если ваш метод содержит несколько фаз ввода образца, поиск осуществляется 

только в первом шаге загрузки образца метода. 

■ Если вы выбираете загрузку пробоотборной петли с помощью насоса для 

образца, объем впрыска при поиске относится к объему впрыска системного 

насоса, исходный объем впрыска равен объему впрыска системного насоса, 

заданному в методе, и минимальный объем впрыска составляет 0,01 мл. 

■ Если вы выбираете впрыск образца на колонку с помощью насоса для образца, 

объем впрыска при поиске относится к объему впрыска насоса для образца, 

исходный объем впрыска равен объему впрыска насоса для образца, 

заданному в методе, и минимальный объем впрыска составляет 0,01 мл. 

■ Максимальный объем впрыска составляет 1000 л. 
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Просмотр сводки поискового метода 

При выполняемой программе поиска таблица Method Editor отображает сводку 

параметров поиска в режиме только для чтения в новой секции Scout Parameters. 

См. «Закладка Scout Parameters (Параметры поиска)» на стр. 162 для получения 

подробной информации. 

Совет: При открытии мастера поиска в сохраненном поисковом методе значения 

для данного метода находятся в программе и в методе. 

Выполнение анализа по поисковому методу 

Вы можете задать немедленный запуск анализов по поисковым методам или 

добавить их в очередь анализов. Как и в случае регулярных методов, немедленный 

запуск анализов по поисковым методам возможен только при отсутствии в очереди 

анализов запланированных методов. Если в очереди нет методов, новые анализы по 

поисковым методам добавляются в конец очереди. 

Каждый поисковый метод появляется в очереди анализов в индивидуальном 

порядке. Каждый анализ идентифицируется как анализ по поисковому методу по 

метке, например: 

 

Из очереди можно удалить любые поисковые методы, которые не выполняются, но 

изменить порядок очереди невозможно. 
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Когда вы производите сбор фракций во время поиска, фракции добавляются к 

фракциям, собранным в предыдущем анализе. В процессе сбора система 

пропускает пробирку между анализами и переходит к следующей доступной 

пробирке. 

Совет: Подробные инструкции приведены в разделе «Выполнение анализа по 

выбранному методу и сбор фракций» на стр. 177. 

Для выполнения анализа по поисковому методу  

1. Откройте метод. 

2. На панели инструментов щелкните на Start Run. 

Диалоговое окно Schedule Scout Run (Составить график анализов по 

поисковым методам) отображает количество и имена запланированных 

анализов, и их параметр поиска. 

 

3. (Опционально) В данном диалоговом окне вы можете изменить префикс имени 

анализа. Префикс имени для каждого анализа меняется динамически по мере 

ввода нового префикса. Префикс имени анализа может включать до 35 

символов. 
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4. Выполните одно из следующих действий: 

■ Щелкните на Start Run для немедленного запуска процедуры анализа. 

■ Щелкните на Schedule Run для помещения методов в очередь анализов. 

Совет: Для удаления анализа из очереди анализов щелкните на . 
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 7 Оценка результатов 

В окне Evaluation вы можете обработать и проанализировать результаты 

хроматографического анализа. Просмотр результатов осуществляется множеством 

способов. При открытии протокола анализа появляется один протокол. При открытии 

по отдельности несколько протоколов анализов они появляются в отдельных 

закладках. Также предоставляется возможность сравнения нескольких протоколов 

анализов в одной закладке. В представлении протоколы анализов можно 

расположить один над другим или наложить друг на друга для сравнения. 

В системе существуют два типа файлов результатов: файлы протоколов анализов и 

файлы результатов анализов. Протокол анализа – это набор сохраненных данных, 

полученных в результате выполнения эксперимента в ручном режиме или 

автоматического выполнения анализа по выбранному методу. Файл результатов 

анализа – это данные, полученные в результате интегрирования пиков. Сравнение 

линий, полученных за несколько анализов, отображаемых друг над другом или 

послойно, также считается результатами анализа. Вы можете выполнить 

интегрирование пиков в одном или нескольких анализах. 

Вы можете импортировать файлы данных программного обеспечения Unicorn и 

BioLogic DuoFlow™ в проект анализа, а также в файлы NGC, экспортированные из 

программного обеспечения ChromLab™, выполняемого на другом компьютере. 

Более подробная информация приведена в главе 8 «Импорт и экспорт данных». 
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Управление проектами анализов 

Вы можете открыть протокол анализа или результаты анализа в диалоговом окне 

Open Run/Analysis (Открыть протокол анализа/результаты анализа) и организовать 

протоколы анализов и результаты анализов, создав проекты и подпроекты. Вы также 

можете создать корневой проект, в котором будут храниться ваши проекты и 

подпроекты. 

Сохраненные проекты и подпроекты перечисляются в левой секции окна. Протоколы 

анализов в выбранном проекте или подпроекте перечисляются в правой секции с 

временем начала и завершения, и типом метода. 

 

Для выбранного протокола анализа в закладках нижней секции отображаются 

доступное только для чтения изображение хроматограммы, перечень сохраненных 

результатов анализов и примечания к протоколу анализа. 

Для создания корневого проекта, проекта или подпроекта 

1. Выберите File > Open Run/Analysis для открытия диалогового окна. 

2. В верхней части диалогового окна щелкните на кнопке типа создаваемого 

проекта. 

3. Введите имя для проекта и поле, которое появится над секцией Projects, и 

щелкните на Save. 

Созданный проект появится в секции Projects. 
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Для группирования протоколов анализов по методу 

► Щелкните правой кнопкой мыши на перечне протоколов анализов и выберите 

Group by Method (Группировать по методу) в появившемся меню. 

Для отображения данных одного анализа 

► Выберите протокол анализа и щелкните на Open Run. 

Окно Evaluation отобразит данные анализа. 

Для отображения данных нескольких анализов 

1. Удерживая клавишу Ctrl или Shift, выберите несколько протоколов анализов из 

перечня в правой секции окна. 

Кнопка Open Runs превращается в раскрывающийся список. 

2. В раскрывающемся списке выполните одно из следующих действий: 

■ Выберите Open in Multiple Tabs (Открыть в нескольких закладках) для 

просмотра каждого протокола анализа в отдельной закладке. 

■ Выберите Open as a Trace Comparison (Открыть как сравнение линий) для 

просмотра выбранных протоколов анализов в одной новой закладке 

Analysis (Результаты анализа). 

Совет: Чтобы увидеть протоколы анализов в каждой группе методов, 

разверните список, щелкнув на знаке «плюс». 

Для открытия сохраненных результатов анализов 

1. Выберите протокол анализа из перечня. 

2. В закладке Analysis выберите результаты анализа. 

3. Щелкните на Open. 
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Окно Evaluation (Оценка) 

В окне Evaluation вы можете отображать данные анализа для одного или нескольких 

протоколов анализов. Несколько протоколов анализов можно отобразить в 

отдельных закладках или в одной закладке Analysis в виде сравнения линий 

хроматограммы. Данные отображаются на хроматограмме в виде отдельных линий. 

При помещении указателя на линию отображается подсказка с координатами. 

Таблица, отображаемая под хроматограммой, содержит подробную информацию о 

каждой линии. 

  

УСЛОВНЫЕ ОБОЗНАЧЕНИЯ 

1 Строка меню предоставляет быстрый доступ к опциям меню File (Файл), View 

(Просмотр), Analysis (Результаты анализа) и Help (Справка). 

2 Закладки, через которые осуществляется доступ к основным функциональным 

областям. 

3 Кнопки панели инструментов закладки обеспечивают быстрый доступ к командам. 

4 Хроматограмма отображает результаты анализа в виде линий. 

5 Условные обозначения хроматограммы определяют цвета и опции отображения 

линий. Условные обозначения также отображают значение длины волны в 

нанометрах для линий УФ-детектора. 

6 Закладки Runs/Traces (Протоколы анализов/линии), Peaks (Пики) и Fractions 

(Фракции) отображают результаты анализа в табличной форме. 
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Опции меню File (Файл) 

Open Run/Analysis (Открыть протокол анализа/результаты анализа) — 

открывает диалоговое окно Open Run/Analysis, в котором вы можете выбрать 

протоколы анализов, которые будут отображаться в окне Evaluation. 

Add Run (Добавить анализ) — открывает диалоговое окно Add Runs, в котором вы 

можете выбрать дополнительные протоколы анализов, которые будут отображаться 

в той же закладке для сравнения линий нескольких анализов. 

Remove Run from Analysis (Удалить протокол анализа из результатов анализа) 

— открывает диалоговое окно, в котором вы можете выбрать анализы, которые 

будут удалены из сравнения линий нескольких анализов. 

Show Method (Отобразить метод) — открывает метод для отображаемого 

протокола анализа в окне Method Editor. Когда отображается протокол анализа по 

поисковому методу, данная команда открывает метод, связанный с данным 

анализом. Данный метод идентифицируется «звездочкой» после его имени 

(например, Method Name: Scout Flow Rate 2.00*). 

Show Scout Method (Отобразить поисковый метод) — (доступна только если 

отображаемый протокол анализа является поисковым) открывает исходный метод, 

из которого был создан поисковый метод. Окно Method Editor содержит закладку 

Scout Parameters, в которой вы можете просмотреть все протоколы анализов по 

поисковым методам, связанных с поисковым методом, и их настройки. 

Close Run/Analysis (Закрыть протокол анализа/результаты анализа) — 

закрывает отображаемый протокол или результаты анализа. 

Close All Runs/Analyses (Закрыть все протоколы анализов/результаты 

анализов) — закрывает все открытые протоколы и результаты анализов. 

Save Analysis (охранить результаты анализа) — сохраняет отображаемые 

результаты анализа. 

Copy Analysis (Копировать результаты анализа) — создает копию отображаемых 

результатов анализа. 

Export (Экспортировать) — экспортирует один протокол анализа в виде файла 

.csv, который можно импортировать в приложения для работы с электронными 

таблицами, такими как Excel, или файл .ngcRun, который может быть импортирован 

программным обеспечением ChromLab, выполняемым на другом компьютере. Более 

подробная информация приведена в разделе «Экспорт данных» на стр. 268. 

Import NGC File (Импортировать файл NGC) — импортирует файлы .ngcRuns, 

экспортированные из ПО ChromLab, выполняемого на другом компьютере. Вы 

можете выбрать проект назначения и имя для импортируемого проекта. Более 

подробная информация приведена в разделе «Импорт метода или протокола 

анализа NGC» на стр. 263. 
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Import Unicorn Data (Импортировать данные Unicorn) — открывает диалоговое 

окно, в котором можно осуществлять импорт файла данных Unicorn в базу данных 

NGC. Более подробная информация приведена в разделе «Импорт файлов данных 

Unicorn» на стр. 265. 

Import DuoFlow Data (Импортировать данные DuoFlow) — открывает диалоговое 

окно, в котором можно осуществлять импорт файла данных DuoFlow в базу данных 

NGC. Более подробная информация приведена в разделе «Импорт файлов данных 

BioLogic DuoFlow» на стр. 267. 

Rename Run/Analysis (Переименовать протокол анализа/результаты анализа) 

— открывает диалоговое окно, в котором вы можете переименовать отображаемый 

протокол анализа или результаты анализа. 

Delete Run/Analysis (Удалить протокол анализа/результаты анализа) — удаляет 

отображаемый протокол анализа или результаты анализа. 

Analysis Notes (Примечания к результатам анализа) — позволяет просматривать 

и редактировать примечания для отображаемых результатов анализа. 

Run Report (Отчет об анализе) — составляет и отображает отчет об отображаемом 

анализе. Вы можете выбрать области, которые будут отображаться в отчете, 

включая хроматограмму, статистику работы колонки, сведения о системе, рабочий 

журнал/журнал регистрации событий и аннотации. Отчет может быть сохранен в 

форматах .pdf, .doc и .ppt. 

Analysis Report (Отчет о результатах анализа) — составляет и отображает отчет о 

результатах анализа, включая выполняемые протоколы анализов, хроматограммы, 

параметры пиков, фракции и табличные данные пиков, на основании колонок, 

выбранных для включения в отчет. Отчет может быть сохранен в форматах .pdf, .doc 

и .ppt. 

Method Report (Отчет по методу) — compiles составляет и отображает отчет по 

отображаемому методу, включая соответствующие настройки и шаги метода. 

Preferences (Глобальные параметры) — открывает диалоговые окна, 

позволяющие осуществлять следующие действия: 

■ Выбирать единицы давления для всех системных и программных величин 

давления. Это основная настройка. 

■ Настраивать сервер SMTP для отправки сообщений по электронной почте о 

состоянии системы от компьютера с ПО ChromLab. 

Exit (Выход) — закрывает ПО ChromLab. 
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Опции меню View (Просмотр) 

Overlay View (Отображение с наложением) — отображает несколько протоколов 

анализов в одном окне хроматограммы. 

Stack View (Отображение друг над другом) — отображает несколько протоколов 

анализов друг над другом в алфавитном (по имени) порядке. 

Show Pre-lnjection (Отобразить данные до впрыска) — отображает данные, 

собранные до момента впрыска. 

Show Baseline (Отобразить базовую линию) — после интегрирования пиков 

отображает кривые базовой линии на хроматограмме. 

Show Peak Area (Отобразить площадь пика) — после интегрирования пиков 

отображает площади пиков на хроматограмме. 

Show Peak Labels (Отобразить метки пиков) — после интегрирования пиков 

отображает метки начала, конца и верхней точки пиков на хроматограмме. 

Show Peaks for All Traces (Отобразить пики для всех линий) — после 

интегрирования пиков отображает базовую линию, площадь пиков и метки пиков для 

всех интегрированных линий. 

Show Chromatogram (Отобразить хроматограмму) — отображает одну или 

несколько хроматограмм. Отмените данную команду для скрытия хроматограмм. 

Show Table (Отобразить таблицу) — отображает одну или несколько таблиц. 

Отмените данную команду для скрытия таблиц. 

Lock UV Scales (Фиксировать масштаб линии УФ-детектора) — фиксирует 

масштабный коэффициент оси Y всех линий УФ-детектора. Если данная опция не 

выбрана, для каждой оси линии многоволнового детектора может использоваться 

отдельный масштабный коэффициент оси Y. 

Опции меню Analysis (Результаты анализа) 

Set Injection Point (Задать точку впрыска) — открывает диалоговое окно, в 

котором вы можете задать точку впрыска (где х = 0) отображаемых протоколов 

анализа. 

Peak Integration (Интегрирование пиков) — рассчитывает и отображает пики и их 

значения. Если интегрирование уже выполнено, открывает секцию Peak Integration. 

Manual Integration (Интегрирование в ручном режиме) — после интегрирования 

пиков отображает секцию Manual Integration. 
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Delete Peak List (Удалить список пиков) — удаляет ранее рассчитанные пики. Все 

пики удаляются с выбранных из списка линий в секции Peak Integration. 

Analyze Column Performance (Анализировать эффективность колонки) — после 

проверки эффективности колонки детектирует самый большой пик в фазе 

определения эффективности колонки и открывает секцию Column Performance. 

Опции меню Tools (Инструменты) 

Flow Rate Converter (Преобразователь скорости потока) — открывает 

преобразователь скорости потока, позволяющий определять скорость потока для 

каждой колонки в протоколе анализа, выполняемого по заданному методу, на 

основании размера колонки и введенной начальной скорости. Значение скорости, 

введенное в единицах «мл/мин», преобразуется в значение в единицах «см/ч» и 

«л/ч»; значение скорости, введенное в единицах «см/ч», преобразуется в значение в 

единицах «мл/мин» и «л/ч». Можно скопировать результат в преобразователе и 

вставить его в метод. 

Опции меню Help (Справка) 

Help (Справка) — отображает тематические разделы и ссылки на установленные 

руководства. 

About (О программе) — отображает информацию об авторском праве и версии ПО 

ChromLab. 

Опции панели инструментов закладки 

Add Run (Добавить анализ) — открывает диалоговое окно Add Runs, в котором вы 

можете выбрать протокол анализа, который будет отображаться в той же закладке. 

Remove Run (Удалить анализ) — открывает диалоговое окно, в котором вы можете 

выбрать анализы, которые будут удалены из сравнения линий нескольких анализов. 

Save Analysis (Сохранить результаты анализа) — сохраняет отображаемые 

результаты анализа и отображает выбранные настройки. 

Stack (Отображать друг над другом) — отображает несколько протоколов 

анализов друг над другом в алфавитном (по имени) порядке. 

Overlay (Отображать с наложением) — отображает все протоколы анализов в 

одном окне хроматограммы. 

Peak Integration (Интегрирование пиков) — рассчитывает и отображает пики и их 

значения. Если интегрирование пиков уже выполнено, открывает секцию Peak 

Integration. 
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Annotate (Снабдить примечанием) — добавляет примечание к хроматограмме в 

заданной точке по оси X. К хроматограмме можно добавить несколько примечаний. 

Charts in View (Отображаемые графики) — доступна для выбора при отображении 

нескольких протоколов анализов друг над другом; позволяет выбирать количество 

протоколов анализов для отображения. 
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Адаптирование хроматограммы к требованиям 
пользователя 

Вы можете менять цвет линий, отображать или скрывать выбранные линии, 

контролировать диапазон масштабных коэффициентов оси Y для каждой линии и 

снабжать хроматограмму примечаниями в определенных точках по оси Х. ПО 

ChromLab сохраняет изображение линий и настройки представления протокола 

анализа и использует их при отображении последующих протоколов анализов. 

Отображение линий хроматограммы 

Линии в каждой конфигурации появляются в нижеприведенном порядке в условных 

обозначениях хроматограмм в окнах System Control и Evaluation. Не все линии 

отображаются во всех конфигурациях. 

■ Линии УФ-детектора (по порядку номеров: λ1, λ2, λ3, λ4) 

■ Conductivity (Проводимость) 

■ %B 

■ pH Theoretical (Теоретический pH) 

■ pH (измеренный) 

■ System Pressure (Давление в системе) 

■ PreCol Pressure (Давление в предколонке) (по порядку номеров для каждого 

подключенного клапана переключения колонок) 

■ ΔCoI Pressure (Разница давлений в колонках) (по порядку номеров для каждого 

подключенного клапана переключения колонок) 

■ Sample Pump Pressure (Давление насоса для образца) 

■ Temperature (Температура) 

■ Flow Rate (Скорость потока) (системный насос) 

■ Sample Pump Flow Rate (Производительность насоса для образца) 

■ SIM 1 (отображается имя предоставленной линии хроматограммы) 

■ SIM 2 (отображается имя предоставленной линии хроматограммы) 
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Выбор активной линии хроматограммы 

Выбранная линия появляется выделенной жирным шрифтом; строка, 

соответствующая линии, выбирается в таблице линий хроматограммы, а масштаб и 

единицы измерения основной оси Y меняются на масштаб и единицы измерения 

линии. Например, когда выбрана линия УФ-детектора, масштаб и единицы оси Y 

отображаются как «е.о.п.». 

Примечание: Вспомогательная ось Y (в правой части хроматограммы) не меняется 

при выборе активной линии. Подробная информация приведена в разделе 

«Изменение параметров осей» на стр. 210. 

 

Для выбора линии хроматограммы 

► Выполните одно из следующих действий: 

■ Щелкните на линии на хроматограмме. 

■ Выберите линию в условных обозначениях. 

■ Выберите строку в таблице линий хроматограммы. 



7   I   Оценка результатов 

210   |   Хроматографические системы NGC™ и программное обеспечение ChromLab™  

Отображение или скрытие линии хроматограммы 

Для отображения или скрытия линии хроматограммы 

► В таблице линий хроматограммы выберите или отмените выбор кнопки-флажка 

Show (Отобразить) в строке линии. 

Изменение параметров осей 

Хроматограмма имеет две оси Y. Левая ось является основной. Ее линией по 

умолчанию является оптическая плотность ультрафиолета. Линией по умолчанию 

для правой оси является проводимость (Conductivity). Вы можете изменять единицы 

любой из осей Y щелчком на ее метке, являющейся переключателем, для 

отображения масштаба и единиц измерения следующей линии. 

Или можно изменить единицы основной оси, выбрав активную линию на 

хроматограмме, как описано в разделе «Выбор активной линии хроматограммы» на 

стр. 209. 

Для изменения единиц оси Х 

► Щелкните на заголовке оси Х для переключения между доступными опциями. 

Для анализов, выполняемых по сохраненным методам, единицы оси Х могут быть 

изменены в единицы времени в минутах (Time (min)), объема в миллилитрах (Volume 

(ml)) или объема колонки (Column Volume (CV)). Для анализов, выполняемых в 

ручном режиме, единицы оси Х могут быть изменены в единицы времени в минутах 

(Time (min)) или объема в миллилитрах (Volume (ml)). 

Контроль диапазона масштабных коэффициентов оси Y 

Для каждой линии хроматограммы вы можете изменить максимальные и 

минимальные ординаты в таблице линий хроматограммы для задания масштаба 

хроматограммы. По умолчанию линии УФ-детектора, использующие одинаковые 

единицы измерения, имеют одинаковый диапазон масштабных коэффициентов 

оси Y. При изменении диапазона масштабных коэффициентов оси Y (Min Y или 

Max Y) линии ко всем линиям применяется новый диапазон в анализе, 

использующем те же единицы измерения. В представлении, где линии различных 

анализов отображаются на одной хроматограмме с наложением, изменение 

диапазона масштабных коэффициентов оси Y одной линии изменяет диапазон 

масштабных коэффициентов оси Y всех отображаемых с наложением линий, 

использующих те же единицы измерения. Когда линии каждого анализа 

отображаются друг над другом, масштаб каждой хроматограммы будет отличаться. 

Для изменения значений Max Y и Min Y в таблице линий хроматограммы 

► Введите максимальное и минимальное значения в соответствующей строке 

таблицы линий хроматограммы, убедившись, что максимальное значение 

больше минимального. 
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Для изменения масштаба нескольких или отображаемых с наложением линий 

УФ-детектора 

► Щелкните правой кнопкой мыши на таблице линий хроматограммы или 

хроматограмме и отмените выбор опции Lock UV scales в появившемся меню. 

Все линии разблокируются, что позволит менять масштаб каждой линии в 

индивидуальном порядке. 

Для фиксации масштаба нескольких или отображаемых с наложением линий 

УФ-детектора 

► Щелкните правой кнопкой мыши на таблице линий хроматограммы или 

хроматограмме и выберите опцию Lock UV scales в появившемся меню. 

Для восстановления диапазона масштабных коэффициентов оси Y по 

умолчанию 

► Щелкните правой кнопкой мыши на таблице линий хроматограммы и выберите 

опцию Restore Default Y Scale Range (Восстановить диапазон масштабных 

коэффициентов шкалы Y) в появившемся меню. 

Изменение цветов линий хроматограммы 

Вы можете изменить цвет линии для повышения качества графического 

отображения или более четкого разграничения линий. 

Цвета линий по умолчанию в окне System Control идентичны цветам по умолчанию в 

окне Evaluation. Каждый цвет обозначает тип линии по умолчанию. Цвета линий 

определяются в условных обозначениях хроматограммы. 

Изменения цветов, произведенные в окне System Control для выполняющегося 

анализа или до выполнения анализа, сохраняются и отображаются при открытии 

протокола анализа в окне Evaluation. 

При изменении цвета линии в окне Evaluation данное изменение применяется к 

линии в таблице, условных обозначениях и на хроматограмме. Изменения 

сохраняются с конкретным протоколом анализа в настройках окна Evaluation. Они не 

влияют на настройки окна System Control или другие анализы. 

Для изменения цвета линии хроматограммы 

1. В закладке Runs/Traces дважды щелкните на цветовой ячейке в таблице для 

открытия селектора цвета (Color chooser). 

2. Выберите цвет в селекторе цвета и щелкните на OK для применения его к 

линии хроматограммы. 
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Для возврата цвета линии по умолчанию хроматограммы 

► Щелкните правой кнопкой мыши на цвете линии в таблице и выберите Restore 

Default Color (Вернуть цвет по умолчанию) в появившемся меню. 

Увеличение и уменьшение изображения 

Для увеличения изображения участка хроматограммы 

► Щелкнув на хроматограмме и удерживая кнопку мыши, «перетащите» 

указатель, выделив интересующую вас область. 

Для увеличения изображения участка хроматограммы 

► Выполните одно из следующих действий: 

■ Для возврата к предыдущему масштабу дважды щелкните или щелкните 

правой кнопкой мыши на хроматограмме и выберите Undo Zoom в 

появившемся меню. 

■ Для перехода к полномасштабному изображению щелкните правой 

кнопкой мыши на хроматограмме и выберите Reset Zoom в появившемся 

меню. 
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Получение статистики по выбранной области на 
хроматограмме 

Для каждой линии хроматограммы вы можете просмотреть статистику по выбранной 

на хроматограмме области. Выбор области на хроматограмме создает таблицу 

Region Statistics (Статистика по области), которая отображает следующие данные: 

■ Trace name (Имя линии) — тип линии хроматограммы. В таблице Region 

Statistics появляются только линии, выбранные в таблице Runs/Traces. 

■ Units (Единицы измерения) — единицы измерения линии хроматограммы. 

■ Color (Цвет) 

■ Left X (min) (Левая ось Х (мин.) — значение точки левой оси Х выбранной 

области, указанное в выбранных единицах оси Х (мин/мл/CV). 

■ Right X (min) (Правая ось Х (мин.) — значение точки правой оси Х выбранной 

области, указанное в выбранных единицах оси Х (мин/мл/CV). 

■ Delta X (Дельта-Х) — диапазон значений оси Х (правая ось Х – левая ось Х) 

выбранной области, указанное в выбранных единицах оси Х (мин/мл/CV). 

■ Left Y (Левая ось Y) — значение линии в точке левой оси Y выбранной 

области. 

■ Right Y (Правая ось Y) — значение линии в точке правой оси Y выбранной 

области. 

■ Min Y (Мин. Y) — Минимальное значение оси Y определенной линии в 

пределах области. 

■ Max Y (Макс. Y)— Максимальное значение оси Y определенной линии в 

пределах области. 

■ Average Y (Средн. Y) — Среднее значение оси Y определенной линии в 

пределах области. 

Вы можете изменить выбранную область на хроматограмме или в таблице Region 

Statistics. Изменение размера выбранной области обновляет значения в таблице 

Region Statistics. Вы также можете скопировать данные статистики из таблицы и 

вставить их в электронную таблицу. Закрытие таблицы Region Statistics отменяет 

выбор области, выбранной на хроматограмме. 
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Для выбора области на хроматограмме 

► Щелкните правой кнопкой мыши на начальной точке хроматограммы и 

«перетащите» указатель к конечной точке. 

Над выбранной областью появится серая рамка, и откроется таблица Region 

Statistics. 

Для изменения размера выбранной области 

► Выполните одно из следующих действий: 

■ На хроматограмме «перетащите» край серой рамки в новую точку. 

■ В диалоговом окне Region Statistics введите новые значения в поле Left X 

или Right X, расположенное над таблицей. 

Для копирования содержимого таблицы 

► Щелкните правой кнопкой мыши на таблице Region Statistics и выберите Copy 

Table (Копировать таблицу). 

 Вы можете вставить содержимое таблицы в файл .doc или .txt, или в 

электронную таблицу. 
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Для отмены выбора области на хроматограмме 

► Закройте таблицу Region Statistics. 

Снабжение хроматограммы примечаниями 

В окне Evaluation вы можете добавить примечания к хроматограмме для связывания 

результатов измерений с точками данных. Диалоговое окно для создания 

примечаний содержит три поля: Location (Местоположение) (в координатах времени, 

объема или объема колонки), Title (Заголовок) и Description (Описание). Когда 

примечание сохраняется, его заголовок появляется в указанном местоположении по 

оси Х. Описание появляется в отчете об анализе. 

Для добавления примечаний 

1. Щелкните на Annotate на панели инструментов и «перетащите» значок на 

хроматограмму в требуемое положение. Откроется зеленое диалоговое окно 

для создания примечаний с заполненным полем Location. 

 

Совет: При необходимости можно отредактировать поле Location. 

2. Введите заголовок для примечания. 

3. (Опционально) Введите описание для примечания. 

4. Щелкните на Save для сохранения примечания. 

Примечание: Щелчок на  закрывает диалоговое окно без сохранения 

примечания. 
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Для редактирования примечания 

1. Дважды щелкните на примечании на хроматограмме для открытия диалогового 

окна. 

2. Отредактируйте примечание и щелкните на Save для сохранения изменений. 

Для удаления примечания 

► Дважды щелкните на примечании для открытия диалогового окна, после чего 

щелкните на Delete (Удалить). 

Копирование хроматограммы 

Скопированное изображение хроматограммы может быть вставлено в файл 

документа или презентации, или сохранено в различных форматах изображения, 

оптимизированных или для экрана, или для распечатки. 

Для копирования хроматограммы 

► Щелкните правой кнопкой мыши на хроматограмме и выберите Copy 

Chromatogram в появившемся меню. 

Хроматограмма будет скопирована в буфер обмена, откуда ее можно будет 

вставить в другое приложение. 

Для сохранения хроматограммы в файл изображения 

1. Щелкните правой кнопкой мыши на хроматограмме и выберите Save 

Chromatogram As. 

2. В появившемся меню выберите формат и щелкните на Save. 

Совет: Для вывода на экран компьютера сохраните хроматограмму в формате 

.png, .jpeg или .gif. Для повышения качества распечатки сохраните 

хроматограмму в формате .tiff или .bmp, обеспечивающем более высокое 

разрешение. 
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Адаптирование отображения таблицы линий 
хроматограммы к требованиям пользователя 

Данные каждой линии каждого анализа появляются в строке таблицы линий 

хроматограммы, по одной строке для каждой линии. По умолчанию информация 

сортируется по анализу. Используйте таблицу для выбора видимых линий 

хроматограммы, изменения их цвета и изменения масштаба осей. 

Вы можете в дальнейшем адаптировать отображение таблицы, изменив 

классификацию, отсортировав столбцы и изменив порядок расположения столбцов. 

Вы также можете скопировать таблицу. 

Изменение классификации таблицы 

Линии хроматограммы могут группироваться по анализу или типу. Линии также 

можно разгруппировать. Группы можно разворачивать для отображения их 

содержимого или сворачивать, чтобы в таблице отображалось только имя группы. 

Для изменения способа классификации линий хроматограммы 

► Щелкните правой кнопкой мыши на таблице и выберите Group By Run 

(Группировать по анализу) или Group By Type (Группировать по типу) в 

появившемся меню. 

Для разгруппирования линий хроматограммы 

► Щелкните правой кнопкой мыши на таблице и выберите Group By Ungroup 

(Разгруппировать) в появившемся меню. 

Для разворачивания или сворачивания групп 

► Выполните одно из следующих действий: 

■ Щелкните на значке «плюс» или «минус» рядом с именем группы. 

■ Щелкните правой кнопкой мыши на таблице и выберите Expand All Groups 

(Развернуть все группы) или Collapse All Groups (Свернуть все группы) в 

появившемся меню. 
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Сортировка столбцов таблицы 

Когда линии хроматограммы в таблице не классифицированы, они сортируются в 

порядке по умолчанию. 

Для сортировки столбцов таблицы 

► Выполните одно из следующих действий: 

■ Выберите столбец, щелкните правой кнопкой мыши на заголовке столбца 

и выберите опцию Sort (Сортировать) в появившемся меню. 

■ Щелкните на заголовке столбца для переключения между нисходящим и 

восходящим порядком сортировки данных таблицы. 

Совет: Стрелка «вверх» или «вниз» рядом с заголовком столбца 

индицирует, что сортировка таблицы производилась с использованием 

данного столбца. 

Упорядочение и выбор столбцов 

Изменения, произведенные для упорядочения и выбора столбцов в таблице 

Runs/Traces, применяются ко всем последующим анализам. Данные настройки 

индивидуальны для каждого пользователя. 

Для изменения порядка отображения столбцов 

► «Перетащите» столбцы в новые местоположения в таблице линий 

хроматограммы. 

Отображение или скрытие столбцов 

Примечание: Вы можете скрыть столбцы таблицы линий хроматограммы без потери 

данных столбца. 

Для скрытия столбцов таблицы линий хроматограммы 

► Щелкните на заголовке столбца для его скрытия и «перетащите» его из 

таблицы. 

Для отображения скрытого столбца 

1. Щелкните правой кнопкой мыши на заголовке столбца и выберите Show Column 

Chooser (Отобразить селектор столбцов) в появившемся меню. 

2. «Перетащите» заголовок столбца, который вы хотите отобразить, из селектора 

столбцов в требуемое местоположение в таблице. 

Заголовок и данные столбца снова появятся в таблице. 
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Копирование таблицы 

Вы можете скопировать таблицу в буфер обмена и затем вставить ее в электронную 

таблицу или другой тип приложения. Скопированная таблица появится в приложении 

со следующими регулировками: 

■ Код цвета копируется в шестнадцатеричном формате. 

■ Состояние отображения/скрытия копируется как булево значение. 

Для копирования таблицы в буфер обмена 

► Щелкните правой кнопкой мыши на таблице линий хроматограммы и выберите 

Copy Table в появившемся меню. 

Таблица будет скопирована в буфер обмена. Теперь вы можете вставить ее в 

другое приложение. 

Отображение или скрытие данных, собранных до 
момента впрыска 

В окне Evaluation точка впрыска анализа определена как x = 0. Для анализов по 

выбранному методу точка впрыска берется из метода и устанавливается на 

время/объем, в соответствии с чем будет производиться впрыск образца, обычно в 

фазе Sample Application. Для анализов, выполняемых в ручном режиме, точка 

впрыска задается на время/объем = 0. По умолчанию данные, собранные до точки 

впрыска, не отображаются. 

Для отображения данных, собранных до точки впрыска 

► Выберите View > Show Pre-injection. 

Для скрытия данных, собранных до точки впрыска 

► В меню View отмените выбор опции Show Pre-injection. 
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Ручная установка точки впрыска (x корректирование) 

Вы можете вручную задать точку впрыска для любого анализа, включая протокол 

анализа, отображаемый в области сравнения линий хроматограммы. Точка впрыска 

сохраняется вместе с протоколом анализа (точка x = 0). Изменение точки впрыска в 

одном представлении влияет на другие представления, включающие протокол 

анализа. 

Для задания точки впрыска для анализа в ручном режиме 

1. Выберите Analysis > Set Injection Point. 

2. В диалоговом окне Set Injection Point (Задать точку впрыска) введите новую 

точку впрыска. 

 

3. Если в одном окне открыты несколько протоколов анализов, выберите анализ в 

меню Run. 

4. Щелкните на Apply для корректировки данных в соответствии с введенной 

настройкой или щелкните на Reset для восстановления исходной настройки. 
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Управление протоколами анализов 

Вы можете переименовать или удалить один протокол анализа, отображаемый в 

окне Evaluation. Вы также можете выбрать способ отображения нескольких 

анализов. 

Примечание: Вы не можете удалить протокол анализа, являющийся частью другого 

анализа. 

Изменения, вносимые в представление одного протокола анализа, сохраняются 

автоматически: цвета линий, диапазон масштабных коэффициентов оси Y, единицы 

оси Х и состояние скрытия/отображения. Кроме того, изменения в отношении 

выбора и порядка расположения столбцов сохраняются глобально и применяются к 

любому протоколу анализа, отображаемому в одиночном представлении, после 

внесения изменений. 

Переименование одного протокола анализа 

Вы можете переименовать один протокол анализа, отображаемый в окне Evaluation. 

Имя анализа может включать до 100 символов. 

Для переименования одного протокола анализа 

1. При отображаемом протоколе анализа выберите File > Rename Run. 

Появится диалоговое окно Rename Run с текущим именем анализа в поле 

Name. 

2. Замените текущее имя новым. 

3. Щелкните на кнопке Save. 

Удаление одного протокола анализа 

Вы можете удалить один протокол анализа, отображаемый в окне Evaluation. При 

удалении одного протокола анализа его закладка автоматически закрывается. 

Для удаления одного протокола анализа 

1. При отображаемом протоколе анализа выберите File > Delete Run. 

 Появится диалоговое окно, запрашивающее подтверждение операции 

удаления протокола анализа. 

2. Щелкните на Yes для удаления протокола анализа. 

 Если протокол анализа является частью другого анализа, ПО ChromLab 

отменит операцию удаления и уведомит вас об этом. 
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Просмотр нескольких протоколов анализов в 
отдельных закладках 

ПО ChromLab может отображать несколько протоколов анализов в окне Evaluation. 

Каждый протокол анализа открывается в отдельной закладке, что позволяет 

просматривать протоколы в индивидуальном порядке. Когда вы выбираете уже 

открытый протокол анализа, система выделяет закладку данного протокола. 

Для открытия нескольких протоколов анализов в отдельных закладках 

1. Выполните одно из следующих действий: 

■ Щелкните на Open/Run Analysis в секции Evaluation окна Home. 

Если окно Evaluation уже открыто, выберите File > Open Run/Analysis. 

2. Удерживая клавишу Ctrl или Shift, выберите несколько протоколов анализов из 

перечня в правой секции окна. Кнопка Open Runs превращается в 

раскрывающийся список. 

3. В раскрывающемся списке выберите Open in Multiple Tabs для просмотра 

каждого протокола анализа в отдельной закладке. 

Для закрытия закладки 

► Выберите File > Close Run/Analysis или щелкните на значке «закрыть» справа 

от имени закладки. 

Для закрытия всех закладок 

► Выберите File > Close All Runs/Analyses. 
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Сравнение линий хроматограммы 

ПО ChromLab может отображать несколько протоколов анализов в диалоговом окне 

Open Run/Analysis в представлении одной закладки. Данное представление 

позволяет сравнивать линии различных анализов. Протоколы анализов, 

отображаемые в закладке, могут появляться или друг над другом для персонального 

дисплея, или в наложении для сравнения. 

Для открытия нескольких протоколов анализов в одной закладке 

1. В окне Home щелкните на Open Run/Analysis в секции Evaluation. 

2. В окне Open Run/Analysis, удерживая клавишу Ctrl или Shift, выберите 

протоколы анализов для добавления и щелкните на Open Run. 

Вы можете добавить большее количество протоколов анализов к открытому 

протоколу или результатам анализа, щелкнув на Add Run на панели инструментов 

окна Evaluation. 

Для добавления большего количества протоколов анализов к открытым 

результатам анализа 

1. Щелкните Add Run на панели инструментов окна Evaluation. 

Откроется диалоговое окно Add Run. Список протоколов анализов появится в 

правой секции окна. 

 

2. Выберите один или несколько протоколов анализов и щелкните на Add Run. 

Протоколы анализов добавятся к результатам анализа и отобразятся друг над 

другом в окне Evaluation. 
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Просмотр нескольких протоколов анализов в одной 
закладке 

В данном представлении одна таблица отображает информацию для всех линий во 

всех отображаемых протоколах анализов. Вы можете выбрать линию, увеличить или 

уменьшить ее масштаб и изменить цвета линий. Вы также можете отобразить или 

скрыть конкретные линии и распределить различные протоколы анализов по оси Y, 

как описано в разделе «Смещение линий хроматограммы — режим наложения» на 

стр. 228. 

Отображение друг над другом 

Каждый протокол анализа появляется в отдельной хроматограмме. На панели 

инструментов поле Charts in View указывает количество отображаемых протоколов 

анализов. Для просмотра хроматограмм для дополнительных анализов можно 

использовать режим прокрутки. Одна таблица отображает информацию для всех 

линий хроматограммы во всех отображаемых протоколах анализов. 

Когда протоколы анализов располагаются друг над другом, единицы шкалы Х и 

левой шкалы Y идентичны во всех хроматограммах. Изменение единиц масштаба на 

одной хроматограмме изменяет единицы масштаба во всех расположенных друг над 

другом хроматограммах. Аналогично, при увеличении масштаба одной 

хроматограммы данный масштаб применяется ко всем остальным расположенным 

друг над другом хроматограммам. 
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Отображение с наложением 

Все видимые линии из всех выбранных протоколов анализов появляются на одной 

хроматограмме. 

 

Для переключения между режимами отображения друг над другом и 

наложения 

► Щелкните на Stack или Overlay на панели инструментов закладки Run или в 

меню View. 
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Адаптирование таблицы сравнения линий 
хроматограммы к требованиям пользователя 

Несколько протоколов анализов в одной закладке можно объединить в группы по 

анализу или типу. Можно также разгруппировать множество протоколов анализов. 

В окне Evaluation представление по умолчанию отображает несколько протоколов 

анализов с линиями хроматограммы, классифицированных по анализу. Протоколы 

анализов сортируются в алфавитном порядке. Когда линии хроматограммы в 

таблице классифицированы по типу, типы линий сортируются в порядке по 

умолчанию, как описано в разделе «Отображение линий хроматограммы» 

на стр. 208. 

Разворачивание или сворачивание групп 

При разворачивании групп их данные становятся видимыми. При сворачивании 

групп видимыми остаются строки групп, а содержимое становится скрытым. 

Для сворачивания или разворачивания групп данных 

► Щелкните на +/- рядом с именем группы. 

Скрытие всех линий хроматограммы в группе 

Для скрытия всех линий хроматограммы в группе 

► Отмените выбор кнопки-флажка Show в строке группы. 

Отображение всех линий хроматограммы в группе 

Для отображения всех линий хроматограммы в группе 

► Выберите кнопку-флажок Show в строке группы. 
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Смещение линий хроматограммы – режим наложения 

Когда две или более линий различных анализов располагаются слишком близко друг 

к другу, и их тяжело различить, можно использовать опцию Offset (Сместить) для 

смещения линий на расстояние, позволяющее просматривать их данные в 

индивидуальном порядке. Линии из первого анализа остаются в исходных 

положениях. Линии из других анализов смещаются. Если используются линии из 

более двух анализов, каждая линия дополнительного анализа смещается 

дополнительно. Линия последнего анализа в списке смещается на самое большое 

расстояние. 

 

Примечание: Смещение масштаба оси Y линии хроматограммы не меняет значения 

линии. 

Для смещения линии хроматограммы 

► При отображении в окне Evaluation двух или более протоколов анализов 

используйте движок в левой части хроматограммы для выбора значения 

смещения из диапазона 0-100, где 0 – отсутствие смещения и 100 – 

максимальное смещение. 

Изменения появляются на хроматограмме по мере перемещения движка. 
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Управление результатами анализов 

Удаление протоколов анализов из сравнения линий 
хроматограммы 

При отображении нескольких протоколов анализов вы можете удалить один или 

более протоколов из результатов анализа. Все протоколы анализов удалить из 

представления нельзя. 

Для удаления анализа из результатов нескольких анализов 

1. Выполните одно из следующих действий: 

■ На панели инструментов закладки Run щелкните на Remove Run. 

■ Выберите File > Remove Run from Analysis. 

Откроется диалоговое окно Remove Run from Analysis с перечнем протоколов 

анализов и выбранным протоколом анализа. 

2. (Опционально) Выберите дополнительные протоколы анализов для удаления 

их из результатов анализов. 

3. Щелкните на Remove для удаления протокола или протоколов анализов из 

результатов анализов. 

Сохранение результатов анализа сравнения линий 
хроматограммы 

Закладка Run отображает «звездочку», индицирующую, что отображаемые 

результаты сравнения линий хроматограммы изменены и еще не сохранены. 

Сохранение результатов анализа сохраняет следующие атрибуты: 

■ Список протоколов анализов 

■ Группирование данных таблицы 

■ Единицы оси Х (время, объем, CV) 

■ Представление, выбранное при сохранении (наложение или друг над другом) 

При сохранении новых результатов анализа открывается диалоговое окно Save 

Analysis (Сохранить результаты анализа) с отображаемым именем результатов 

анализа по умолчанию. Текст, добавляемый вами в поле Notes, сохраняется с 

результатами анализа. Данный текст может иметь любую длину и подлежит 

копированию и вставке. 

Совет: Если сохраненные результаты анализа открыты, вы можете просмотреть 

соответствующий текст примечаний, выбрав Analysis Notes (Примечания к 

результатам анализа) в меню File. 
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Для сохранения результатов анализа 

1. Выполните одно из следующих действий: 

■ Щелкните на Save Analysis на панели инструментов закладки Run. 

■ Выберите File > Save Analysis. 

2. Введите имя для результатов анализа в диалоговом окне Save New Analysis 

(Сохранить новые результаты анализа). 

3. Щелкните на кнопке Save. 

Как только результаты анализа будут сохранены, нижеприведенные действия будут 

сохраняться автоматически по мере их применения: 

■ Отображение или скрытие линии или группы линий хроматограммы. 

■ Изменения минимального и максимального значений оси Y. 

■ Изменение цвета линии хроматограммы. 

Копирование результатов анализа 

Для создания копии результатов анализа 

1. При отображении сохраненных результатов анализа выберите File > Copy 

Analysis. 

2. Введите имя для новых результатов анализа в диалоговом окне Copy Analysis 

(Копировать результаты анализа). 

3. Щелкните на кнопке Save. 

Переименование результатов анализа 

Для переименования результатов анализа 

1. При отображаемых результатах анализа выберите File > Rename Analysis. 

Появится диалоговое окно Rename Analysis с текущим именем анализа в поле 

Name. 

2. Замените текущее имя новым именем длиной до 50 символов. 

3. Щелкните на кнопке Save. 
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Удаление результатов анализа 

Для удаления результатов анализа 

1. При отображаемых результатах анализа выберите File > Delete Analysis. 

Появится диалоговое окно, запрашивающее подтверждение операции 

удаления результатов анализа. 

2. Щелкните на Yes для удаления результатов анализа. 

Отчеты 

ПО ChromLab поддерживает три типа отчетов, включая отчет об анализе и отчет о 

результатах анализа. Более подробная информация приведена в главе 9 «Отчеты». 

Экспорт данных анализа 

Вы можете экспортировать данные анализа в виде файла NGC, который может быть 

загружен в другую систему или на другой компьютер, работающий под управлением 

ПО ChromLab, или файла a .csv, которых подходит для импорта в другие 

приложения. Вы также можете экспортировать данные анализа с методом, 

использованном для его создания, или только протокол анализа, или только метод. 

Более подробная информация приведена в главе 8 «Импорт и экспорт данных». 
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Интегрирование пиков 

ПО ChromLab использует алгоритм поиска пиков на линиях УФ-детектора и расчета 

необходимых данных для анализа, таких как объем удерживания и площадь пика. 

Результаты появляются в таблице Peaks (Пики) в нижней части окна Evaluation и на 

хроматограмме. 

Вы можете выполнить интегрирование пиков в одном или нескольких анализах в 

одном представлении. 

При щелчке на Peak Integration на панели инструментов закладки Run система 

автоматически производит интегрирование пиков, используя настройки по 

умолчанию, которые появляются в секции Peak Integration справа от хроматограммы. 

Вы можете изменить уставки параметров или линии, выбранные для интегрирования 

пиков, и снова произвести интегрирование пиков с новыми настройками. 

Также можно отрегулировать пики в ручном режиме. При этом регулируются пики 

только выбранной линии, и только они отображаются на хроматограмме. См. раздел 

«Регулирование пиков в ручном режиме» на стр. 243. 

Совет: Линии данных модуля SIM с внешними детекторами, подключенными к 

приборам NGC, также используются для детектирования и интегрирования пиков. 

В данном случае для расчета пиков используются единицы оси Y, определенные в 

настройках системы (окно System Settings) для внешних детекторов. См. «Закладка 

Device Input (Вход устройства) на стр. 78 для получения подробной информации. 
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Настройки автоматического интегрирования пиков 

В секции Peak Integration закладка Auto Integration (Автоматическое интегрирование) 

отображает настройки, влияющие на расчет базовой линии и детектирование пиков. 

Изменение данных настроек позволяет оптимизировать способ детектирования и 

распознавания целевых пиков. 

Примечание: По умолчанию большинство областей закладок свернуто. При 

разворачивании областей отображаются опции, приведенные на изображении ниже. 
 

 

Опция Traces (Линии хроматограммы) 

Перечень отображаемых линий УФ-детектора, 

классифицированных по анализу. По умолчанию для 

интегрирования пиков выбраны все отображаемые 

линии УФ-детектора. 

Исключить линии из процесса интегрирования можно, 

отменив выбор их кнопок-флажков. 

Опция Baseline Parameters (Параметры 

базовой линии) 

Предоставляются два метода расчета базовой линии. 

By Best Fit (По максимальному соответствию) — 

базовая линия рассчитывается на основании данных. 

Кривая базовой линии соединяет нижние точки данных. 

Данная настройка описывает радиус диска, 

перемещаемого вдоль изгиба кривой. 

По умолчанию параметр максимально 

соответствующего радиуса установлен на 8. Данное 

значение может быть установлено в диапазоне от 1 до 

10. Чем меньше радиус, чем больше низших точек 

кривой касается диск. 

By Offset (По смещению) — базовая линия 

представляет собой прямую горизонтальную линию, 

имеющую постоянное значение смещения (y). Значение 

по умолчанию – ноль, но можно задать другое значение 

смещения. 
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Опция Peak Parameters (Параметры пиков) 

Вы можете задать исходные значения для двух параметров, принимающих участие в 

процессе детектирования пиков: наклон и чувствительность фильтра. 

Slope (Наклон) — определяет пороговое значение наклона пика. Чем больше 

наклон, тем круче отфильтрованные пики. Диапазон значений наклона – от 1 до 100. 

Sensitivity (Чувствительность) — определяет эффективность действия фильтра, 

используемого для образования плавной кривой перед поиском пиков. Настройка 

низкой чувствительности (Low) отфильтровывает высокочастотные составляющие 

сигнала, устраняя небольшие кратковременные пики. Чем выше настройка 

чувствительности, тем больше высокочастотных составляющих проходит через 

фильтр. Это позволяет детектировать небольшие и кратковременные пики. 

Опция Peak Filtering (Фильтрация пиков) 

Для действительных пиков можно задать следующие пороговые значения, 

Min Height (Мин. высота) — данная настройка задает минимальную высоту для 

действительного пика в единицах «е.о.п.». 

Min Width (Мин. ширина) — данная настройка задает минимальную ширину для 

действительного пика на уровне базовой линии в единицах «мл». 

N-Largest (Крупнейшие пики уровня N) — данная настройка задает фильтрацию 

пиков по площади. Она собирает крупнейшие пики уровня N в порядке убывания. 

Range (Диапазон) — данные настройки определяют диапазон, в пределах которого 

будут детектироваться пики. Единицы диапазона определяются из единиц оси Х 

хроматограммы. 

Опция Default Parameters (Параметры по умолчанию) 

Reset (Сброс) — восстанавливает параметры базовой линии, параметры 

детектирования пиков и настройки фильтрации пиков до настроек по умолчанию. 

Примечание: Для перерасчета пиков с настройками по умолчанию необходимо 

щелкнуть на кнопке Integrate (Интегрировать). 
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Кнопки Integrate (Интегрировать) и Delete (Удалить) 

Integrate (Интегрировать) — детектирует пики, используя текущие значения 

параметров, для выбранных линий и обновляет таблицу пиков детектированными 

значениями. 

Delete (Удалить) — удаляет ранее рассчитанные пики. Удаление всех пиков 

производится только с линий, выбранных в списке линий хроматограммы. 

Запуск процесса интегрирования пиков 

При выборе Peak Integration один протокол анализа преобразуется в результаты 

анализа, и система при первом сохранении данных результатов предлагает дать им 

имя. 

Для первого запуска процесса интегрирования пиков 

► Щелкните на Peak Integration на панели инструментов закладки Run. 

Откроется секция Peak Integration, и система автоматически произведет 

интегрирование пиков, используя настройки по умолчанию. 

Для выполнения интегрирования пиков с измененными настройками 

► Выберите интересующие вас линии хроматограммы, измените настройки в 

секции Peak Integration, и затем щелкните на кнопке Integrate в нижней части 

секции. 

Обновленные результаты интегрирования пиков появляются в хроматограмме 

и в таблице пиков (Peaks). 

Совет: Вы можете применить различные настройки для отдельных линий, 

интегрировав каждую линию отдельно с ее собственными настройками. Отмените 

выбор кнопок-флажков для всех остальных линий в списке и щелкните на кнопке 

Integrate. 
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Отображение результатов по пикам – хроматограмма 

 

На хроматограмме начало, конец и высшая точка пика индицируются небольшими 

вертикальными черточками в соответствующих точках по оси Х. Цвет каждой 

черточки совпадает с цветом соответствующей линии хроматограммы. 

Время удерживания, объем удерживания или объем колонки появляется рядом с 

черточкой высшей точки пика. 

Совет: Примерный экран отображает время удерживания, но вместо данного 

параметра вы можете отобразить объем колонки, щелкнув на заголовке Time 

(Время) рядом с нижней частью хроматограммы. 

Начало пика отображается в качестве непрерывной вертикальной черты, 

расположенной в соответствующей точке по оси Х. 

Конец пика отображается в качестве прерывистой вертикальной черты, 

расположенной в соответствующей точке по оси Х. 

При помещении указателя на начало, конец, площадь или высшую точку пика на 

экран выводится подсказка, отображающая подробную информацию. 
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Рассчитанная базовая линия появляется на хроматограмме при детектировании 

пиков. Базовая линия строится в соответствии с выбранными расчетами базовой 

линии и окрашивается в цвет соответствующей линии хроматограммы. При 

помещении указателя на базовую линию отображается подсказка с подробной 

информацией о базовой линии и линии хроматограммы. 

Изменение опций представления пиков на экране 

Базовую линию, площадь пика, метки пика или все данные опции можно скрывать 

или отображать. 

Как хроматограмма, так и таблица пиков выделяют информацию о выбранном 

элементе. Элементы, выбранные на хроматограмме, выделяются в таблице пиков, и 

наоборот. Аналогично, изменения, внесенные в одно изображение, отражаются на 

другом. 

 

При щелчке на элементе пика (высшей точке, начале, конце или площади пика) на 

хроматограмме или в строке пика таблицы пиков: 

■ В таблице выбирается строка пика. 

■ Площадь пика выделяется. 

■ Начало, конец и высшая точка пика выделяются жирным шрифтом. 

■ Выбирается соответствующая линия хроматограммы. 
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Для скрытия или отображения опций представления пиков на экране 

► Щелкните правой кнопкой мыши на хроматограмме, выберите View и выберите 

требуемую опцию или опции из раскрывающегося меню. Те же опции также 

появляются в меню View. 

Отображение результатов по пикам – таблица пиков 

Описание каждого пика приведено в строках таблицы пиков (Peaks). Для каждого 

пика отображаются следующие поля: 

■ Peak number (Номер пика) — порядковый. 

■ Run name (Имя анализа) 

■ Trace type (Тип линии хроматограммы) — линии УФ-детектора отображают 

значение длины волны в нанометрах, например, 280 нм. Линии модуля SIM 

отображают высоту и площадь пика в соответствующих единицах измерения. 

■ Start (Начало) — начало пика в единицах текущей отображаемой оси Х. 

■ End (Конец) — конец пика в единицах текущей отображаемой оси Х. 

■ Retention volume (Объем удерживания) — элюирущий объем при 

максимальной высоте пика. 

■ Retention time (Время удерживания) — время при максимальной высоте пика. 

■ Height (mAU) (Высота (е.о.п.)) — высота пика при объеме/времени 

удерживания, измеренная от линии УФ-детектора до рассчитанной базовой 

линии. 

■ Area (ml*mAU) (Площадь (мл*е.о.п.)) — площадь под кривой между линией 

УФ-детектора и базовой линией. 

■ Relative area (%) (Относительная площадь (%)) — площадь пика 

относительно всех площадей пиков линии хроматограммы. 

■ Width at half height (ml) (Ширина при половинной высоте (мл)) — ширина 

(в мл) пика при 50% максимальной высоты пика. 
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■ Peak asymmetry (Ассиметрия пика) — коэффициент ассиметрии, 

определяемый как расстояние от центральной линии пика до заднего склона, 

поделенное на расстояние от центральной линии пика до переднего склона. 

Все измерения производятся при 10% максимальной высоты пика. 

Примечание: Коэффициент ассиметрии пика обычно аналогичен 

коэффициенту размывания того же пика, но два значения не могут быть 

преобразованы напрямую. 

■ Fractions (Фракции) — все фракции между началом и концом пика. Фракции 

отображаются от первой до последней. 

■ Peak type (Тип пика) — тип интегрирования пика. 

□ Automatic (Автоматический) — пик был определен автоматически и не 

был отрегулирован вручную. 

□ Manual (Ручной) — пик был отрегулирован или добавлен в ручном 

режиме. 

■ Path length (cm) (Длина пути (см)) — длина пути проточной ячейки УФ-

детектора. Значение по умолчанию - 0,5 см. Система NGC имеет три 

опциональных проточных ячейки, которые используются для расчета 

концентрации белка: 0,2, 0,5 и 1,0 см. Данное поле можно изменить и задать 

другое значение для используемой проточной ячейки. При изменении значения 

в одной строке длина пути проточной ячейки для всех пиков одного анализа 

соответствующим образом обновляется. 

■ Extinction coefficient ((mg/ml)-1 cm-1) (Коэффициент экстинкции ((мг/мл)-1  

см-1)) — коэффициент экстинкции белка, используемый для расчета 

концентрации белка. По умолчанию данное поле пустое. Вы можете ввести 

значение размером до трех значащих разрядов. Значения коэффициентов, 

введенные в таблицу пиков, автоматически заполняют значения коэффициента 

экстинкции для соответствующих фракций в таблице фракций (Fractions). 

Значения коэффициентов, введенные в таблицу фракций, не заполняют 

автоматически таблицу пиков. 

■ Concentration (mg/ml) (Концентрация (мг/мл)) — рассчитанная концентрация 

белка для конкретного пика. Данное значение базируется на следующих 

расчетах: 

(площадь пика/объем пика) / (коэффициент экстинкции x длина пути x 1000) 
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■ Molecular mass (kDa) (Молекулярная масса (кДа)) — молекулярная масса 

белка. По умолчанию данное поле пустое. Значения молекулярной массы, 

вводимые в таблицу пиков, автоматически заполняют таблицу фракций для 

соответствующих фракций. Значения молекулярной массы, введенные в 

таблицу фракций, не заполняют автоматически таблицу пиков. 

■ Molarity (µM) (Молярность (мкM)) — рассчитанная молярная концентрация 

белка для конкретного пика.  Данное значение вычисляется из рассчитанных 

значений концентрации и молекулярной массы. 

■ 280/260 (или 280/255) – отношение коэффициентов поглощения на 280 нм и 

260 нм (или 255 нм), используемое для определения степени чистоты белка 

для каждого пика линии на 280 нм. Данное отношение появляется в области 

линии на 280 нм таблицы. Отношение рассчитывается с использованием 

значений линии УФ-детектора с вычтенной базовой линией при указанном 

времени или объеме удерживания пика на 280 нм. 

■ Примечание: Данный столбец появляется в таблице пиков после выполнения 

интегрирования пиков при детектировании линий на 280 нм и 260 нм (или 

250 нм). В зависимости от того, какая линия присутствует, имя столбца может 

быть или 280/260, или 280/255. 

Порядок отображения и выбор столбцов таблицы 

Вы можете изменить порядок расположения столбцов таблицы. Настройки выбора и 

порядка расположения столбцов задаются пользователем и применяются к 

результирующим таблицам результатов интегрирования пиков. 

Для изменения порядка отображения столбцов 

► «Перетащите» столбцы в новые местоположения в таблице пиков. 

Отображение или скрытие столбцов 

Как и в таблице Runs/Traces, вы можете отобразить или скрыть столбцы в таблице 

пиков, выбрав Show Column Chooser в контекстном меню. 

Примечание: Вы можете отобразить или скрыть столбцы в таблице без влияния на 

содержащиеся в таблице данные. 

Для скрытия столбцов в отображаемой таблице пиков 

► Щелкните на заголовке столбца для его скрытия и «перетащите» его из 

таблицы. 
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Для отображения скрытого столбца 

1. Щелкните правой кнопкой мыши на заголовке столбца и выберите Show Column 

Chooser (Отобразить селектор столбцов) в появившемся меню. 

2. «Перетащите» заголовок столбца, который вы хотите отобразить, из селектора 

столбцов в требуемое местоположение в таблице. 

Заголовок и данные столбца снова появятся в таблице. 

Копирование таблицы пиков 

Для копирования таблицы 

► Щелкните правой кнопкой мыши на таблице и выберите Copy Table в 

появившемся меню. 

Скопированную таблицу можно вставить в электронную таблицу или в другой 

тип документа. 

Группирование или разгруппирование таблицы пиков 

При разворачивании групп их данные становятся видимыми. При сворачивании 

групп видимыми остаются строки групп, а содержимое становится скрытым.  

По умолчанию пики классифицируются по анализу и по типу. Каждая комбинация 

анализа и типа линии хроматограммы отображается в виде группы. В группе 

находятся соответствующие пики. В таблице пиков настройки группирования для 

каждого анализа появляются в строке заголовка анализа непосредственно под 

заголовками столбцов. 

 

Для группирования пиков 

► Щелкните правой кнопкой мыши на таблице и выберите Group By Run 

(Группировать по анализу) или Group By Type (Группировать по типу) в 

появившемся меню. 

Примечание: В таблицах пиков нескольких анализов, отображаемых в одном 

представлении, вы также можете выбрать группирование по анализу и типу. 

Для разгруппирования пиков 

► В таблице щелкните правой кнопкой мыши на группе пиков и выберите Ungroup 

(Разгруппировать) в появившемся меню. 
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Для сворачивания или разворачивания групп пиков 

► Щелкните правой кнопкой мыши на таблице и выберите Expand All Groups 

(Развернуть все группы) или Collapse All Groups (Свернуть все группы) в 

появившемся меню. 

Сброс значений коэффициента экстинкции в таблице пиков 

Примечание: Сброс коэффициента в таблице пиков также производит сброс 

значений в столбцах Extinction Coefficient и Concentration в таблице фракций для 

фракций, содержащих данный пик. 

Для сброса значения коэффициента экстинкции для конкретного пика 

► Выберите значение и щелкните на Delete. 

Значение в ячейке столбца Extinction Coefficient будет сброшено вместе со 

значением в соответствующем столбце Concentration. 

Для сброса всех значений в столбце коэффициента экстинкции 

► Щелкните правой кнопкой мыши на таблице и выберите Clear Extinction 

Coefficient (Сбросить значение коэффициента экстинкции) в появившемся 

меню. 

Все значения, введенные в данном столбце, будут сброшены вместе со 

значениями столбца Concentration. 
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Регулирование пиков в ручном режиме 

Вы можете вручную отрегулировать пики, обнаруженные при автоматическом 

интегрировании пиков. Вы также можете добавить пик на хроматограмму в 

местоположение, в котором он был детектирован. При выборе закладки Manual 

Integration (Интегрирование в ручном режиме) в секции Peak Integration на 

хроматограмме появляются линии координатной сетки. 

 

Таблица Manual Integration отображает список протоколов анализов в текущих 

результатах анализа и их интегрированные линии УФ-детектора. Одновременно 

можно выбрать и отрегулировать только один пик. Отрегулировать можно только 

выбранную линию, и только ее пики появятся на хроматограмме. Данная закладка 

также отображает инструкции по регулированию пиков в ручном режиме. Кнопки 

Undo (Отменить) и Redo (Повторить) упрощает работу с различными настройками 

для данной линии хроматограммы. 
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Пики можно отрегулировать, выбрав опции меню, 

вызываемого щелчком правой кнопкой мыши на 

хроматограмме или таблице пиков. 

Для добавления пика 

► Щелкните правой кнопкой мыши в точке 

хроматограммы, не содержащей 

детектированный пик, после чего щелкните на 

Add Peak (Добавить пик) в появившемся меню. 

Новый пик будет добавлен к линии с шириной по 

умолчанию, которую позднее можно 

отрегулировать. Система произведет перерасчет и 

обновит статистику таблицы пиков. 

Для изменения начальной и конечной точек 

пика на хроматограмме 

1. Поместите указатель на линию начала или 

конца пика. 

Курсор примет вид пары стрелок, индицируя, то 

можно перемещать линию. 

2. Щелкните на линии для ее выбора и 

«перетащите» линию в другое положение. 

По мере перемещения линии ваши изменения 

применяются к таблице пиков. 

Для изменения начала или конца пика в таблице пиков 

1. На хроматограмме или в таблице пиков выберите пик для редактирования. 

2. В таблице пиков измените значение Start или End, или оба значения в 

выделенной строке. 
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Для разделения пика 

► На хроматограмме или в таблице пиков щелкните правой кнопкой мыши на 

пике, который вы собираетесь разделить, и щелкните на Split Peak (Разделить 

пик) в появившемся меню. 

Пик разделится на два пика. Точка разделения Х появляется в месте 

расположения указателя на момент выбора опции Split Peak. Таблица пиков 

обновится, включив два пика вместо одного. Система также произведет 

перерасчет и обновление статистики таблицы. 

Для удаления пика 

► Щелкните правой кнопкой мыши на хроматограмме или на таблице пиков, 

затем щелкните на опции Delete Peak (Удалить пик) в появившемся меню. 

Пик будет удален с хроматограммы и из таблицы пиков, и система также 

произведет перерасчет и обновление статистики для исключения удаленного 

пика. 

Для отмены или повторного регулирования пика в ручном режиме 

► Выберите линию на хроматограмме и щелкните на Undo или Redo в закладке 

Manual Integration для отмены или повторного применения последнего 

действия, выполненного в отношении линии. 

Сохранение данных интегрирования пиков 

При выполнении интегрирования пиков для одного анализа результаты сохраняются 

в результатах анализа. Настройки и результаты интегрирования пиков сохраняются 

при сохранении результатов анализа и загружаются при последующем открытии 

результатов анализа. 
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Оценка фракций 

При активации сбора фракций подробная информация о каждой фракции в анализе 

появляется в строке таблицы фракций под хроматограммой (одна строка для каждой 

собранной фракции). Местоположение фракции появляется на изображении 

штатива слева от таблицы фракций. Для поиска интересующих вас фракций 

используйте таблицу фракций, изображение штатива и хроматограмму. При 

использовании нескольких штативов используйте область выбора штатива. 

Отображение результатов сбора фракций 

 

Хроматограмма отображает фракции, собранные во время каждого анализа, в виде 

наборов меняющихся цветовых оттенков: 

■ Синий — для фракций, собранных через коллектор фракций BioFrac™. Штатив 

и номер пробирки появляются в верхней части каждого набора. 
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■ Оранжевый — для фракций, собранных через выходной клапан. Выходной 

клапан и номер порта появляются в верхней части каждого набора. 

После интегрирования пиков появляется тепловая карта, индицирующая 

относительные величины чистоты в каждой пробирке. Элементы, выбранные на 

хроматограмме, выделяются на изображении штатива или выходного клапана и в 

таблице фракций, и наоборот. 

Изображение штатива 

 

Изображение выходного клапана 
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Отображение результатов сбора фракций – таблица 
фракций 

Подобно таблице линий хроматограммы, таблица фракций становится доступной 

при открытии протокола анализа в окне Evaluation. Таблица фракций доступна 

только при наличии в окне Evaluation одного открытого протокола анализа. Она не 

отображается для результатов нескольких анализов и для представлений сравнения 

линий хроматограммы. 

Для каждой собранной фракции отображаются следующие поля: 

■ # — порядковый номер строки. 

■ Rack/Tube (Штатив/пробирка) — штатив и номер пробирки.  

■ Tube location (Местоположение пробирки) — местоположение пробирки на 

планшете или в штативе на основании ее схемы нумерации. 

■ Start (Начало) — начало сбора фракций в единицах текущей отображаемой 

оси Х. 

■ End (Конец) — конец сбора фракций в единицах текущей отображаемой оси Х. 

■ Collected volume (ml) (Собранный объем (мл)) — общий объем фракций, 

собранных в пробирку.  

■ Area (ml*mAU) (Площадь (мл*е.о.п.)) — площадь фракции между линией УФ-

детектора, выбранной в тепловой карте, и ее базовой линией. Данный столбец 

появляется после завершения интегрирования пиков. 

■ Amount (mg) (Количество (мг)) — количество белка во фракции на основании 

линии хроматограммы, выбранной в тепловой карте. Данный столбец 

появляется после завершения интегрирования пиков и ввода в таблицу 

коэффициента экстинкции. 

■ Concentration (mg/ml) (Концентрация (мг/мл)) — рассчитанная концентрация 

белка для определенной фракции на основании линии хроматограммы, 

выбранной в тепловой карте. Данный столбец появляется после завершения 

интегрирования пиков и ввода в таблицу коэффициента экстинкции. 

■ Relative area (%) (Относительная площадь (%)) — площадь фракции 

относительно всех площадей фракций на линии хроматограммы. Данный 

столбец появляется после завершения интегрирования пиков. 
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■ Extinction coefficient ((mg/ml)-1 cm-1) (Коэффициент экстинкции ((мг/мл)-1  

см-1)) — коэффициент экстинкции белка, используемый для расчета 

концентрации белка. ПО ChromLab автоматически заполняет данное поле при 

вводе коэффициента экстинкции или его изменении в таблице пиков. 

Примечание: Изменение одного коэффициента в таблице пиков влияет только 

на коэффициенты для фракций, содержащих данный пик. 

■ Molecular mass (kDa) (Молекулярная масса (кДа)) — молекулярная масса 

белка. По умолчанию данное поле пустое. Значения молекулярной массы, 

вводимые в таблицу пиков, автоматически заполняют таблицу фракций для 

соответствующих фракций. Значения молекулярной массы, введенные в 

таблицу фракций, не заполняют автоматически таблицу пиков. 

■ Molarity (µM) (Молярность (мкM)) — рассчитанная молярная концентрация 

белка для конкретного пика. Данное значение вычисляется из рассчитанных 

значений концентрации и молекулярной массы. 

■ 280/260 (или 280/255) – отношение средних коэффициентов поглощения на 

280 нм и 260 нм (или 255 нм), используемое для определения степени чистоты 

белка для каждой фракции. Данное отношение появляется в области линии на 

280 нм таблицы. Отношение рассчитывается с использованием значений линии 

УФ-детектора с вычтенной базовой линией в пределах фракции. 

Примечание: Данный столбец появляется после выполнения интегрирования 

пиков при детектировании линий на 280 нм и 260 нм (или 250 нм).  

В зависимости от того, какая линия присутствует, имя столбца может быть или 

280/260, или 280/255. 
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Расчет концентрации белка для фракций 

Вы можете рассчитать и просмотреть концентрацию белка для отдельных и 

смешанных фракций после выполнения интегрирования пиков. Интегрирование 

пиков производится с настройками по умолчанию. При необходимости вы можете 

отрегулировать базовую линию, изменив параметры Best Fit или Offset и выполнив 

повторное интегрирование. Базовая линия используется для расчета площади под 

кривой линии УФ-детектора в каждой фракции. См. «Опция Baseline Parameters 

(Параметры базовой линии)» на стр. 233 для получения более подробной 

информации. 

Для смешанных фракций концентрация белка рассчитывается по 

средневзвешенному значению фракций, включенных в группу. 

Для расчета концентрации белка для отдельных или смешанных фракций 

► Щелкните на Peak Integration на панели инструментов закладки Run. 

После выполнения интегрирования пиков в таблице фракций появятся следующие 

столбцы: 

■ Area (Площадь) 

■ Relative Area (Относительная площадь) 

■ Extinction Coefficient (Коэффициент экстинкции) 

■ Concentration (Концентрация) 

■ Amount (Количество) 

Поля Extinction Coefficient и Concentration заполняются автоматически при вводе 

коэффициента экстинкции в таблицу пиков. Если фракция охватывает несколько 

пиков с различными значениями коэффициента экстинкции, данные значения не 

импортируются, и поле Extinction Coefficient в таблице фракций отображает слово 

«Multiple» (несколько). В данном случае вы можете вручную ввести коэффициент 

экстинкции в таблице фракций. 

Также в таблице фракций можно вручную изменить коэффициент экстинкции 

фракции. Это не изменит значение коэффициента пика в таблице пиков. 
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Просмотр данных фракций 

Для просмотра данных одной фракции 

► Выполните одно из следующих действий: 

■ Выберите местоположение пробирки или порта выходного клапана на 

хроматограмме. 

■ Выберите строку в таблице, соответствующую интересующей вас 

фракции. 

■ Выберите интересующую вас фракцию в отображении фракций слева от 

таблицы. 

Совет: Если интересующая вас фракция находится в другой емкости, 

измените отображение, щелкнув на номере фракции на панели выбора 

штатива. 

Для выбора нескольких фракций 

► Выполните одно из следующих действий: 

■ Для выбора диапазона фракций выполните комбинацию «Shift + левая 

кнопка мыши» на первой фракции в диапазоне и затем – на последней 

фракции в диапазоне. 

■ Для выбора группы отдельных фракций щелкните по отдельности на 

каждой интересующей вас фракции, удерживая клавишу Ctrl. 

Объединение фракций 

Можно выбрать несколько фракций для группировки (или объединения) на 

хроматограмме или в таблице фракций для ознакомления с рассчитанными 

концентрациями. При объединении фракций группа фракций создается и на 

изображении штатива. 

Примечание: Группа должна состоять из смежных пробирок на хроматограмме или 

строк в таблице. Можно объединить несколько фракций от одного порта выходного 

клапана, щелкнув правой кнопкой мыши на таблице фракций и выбрав Pool Outlet 

Valve/Port (Объединить от выходного клапана/порта). Объединению не подлежат 

фракции от отключенного коллектора фракций. 

В таблице фракций группа фракций сворачивается в одну строку. В таблице 

фракцией группа идентифицируется следующими опциями: 

■ Знак «+» — появляется в первой ячейке свернутой строки. 

■ Fraction number (Количество фракций) — диапазон фракций в группе 

(например, фракции 1-4). 
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■ Tube location (Местоположение пробирки) — местоположение группы 

объединенных пробирок в штативе. 

■ Start (Начало) — начало сбора первой фракции в группе. 

■ End (Конец) — конец сбора последней фракции в группе. 

■ Collected volume (ml) (Собранный объем (мл)) — общий объем фракций, 

собранных во все пробирки в группе.  

■ Area (ml*mAU) (Площадь (мл*е.о.п.) — сумма всех площадей в группе. 

Данный столбец появляется после завершения интегрирования пиков. 

■ Relative area (%) (Относительная площадь (%)) — площадь группы 

относительно всех площадей на линии хроматограммы. Данный столбец 

появляется после завершения интегрирования пиков. 

■ Amount (mg) (Количество (мг)) — сумма всех количеств фракций в группе. 

Данный столбец появляется после завершения интегрирования пиков. 

■ Concentration (mg/ml) (Концентрация (мг/мл)) — рассчитанная концентрация 

белка для конкретной группы. Данное значение является средневзвешенным 

значением концентраций фракций по объему в группе. 

■ Molarity (µM) (Молярность (мкM)) — рассчитанная молярная концентрация 

белка для группы. Данное значение является средневзвешенным значением 

молярных концентраций фракций по объему в группе. 

Для создания группы фракций 

1. В таблице фракций выберите несколько смежных строк фракций, удерживая 

клавишу Ctrl или Shift. 

2. Щелкните правой кнопкой мыши на группе смежных фракций и выберите Pool. 

Для разворачивания группы в таблице фракций 

► Выполните одно из следующих действий: 

■ В таблице фракций щелкните на знаке «+» в первой ячейке. 

■ Щелкните правой кнопкой мыши на таблице фракций и выберите Expand 

all pools (Развернуть все группы). 

Для отмены объединения фракций 

► В таблице фракций щелкните правой кнопкой мыши на строке группы и 

выберите Unpool (Разделить). 
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Просмотр результатов сбора фракций — тепловая 
карта 

Конфигурация коллектора фракций (изображение штатива или выходного клапана) 

появляется слева от таблицы фракций. Изображение демонстрирует конфигурацию 

выбранного коллектора фракций для выполненного анализа. После интегрирования 

пиков появляется тепловая карта свойств фракций. Если для анализа использовался 

многоволновый УФ-детектор, вы можете выбрать линию для тепловой карты (линия 

по умолчанию - 280 нм). Цвет тепловой карты основан на цвете выбранной на 

хроматограмме линии. Пробирки или порты выходного клапана, не содержащие 

фракций, отображаются затененными. 

Примечание: Так как выходной клапан 1, порт 1 (OV1 Port 1) направляет поток к 

перепускному клапану коллектора фракций или в отходы, он всегда появляется на 

изображении выходного клапана затененным. Когда для сбора фракций 

используются два выходных клапана, клапан 1, порт 12 (OV1 Port 12) также 

появляется затененным. 

Вы можете применить тепловую карту к любому из следующих столбцов таблицы 

фракций, выбрав из раскрывающегося списка Color by (Окрашивать по…): 

■ Area (Площадь) 

■ Concentration (Концентрация) 

■ Amount (Количество) 

■ Molarity (Молярность) 

■ 280/260 (или 255) 
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Шкала цветов базируется на выбранном столбце и является относительной среди 

всех доступных фракций анализа. Более темный цвет представляет большее 

значение, и положения пробирок или клапана, не содержащих фракций, являются 

недоступными для выбора. 

 

Просмотр данных тепловой карты 

Для изменения отображаемой линии хроматограммы 

► Выберите другую линию УФ-детектора из раскрывающегося списка (линия 

доступна, только если в методе использовался многоволновый УФ-детектор). 

Для изменения отображаемых значений 

► Выберите Area, Concentration, Amount, Molarity или 280/260 (или 255) из 

раскрывающегося списка Color by. 
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Для скрытия изображения штатива 

► Щелкните на стрелке «свернуть» справа от изображения фракций. 

Для выбора штатива или планшета для просмотра 

► Щелкните на соответствующем значке отображения на панели выбора 

штатива. Используйте стрелки «вверх» и «вниз» рядом с панелью для 

прокрутки изображений штативов, планшетов или выходных клапанов. 
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Анализ эффективности колонки 

Анализы по выбранному методу, включающие фазу проверки эффективности 

колонки, могут быть проанализированы на предмет эффективности колонки. 

Программное обеспечение ChromLab анализирует характеристики используемой 

колонки и предоставляет статистику качества, включающую число теоретических 

тарелок (N), число тарелок на метр (N/L), высоту, эквивалентную теоретической 

тарелке (HETP), и приведенную высоту тарелки (rHETP). Результаты появляются в 

закладке Column Performance (Эффективность колонки) в нижней части окна 

Evaluation и на хроматограмме. 

Эффективность колонки – настройки 

При щелчке на Analyze Column Performance в меню Analysis справа от 

хроматограммы появляется секция Column Performance. Настройки по умолчанию в 

закладке Settings используются для автоматического расчета различных 

функциональных свойств колонки. Вы можете изменить настройки по умолчанию и 

выбрать значения измерений характеристик качества, которые будут отображаться в 

таблице Column Performance. 
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Опция Traces (Линии хроматограммы) 

Проанализировать характеристики колонки можно 

или на основании одной линии УФ-детектора, или 

линии кондуктометрического детектора. 

Опция Calculate (Рассчитать) 

Вы можете рассчитать и отобразить следующие 

значения измерений: 

Number of plates (N) (Число тарелок (N)) — 

отображает число теоретических тарелок, 

индикатор эффективности колонки. Число 

теоретических тарелок является косвенным 

показателем ширины пика при определенном 

времени удерживания. Столбцы с большим 

числом тарелок считаются более эффективными. 

Формула, используемая для расчета числа 

тарелок: 

N = 5,54 * (время удерживания пика/ширина пика 

при половинной высоте)2 

Plates per meter (N/L) (Тарелок на метр (N/L)) — число теоретических тарелок на 

метр, значение, используемое для сравнения числа теоретических тарелок между 

столбцами. Для данного измерения требуется средняя высота (в см) слоя 

используемой колонки. Формула, используемая для расчета числа тарелок на метр: 

тарелок/метр = N/L 

где L = средняя высота слоя 

HETP — высота, эквивалентная теоретической тарелке, значение, используемое для 

определения числа теоретических тарелок, содержащихся в любой длине колонки.  

Чем меньше высота, эквивалентная одной тарелке, тем выше показатель 

эффективности колонки. Для данного измерения требуется средняя высота слоя. 

Формула, используемая для расчета HETP: 

HETP = L/N 
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(rHETP) — приведенная высота тарелки, значение, используемое для сравнения 

эффективности нескольких колонок, наполненных частицами различных размеров. 

Колонки со значением rHETP ≤2 считаются надлежащим образом наполненными и 

более эффективными. Для данного измерения требуется средняя высота слоя и 

средний диаметр частиц (в мкм) для используемой колонки. Формула, используемая 

для расчета rHETP: 

rHETP = HETP/Dp 

где Dp = средний диаметр частиц  

Анализ эффективности колонки 

При анализе эффективности предварительно определенных колонок ПО ChromLab 

получает значения средней высоты слоя и среднего диаметра частиц из таблицы 

свойств колонки и автоматически производит все измерения. 

При анализе эффективности пользовательских колонок ПО ChromLab автоматически 

рассчитывает только число тарелок. После ручного ввода значений средней высоты 

слоя и среднего диаметра частиц ПО ChromLab автоматически производит все 

выбранные измерения. 

Исходные значения берутся с линии УФ-детектора. Вы можете изменить линию для 

проведения измерений на основании проводимости. 

Для анализа эффективности колонки 

1. Выберите Analysis > Analyze Column Performance. 

Рядом с хроматограммой появится секция Column Performance. Таблица 

Column Performance появится в нижней секции, заполненной известными 

значениями для колонки. 

2. (Опционально) В области Traces секции Column Performance измените линию 

хроматограммы для использования. 

3. В области Calculate выберите или отмените выбор кнопок-флажков 

соответствующих значений, которые необходимо рассчитать. 
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4. Введите в данной области значения высоты слоя и диаметра частиц для 

расчета значений N/L, HETR или rHETR. 

Совет: Для предварительно определенных колонок вы можете изменить в 

данной области предварительно определенные значения для высоты слоя и 

диаметра частиц без изменения значений в Редакторе методов. 

5. Щелкните на Apply для расчета статистики эффективности выбранной колонки 

и отображения ее в таблице. 

Совет: Вы можете включить статистику эффективности колонки в отчете об 

анализе. Информация о создании отчетов об анализах приведена в разделе 

«Отчеты об анализах» на стр. 281. 

Сброс эксплуатационных характеристик колонки 

Для сброса эксплуатационных характеристик к значениям по умолчанию 

► Щелкните на Reset для возврата кнопок-флажков эксплуатационных 

характеристик к значениям по умолчанию. 

Удаление эксплуатационных данных колонки 

Для удаления эксплуатационных данных колонки для отображаемой линии 

хроматограммы 

► Щелкните на Delete. 

Примечание: Данное действие также удаляет таблицу Column Performance. 
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Эффективность колонки – ручное регулирование 

В закладке Manual Adjustment (Ручное регулирование) секции Column Settings 

(Настройки колонки) можно вручную отрегулировать точки начала и конца пика в 

пределах фазы определения эффективности колонки. Результаты регулировки точек 

начала и конца пика появятся в соответствующем столбце таблицы Column 

Performance в нижней секции окна. Начальную и конечную точки можно также 

отрегулировать в таблице Column Performance. Внесенные изменения появятся в 

соответствующих точках на хроматограмме. 

Для изменения точек начала и конца пика на хроматограмме 

► «Перетащите» маркер начала и/или конца пика на отрегулированное значение 

времени. 

Для изменения точек начала и конца пика в таблице Column Performance 

► Введите отрегулированное значение времени в соответствующий столбец. 

Для отмены результатов регулировки 

► Щелкните на Undo в закладке Manual Adjustment. 

Для повторной регулировки 

► Щелкните на Redo в закладке Manual Adjustment. 

Отображение результатов анализа эффективности 
колонки – хроматограмма 

Хроматограмма отображает пик эффективности колонки заштрихованным и 

затененным. Начало, конец и высшая точка данного пика индицируются небольшими 

вертикальными линиями в соответствующих точках по оси Х. 

Время удерживания, объем удерживания или объем колонки появляется рядом с 

линией высшей точки пика. 

Начальный пик появляется в качестве непрерывной вертикальной линии, 

расположенной в соответствующей точке по оси Х. 

Конец пика отображается в качестве прерывистой вертикальной линии, 

расположенной в соответствующей точке по оси Х. 

При помещении указателя на начало, конец, площадь или высшую точку пика на 

экран выводится подсказка, отображающая подробную информацию. 
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Отображение результатов анализа эффективности 
колонки – таблица Column Performance 

Результаты анализа эффективности колонки подробно излагаются в таблице Column 

Performance. Таблица отображает следующие поля для пика эффективности 

колонки: 

■ N — отображает рассчитанное число теоретических тарелок для колонки. 

■ N/L (cm-1) — отображает рассчитанное число теоретических тарелок на метр 

для колонки. 

■ HETP (cm) — отображает рассчитанную высоту, эквивалентную теоретической 

тарелке, для колонки. 

■ rHETP — отображает рассчитанную приведенную высоту тарелки для колонки. 

■ Bed height (cm) (Высота слоя (см)) — отображает значение средней высоты 

слоя, определенное в секции Settings. 

■ Particle diameter (µm) (Диаметр частиц (мкм)) — отображает значение 

среднего диаметра частиц, определенное в секции Settings. 

■ Run start time (Время начала анализа) 

■ Column type (Тип колонки) — отображает тип колонки. Тип колонки задается в 

секции Method Settings в представлении настроек метода. 

■ Start (Начало) — начало пика в единицах текущей выбранной оси Х. 

■ End (Конец) — конец пика в единицах текущей выбранной оси Х. 

■ Retention time (Время удерживания) — отображает время элюирования при 

максимальной высоте пика. 

■ Retention volume (Объем удерживания) — отображает элюирущий объем при 

максимальной высоте пика. 

■ Height (mAU) (Высота (е.о.п.)) — высота пика при объеме/времени 

удерживания, измеренная от линии УФ-детектора до рассчитанной базовой 

линии. 
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■ Width at half height (ml) (Ширина при половинной высоте (мл)) — 

отображает ширину (в мл) пика при 50% максимальной высоты пика. 

■ Peak asymmetry (Ассиметрия пика) — отображает коэффициент ассиметрии, 

определяемый как расстояние от центральной линии пика до заднего склона, 

поделенное на расстояние от центральной линии пика до переднего склона. 

Все измерения производятся при 10% максимальной высоты пика. 

■ Peak type (Тип пика) — тип интегрирования пика. 

□ Automatic (Автоматический) — пик был определен автоматически и не 

был отрегулирован вручную. 

□ Manual (Ручной) — пик был отрегулирован или добавлен в ручном 

режиме.  
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 8 Импорт и экспорт данных 

Импорт файлов данных может осуществляться в окне Home, Method Editor или 

Evaluation при выборе опции Import в меню File. Система поддерживает импорт 

следующих файлов данных: 

■ файлы данных NGC, включая регулярные и поисковые методы, методы с 

протоколами анализов и файлы протоколов анализов, экспортированные из ПО 

ChromLab, выполняемого на другом компьютере 

■ файлы данных Unicorn (v. 5 и v. 6) 

■ файлы данных BioLogic DuoFlow 

Импорт метода или протокола анализа NGC 

В окне Home, Method Editor или Evaluation вы можете импортировать метод с или без 

протоколов анализов или импортировать протокол анализа. Файлы методов и 

протоколов анализов сохраняются со следующими расширениями: 
 

Метод .ngcMethod 

Метод с протоколами анализов .ngcMethodRuns 

Протокол анализа .ngcRun 

Вы можете импортировать метод с соответствующими протоколами анализов, даже 

если целевая папка уже содержит метод с тем же именем. В данных случаях: 

■ Все новые протоколы анализов прилагаются к существующему методу 

■ Существующие протоколы анализов не импортируются дважды 
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Для импорта метода или протокола анализа 

1. В окне Home, Method Editor или Evaluation выберите File > Import и выберите 

NGC File. 

Появится диалоговое окно Import NGC File. 

 

2. Щелкните на Select (Выбрать). В секции Select Project (Выбрать проект) 

выполните одно из следующих действий: 

■ Выберите проект назначения для метода или протокола анализа и 

щелкните на Select Project. 

■ Переименуйте проект, используя соответствующую кнопку в верхней 

части диалогового окна, и выберите проект для переименования. 

Щелкните на Select Project. 

■ Создайте новый подпроект или корневой проект и щелкните на Select 

Project. 

3. В диалоговом окне Import NGC File щелкните на Browse для отображения 

диалогового окна Open. 

4. Выберите файл метода или протокола анализа для импортирования и 

щелкните на Open. 

Совет: Для одновременного импорта нескольких методов или протоколов 

анализов выберите каждый файл, нажав и удерживая клавишу Ctrl или Shift. 

5. (Опционально) В поле Name введите другое имя для метода или анализа. 

Примечание: Данная опция не доступна, если для импорта выбраны несколько 

методов или протоколов анализов. 
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6. (Опционально) Выберите Open on Import (Открыть по завершении импорта) для 

открытия окна Evaluation по завершении импорта. 

 Примечание: Данная опция не доступна, если для импорта выбраны несколько 

методов или протоколов анализов. 

7. Щелкните на Import. В процессе импортирования появляется диалоговое окно 

состояния. После успешного импорта всех методов и протоколов анализов 

строка состояния отображает Completed (Выполнено). 

8. Щелкните на OK для закрытия диалогового окна. 

 Файлы импортируются в выбранный вами проект. Импортированные файлы 

данных перечисляются в диалоговом окне Open Run/Analysis, доступного через 

меню File окон Evaluation и Home. 

Импорт файлов данных Unicorn 

Импортированные данные Unicorn добавляются в базу данных NGC. Файл протокола 

анализа Unicorn можно импортировать в формате .asc или .csv. Импортированный 

протокол анализа можно сравнить с другими протоколами анализов в базе данных. 

Для импорта файла данных Unicorn 

1. В окне Home или Evaluation выберите File > Import > Unicorn Data. 

2. В диалоговом окне Import Unicorn Data выполните одно из следующих 

действий: 

■ Щелкните на Select и выберите проект назначения для импортированного 

протокола анализа. 

■ Создайте или переименуйте проект, используя соответствующую кнопку в 

верхней части диалогового окна, и выберите проект. Вы также можете 

создать новый подпроект или корневой проект. 
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3. Щелкните на Select Project. 

4. В диалоговом окне Import Unicorn Data щелкните на Browse для отображения 

диалогового окна Select Unicorn File (Выбрать файл Unicorn). 

5. Выберите файл протокола анализа и щелкните на Open. 

 Имя файла протокола анализа и выбранный проект появятся в диалоговом 

окне Import Unicorn Data. 

 

6. (Опционально) В поле Run Name введите другое имя для протокола анализа, 

который вы хотите импортировать. 

7. (Опционально) Для открытия файла протокола анализа после импортирования 

в окне Evaluation выберите опцию Open on Import. 

8. Щелкните на Import. По завершении операции импорта щелкните на OK. 

 Файлы данных импортируются в выбранный вами проект. Импортированные 

файлы данных перечисляются в диалоговом окне Open Run/Analysis, 

доступного через меню File окон Evaluation и Home. 
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9. Выберите протокол анализа, если он еще не открыт, для отображения его 

хроматограммы и таблицы линий хроматограммы в окне Evaluation. 

 

Импорт файлов данных BioLogic DuoFlow 

Импорт данных BioLogic DuoFlow осуществляется в файл BIODB.txt. 

Импортированные данные BioLogic DuoFlow добавляются в базу данных NGC. 

Для импорта файла данных BioLogic DuoFlow 

1. В окне Home или Evaluation выберите File > Import > DuoFlow Data. 

2. В диалоговом окне DuoFlow Data щелкните на Select и выберите проект из 

появившегося списка проектов. 

 

3. В диалоговом окне Select DuoFlow File (Выбрать файл DuoFlow) выберите файл 

данных для импорта. 
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4. Щелкните на Import. 

ПО ChromLab импортирует все протоколы анализов в файл данных. 

Для открытия импортированного протокола анализа 

1. Выберите File > Open Run/Analysis и выберите проект, в который будет 

импортирован файл данных. 

2. Выберите протокол анализа в диалоговом окне Open Run/Analysis и щелкните 

на Open Run. 

Выбранный протокол анализа появится в окне Evaluation. 

Экспорт данных 

Вы также можете экспортировать данные анализа с методом, использованном для 

его создания, или экспортировать только протокол анализа, или только метод. 

Примечание: Экспортировать данные анализа без соответствующего метода можно 

только в окне Evaluation. 

Вы можете экспортировать данные анализа в виде файла NGC, который может быть 

загружен в другую систему или на другой компьютер, работающий под управлением 

ПО ChromLab, или файла a .csv, который подходит для импорта в другие 

приложения. Более подробная информация приведена в разделе «Экспорт данных 

анализа в виде файла .csv» на стр. 273. 

Экспортированные файлы данных сохраняются со следующими расширениями: 
 

Только метод .ngcMethod 

Метод с протоколами анализов .ngcMethodRuns 

Протокол анализа .ngcRun 

Протокол анализа .csv 

Примечание: Вы не можете экспортировать поисковые методы, содержащие 

соответствующие протоколы анализов или протоколы анализов по поисковым 

методам. Экспортировать можно только собственно поисковые методы. 
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Экспорт данных в виде файла NGC 

Из окон Home, Method Editor или Evaluation можно экспортировать информацию о 

методе или анализе. 

■ В окне Home вы можете одновременно осуществлять экспорт одного или 

нескольких протоколов анализов, собственно методов и методов с 

соответствующими протоколами анализов. Открывать протоколы анализов или 

методы для их экспорта не требуется. 

■ В окне Method Editor вы открываете метод и экспортируете вместе с ним все 

соответствующие протоколы анализов. 

■ В окне Evaluation вы открываете протокол анализа и экспортируете только 

протокол анализа, только метод или протокол анализа с его методом. 

По умолчанию при экспорте протокола анализа экспорт данных (например, объема 

колонки) его метода не производится. В результате любой отчет, впоследствии 

генерируемый на основании импортированного протокола анализа, не будет 

включать данные метода. 

Экспорт метода с соответствующими протоколами анализов обеспечивает 

появление данных метода в отчетах об анализах, генерируемых впоследствии. 

Вы также можете экспортировать только метод, связанный с анализом. 

Для экспорта данных одного анализа с соответствующим методом 

1. С протоколом анализа, отображаемом в окне Evaluation, выберите Export > Run 

with Method (Протокол анализа с методом). 

Появится диалоговое окно Save As с именем метода и типом файла. 

2. Перейдите к папке, в которой вы хотите сохранить экспортированные данные и 

метод анализа, и щелкните на Save. По завершении операции импорта 

щелкните на OK. 
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Для экспорта метода со всеми его протоколами анализов 

1. С методом, отображаемым в окне Method Editor, выберите File > Export Method 

with Runs (Экспортировать метод с протоколами анализов). 

Появится диалоговое окно Save As с именем метода и типом файла. 

2. Перейдите к папке, в которой вы хотите сохранить экспортированные данные и 

метод анализа, и щелкните на Save. После завершения импорта метода с его 

протоколами анализов щелкните на OK. 

Для экспорта только метода 

1. С протоколом анализа, отображаемым в окне Evaluation, выполните одно из 

следующих действий: 

■ Выберите File > Export > Method only (Только метод). 

■ Выберите File > Show Method для отображения метода в окне Method 

Editor, после чего выберите Export Method. 

Появится диалоговое окно Save As с именем метода и типом файла. 

2. Перейдите к папке, в которой вы хотите сохранить экспортированный метод, и 

щелкните на Save. По завершении операции импорта метода щелкните на OK. 

3. Щелкните на кнопке OK. 

Для экспорта только данных анализа 

1. С протоколом анализа, отображаемом в окне Evaluation, выберите Export > Run 

only (f.ngcRun) (Только протокол анализа (f.ngcRun)). 

Появится диалоговое окно Save As с именем анализа и типом файла. 

2. Перейдите к папке, в которой вы хотите сохранить экспортированные данные и 

метод анализа, и щелкните на Save. По завершении операции импорта данных 

анализа щелкните на OK. 
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Для экспорта нескольких методов и соответствующих протоколов анализов 

1. В окне Home выберите File > Export > Method/Method Runs. 

Появится диалоговое окно Method/Method Runs (Метод/анализы по выбранному 

методу). 

 

2. Выберите папку проекта, содержащую методы, которые вы хотите 

экспортировать, в левой секции окна. 

3. Удерживая клавишу Ctrl или Shift, выберите несколько методов из перечня в 

правой секции окна. 

4. Щелкните на Browse для задания целевой папки, в которой будут сохранены 

данные метода. 

5. (Опционально) Выберите Include Runs (Включить протоколы анализов) для 

экспорта соответствующих данных анализов. 

6. Щелкните на Export. 

В процессе импортирования появляется диалоговое окно состояния. После 

успешного импорта всех данных методов и анализов строка состояния 

отображает Completed. 
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7. Щелкните на OK для закрытия диалогового окна. 

Для экспорта нескольких протоколов анализов 

1. В окне Home выберите File > Export > Runs. 

Появится диалоговое окно Export Runs (Экспортировать протоколы анализов). 

2. Выберите папку проекта, содержащую протоколы анализов, которые вы хотите 

экспортировать, в левой секции окна. 

3. Удерживая клавишу Ctrl или Shift, выберите несколько протоколов анализов из 

перечня в правой секции окна. 

4. Щелкните на Browse для задания целевой папки, в которой будут сохранены 

данные анализа. 

5. (Опционально) Выберите Include Methods (Включить методы) для экспорта 

соответствующих методов. 

6. Щелкните на Export. После успешного экспортирования всех данных анализов 

щелкните на OK. 



Экспорт данных 

Руководство пользователя   |   273 

Экспорт данных анализа в виде файла .csv 

Экспорт данных анализа в виде файла .csv позволяет применять различные 

стандартные форматы файлов, такие как табличные форматы, что, в свою очередь, 

позволяет включать данные в отчеты и обрабатывать их в соответствии с 

собственными требованиями. Экспорт данных анализа производится по следующим 

правилам: 

■ Экспортируются только линии хроматограммы с меткой «Show in the Run table» 

(Отображать в таблице анализов). 

■ По умолчанию экспортируются все точки данных (значения оси Y), даже если 

они находятся в настоящий момент не в своем масштабе. 

■ Масштаб оси Х (единицы) определяется по текущей отображаемой оси. 

■ Если задана точка впрыска, она определяет нулевую точку оси Х. 

■ По умолчанию данные экспортируются таким образом, что каждая линия 

хроматограммы имеет два столбца: данные по оси Х и данные по оси Y. Так как 

для каждого типа линии хроматограммы используется своя частота замеров, 

различные линии имеют различные количества значений. 

Для экспорта данных хроматограммы в файл .csv 

1. С отображаемым файлом протокола анализа выполните одно из следующих 

действий: 

■ Выберите File > Export > As .csv. 

■ Щелкните правой кнопкой мыши на хроматограмме и выберите команду 

Export As .csv из появившегося меню. 

Появится диалоговое окно Export as .csv. 

Протоколы анализов, отображаемые в данный момент в ПО ChromLab, 

включены в список и предварительно выбраны.  
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2. Отмените выбор кнопки-флажка для любых данных анализа, которые вы не 

собираетесь экспортировать. 

3. Для изменения настроек по умолчанию щелкните на Advanced для 

отображения дополнительных настроек. 

4. Под Range (Диапазон) выберите Full Scale (Полномасштабный) для экспорта 

всего диапазона данных или выберите Current view (Текущее представление) 

для экспорта только видимого диапазона. 

5. Под Sampling (Выборка) выберите Sample every n data points (Отбирать каждые 

n точек данных) для сокращения количества точек данных на введенный 

коэффициент. Это сократит количество экспортируемых данных. 

6. Выберите Normalize all x-axes (Нормализовать все оси Х) для применения ко 

всем линиям хроматограммы одной оси (один столбец) и нескольких столбцов 

Y, по одному для каждой экспортированной линии. 

Примечание: Использование одной оси Х упрощает построение графиков 

результатов, когда экспортированные данные открываются в приложениях для 

работы с электронными таблицами. 

7. Щелкните на Export. 

Откроется диалоговое окно Save .csv, в котором вы можете отредактировать 

имя файла и выбрать папку назначения для файла .csv. 

8. Щелкните на кнопке Save. 
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Экспорт журналов диагностики 

В ПО ChromLab вы можете экспортировать всю важную информацию, необходимую 

Группе технической поддержки компании Bio-Rad для диагностики неисправностей. 

Даня информация включает сведения о системе, текущие файлы регистрации и 

соответствующие протоколы анализов и методы за определенный диапазон 

времени, включающий момент обнаружения проблемы, а также описание проблемы 

или проблем. 

Примечание: Сведения о лампах не включаются в экспортируемые журналы 

диагностики. Для получения информации о состоянии ламп выберите File > System 

Information в окне System Control и щелкните на Get Lamp Status в закладке Detector. 

По умолчанию файлы регистрации и данные экспортируются в zip-файл и 

сохраняются на рабочем столе компьютера, работающего под управлением ПО 

ChromLab. Вы также можете сохранить файл в другое местоположение. 

Для экспорта журналов диагностики 

1. В окне Home, System Control или Method Editor выберите Help > Export 

Diagnostic Logs. Появится диалоговое окно Export Diagnostic Logs. 

 

2. Выполните шаги, приведенные в диалоговом окне. 
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3. (Опционально) Отмените выбор кнопки-флажка Include Runs and Methods in the 

export file (Включить протоколы анализов и методы в файл экспорта) для 

исключения всех данных методов и анализов из файла экспорта. 

4. (Опционально) Щелкните на Review для отображения диалогового окна Include 

Runs and Methods (Включить протоколы анализов и методы). Данное 

диалоговое окно перечисляет протоколы анализов с методами и отдельно 

перечисляет методы, использованные в анализах, выполненных за выбранный 

период времени. Например: 

 

5. В диалоговом окне Include Runs and Methods вы можете: 

■ изменять диапазон дат; 

■ отменять выбор кнопок-флажков для вводов, не имеющих отношение к 

конкретному вопросу. Данные этих вводов не будут включены в журналы. 
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■ Выполните одно из следующих действий: 

□ Щелкните на OK для принятия любых изменений и возврата к 

диалоговому окну Export Diagnostic Logs. 

□ Щелкните на Cancel для отмены любых изменений и возврата к 

кнопке-флажку Export Diagnostic Logs. 

6. В диалоговом окне Export Diagnostic Logs щелкните на Export. 

По умолчанию файл ChromLabLog.zip сохраняется на рабочем столе ПО 

ChromLab. При необходимости вы можете перейти к другой папке, в которую 

затем можно сохранить файл. 

7. Щелкните на Save для сохранения файла ChromLabLog.zip. 



8   I   Импорт и экспорт данных 

278   |   Хроматографические системы NGC™ и программное обеспечение ChromLab™  
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 9 Отчеты 

Три формата отчетов, поддерживаемые ПО ChromLab, упрощают размещение 

данных методов, протоколов и результатов анализа в подробных отчетах. Отчет об 

одном анализе включает всю информацию об анализе без результатов 

интегрирования пиков. Отчет по методу включает всю информацию о методе. Отчет 

о результатах анализа включает всю информацию в одном отчете об анализе, а 

также перечень включенных анализов и информацию о сравнении линий 

хроматограммы и детектированных пиках. 

Отчеты можно распечатать, не выходя из ПО ChromLab, а также сохранить в 

формате .pdf, .ppt или .doc. 
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Подготовка отчета 

По завершении генерирования данных, которые вы хотите включить в отчет, вы 

можете очень просто с помощью ПО ChromLab создать отформатированный отчет. 

Откорректировать отчет можно с помощью команд и опций диалогового окна 

средства просмотра отчетов Report Viewer. Отчет можно сохранить или распечатать, 

указать формат страницы и выбрать опцию просмотра из нескольких. Также можно 

изменить представление, используя полосу прокрутки в нижнем правом углу 

диалогового окна. 

 
полоса прокрутки 
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Отчеты по методам 

Примечание: Столбец Scout и таблица Scouting Parameters отображается в отчете 

по методу только в том случае, если метод является поисковым. 

Для генерации отчета по методу 

► С отображаемым протоколом анализа, методом или результатами анализа 

выберите File > Method Report. 

ПО ChromLab автоматически сгенерирует отформатированный отчет по всем 

данным метода и отобразит отчет в диалоговом окне Report Viewer. 

Примечание: Генерация отчета по методу невозможна, если результаты 

анализа включают данные нескольких анализов. 

Отчеты об анализах 

Для генерации отчета об анализе 

1. В окне Evaluation выберите File > Run Report. 

Диалоговое окно Run Report Options (Опции отчета об анализе) отображает 

перечень опций, которые можно включить в отчет (например, хроматограмма, 

статистика эффективности колонки, сведения о системе, рабочий 

журнал/журнал регистрации событий и аннотации). 

2. ПО ChromLab по умолчанию генерирует отчет об анализе со всеми опциями. 

Отмените выбор кнопок-флажков опций, которые вы не хотите включать в 

отчет об анализе. 

3. Щелкните на кнопке OK. 

ПО ChromLab автоматически сгенерирует отформатированный отчет со всеми 

выбранными опциями и отобразит отчет в диалоговом окне Report Viewer. 
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Отчеты о результатах анализов 

Примечание: Перед созданием отчета о результатах анализа необходимо сначала 

выполнить анализ результатов интегрирования пиков. 

Для генерации отчета о результатах анализа 

1. В окне Evaluation выберите File > Analysis Report. 

Диалоговое окно Analysis Report Options (Опции отчета о результатах анализа) 

отображает перечень столбцов, присутствующих в отображаемой таблице 

пиков. 

2. Выберите кнопки-флажки столбцов, которые будут включены в отчет о 

результатах анализа. 

Примечание: Предельное количество столбцов – 12. 

3. Щелкните на кнопке OK. 

ПО ChromLab автоматически сгенерирует отформатированный отчет по 

выбранным столбцам, а также параметрам пиков и хроматограмме. Отчет о 

результатах анализа появится в диалоговом окне Report Viewer. 

Если производился сбор фракций, в отчете будут представлены таблица 

фракций и все ее отображаемые столбцы в виде отдельной таблицы. 

Смешанные фракции будут представлены в отчете в виде строки в таблице 

фракций. Фракции в группе отображаются в виде отдельных вводов под 

строкой смешанных фракций. 

Совет: В отчете о результатах анализа появятся также результаты сравнений 

линий хроматограммы (если есть) в результатах анализа интегрирования 

пиков. 

Распечатка отчета 

Для распечатки отчета 

► С отчетом, отображаемым в диалоговом окне Report Viewer, щелкните на Print 

(Распечатать) на панели инструментов, выберите принтер и щелкните на Print. 
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Сохранение отчета 

Для сохранения отчета 

► С отчетом, отображаемом в диалоговом окне Report Viewer, щелкните на Save 

и выберите формат файла, из раскрывающегося списка. 

Появится диалоговое окно Export Settings (Настройки экспорта). Данное 

диалоговое окно можно развернуть для отображения подробных настроек. 

Доступные настройки зависят от выбранного формата печати. 
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 A Управление базой данных 

Программное обеспечение ChromLab хранит все данные (например, методы, 

шаблоны и протоколы анализов) в базе данных, расположенной на сервере Microsoft 

SQL Server 2008 R2. Компания Bio-Rad настоятельно рекомендует регулярно 

создавать резервную копию базы данных. Также рекомендуется резервное 

копирование базы данных на различные накопители, на одном из которых 

выполняется ПО ChromLab. 

Если предотвращение потери данных критично для выполняемой вами операции, 

рассмотрите установку ПО ChromLab на RAID 1 массив. Данный массив произведет 

запись данных одновременно на два жестких диска. При отказе одного жесткого 

диска данные сохранятся на резервном диске. 

Процедура резервного копирования сохраняет базу данных NGC в файл формата 

zip (.bak). Размер файла .bak приблизительно равен размеру файла базы данных 

NGC. Для сохранения файла .bak свободное дисковое пространство должно быть, 

по крайней мере, равно размеру базы данных NGC. Для восстановления базы 

данных требуется свободное дисковое пространство, равное размеру файла .bak. 

Для резервного копирования и восстановления базы данных NGC используйте 

программу администрирования программного обеспечения ChromLab Administration. 

Программа ChromLab Administration создает резервную копию всех данных NGC, 

включая методы, протоколы анализов и результаты анализов. 

Важно: Программа ChromLab Administration осуществляет резервное копирование 

только текущей базы данных NGC. Данное программное средство не может быть 

использовано для резервного копирования базы данных 1.0 или 2.0. Кроме того, 

программа ChromLab Administration восстанавливает только текущие данные NGC. 

Данное программное средство также не может быть использовано для 

восстановления базы данных NGC, резервная копия которой была создана с 

использованием программных средств сторонних производителей, таких как 

SQLBackupAndFTP или SQL Backup Pro. 
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Резервное копирование базы данных NGC 

Запустить программу ChromLab Administration невозможно, пока ПО ChromLab 

выполняется на клиентском компьютере. Перед созданием резервной копии базы 

данных NGC убедитесь, что ПО ChromLab не выполняется на клиентском 

компьютере, и прибор NGC находится в холостом режиме, то есть не выполняются 

никакие операции в ручном режиме и по выбранному методу. 

Примечание: Для запуска программы ChromLab Administration на компьютере, 

работающем под управлением ПО ChromLab, необходимо иметь права 

администратора Windows. 

Для резервного копирования базы данных ChromLab 

1. Определите размер базы данных NGC, если это еще не сделано. 

а. Перейдите к C:\ProgramData\Bio-Rad\NGC\Database. 

б. Щелкните правой кнопкой мыши на папке Database и выберите Properties. 

в. В закладке General отметьте значение в поле Size (Размер). 

Убедитесь, что диск, на который вы планируете сохранить zip-файл с 

резервной копией, имеет свободное место, по крайней мере, равное размеру 

базы данных NGC. 

2. В меню Start выберите ChromLab > ChromLab Administration. 

 

3. В области Backup (Создать резервную копию) щелкните на Browse для 

перехода к местоположению, в котором будет сохранен файл с резервной 

копией (.bak). 

../AppData/ProgramData/Bio-Rad/NGC/Database
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4. Щелкните на Backup. 

Появится строка состояния, отображающая ход выполнения резервного 

копирования. В зависимости от размера вашей базы данных, операция 

резервного копирования может занять некоторое время. 

5. По завершении резервного копирования закройте программу ChromLab 

Administration. 

6. Запустите ПО ChromLab на клиентском компьютере. 

Совет: Запустить ПО ChromLab на клиентском компьютере невозможно, пока 

выполняется программа ChromLab Administration. 

Восстановление базы данных NGC 

Важно: Перед восстановлением базы данных NGC закройте ПО ChromLab на 

компьютере и выключите прибор NGC. 

Примечание: Для запуска программы ChromLab Administration на компьютере, 

работающем под управлением ПО ChromLab, необходимо иметь права 

администратора Windows. 

Для восстановления базы данных ChromLab 

1. Определите размер zip-файла с резервной копией базы данных NGC, если это 

еще не сделано. 

а. Перейдите к диску, на котором вы сохранили zip-файл с резервной копией 

базы данных NGC. 

б. Щелкните правой кнопкой мыши на файле с резервной копией и выберите 

Properties. 

в. В закладке General отметьте значение в поле Size (Размер). 

Убедитесь, что диск, на который вы планируете восстановить базу данных 

NGC, имеет свободное место, по крайней мере, равное размеру базы данных 

NGC. 

2. В меню Start выберите ChromLab > ChromLab Administration. 

3. В области Restore (Восстановить) щелкните на Browse для перехода к 

местоположению, в котором был сохранен файл с резервной копией базы 

данных NGC (.bak). 

4. Щелкните на Restore. 

Появится строка состояния, отображающая ход выполнения восстановления. 

В зависимости от размера вашей базы данных, операция восстановления 

может занять некоторое время. 
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5. По завершении восстановления закройте программу ChromLab Administration. 

6. Выполните повторный запуск прибора NGC. 

7. Запустите ПО ChromLab на клиентском компьютере. 

Совет: Запустить ПО ChromLab на клиентском компьютере невозможно, пока 

выполняется программа ChromLab Administration. 
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 В Многоколоночная очистка 

Процедура очистки белков может включать сложные процессы разделения сложных 

смесей, не способные обеспечить достаточное отделение целевых белков от 

примесей за один этап хроматографической процедуры. Для таких случаев могут 

потребоваться несколько отдельных экспериментов с использованием нескольких 

колонок и наполнителей с различным химическим составом. 

Процедура многоколоночной очистки объединяет в одном отдельном протоколе ряд 

последовательно или тандемно установленных колонок, обычно с наполнителями с 

различным химическим составом. В один протокол, использующий несколько 

колонок, можно включить наиболее широко распространенные методы очистки 

белков, обеспечив удобство рутинной очистки белков за счет автоматизации 

процесса. Типичным примером мнококолоночной хроматографической схемы 

очистки является аффинная очистка с использованием таких аффинных меток, как 

гистидин (His) или глутатион-S-трансфераза (GST), с последующим выполнением 

одного или нескольких экспериментов, включающих колонки для эксклюзионной 

хроматографии для обессоливания или удаления агрегатов, или ионообменные 

колонки для разделения сложных смесей. 

Для упорядочивания комбинации таких различных хроматографических методов 

требуется автоматизированная хроматографическая система с гибкой конструкцией 

и адаптивным управляющим программным обеспечением. Гибкие 

хроматографические системы NGC™ с возможностью расширения легко 

адаптируются, обеспечивая соответствие вашим требованиям к многоколоночной 

очистке. 
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Шаблоны методов многоколоночной очистки 

Программное обеспечение ChromLab включает несколько шаблонов 

многоколоночной очистки. Шаблоны включают предварительно 

запрограммированные методы для связывания и элюирования образцов из колонок 

в автоматической последовательности. Они также предлагают методики 

многомерной хроматографии, где целевая фракция, элюированная из одной 

колонки, загружается на другую, чтобы подвергнуться очистке «во втором 

измерении». 

Вы можете адаптировать предварительно запрограммированные шаблоны к своим 

требованиям, определив, среди прочего, следующие переменные: 

■ Тип и размер колонки для используемого образца 

■ Базовые единицы измерения метода 

■ Объем образца 

■ Размер и продолжительность шага 

Шаблоны многоколоночной последовательной очистки 

Последовательное связывание и элюирование используется при очистке нескольких 

образцов на нескольких колонках. Образцы впрыскиваются последовательно или с 

помощью насоса для образца с клапаном выбора образца, или через 

пробоотборные петли. Каждый образец загружается на колонку и промывается для 

удаления загрязнений, способных ухудшить свойства образца. Затем с колонок 

производится элюирование с последовательным использованием протоколов 

ступенчатого или линейного градиента. Сбор фракций производится с помощью 

коллектора фракций BioFrac™ или выходного клапана. Шаблоны последовательной 

очистки, главным образом, используют аффинные методы, но могут быть 

перенастроены на включение других технологий. 

Таблица 7 на стр. 291 определяет шаблоны многоколоночной последовательной 

очистки. 
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Таблица 7. Шаблоны многоколоночной последовательной очистки 

Имя шаблона Описание шаблона 

Affinity (1 ml) — Linear Gradient 

(Аффинность (1 мл) — линейный 

градиент) 

Данный метод используется для быстрой очистки множества 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка образца на отдельные колонки для 

аффинной хроматографии и вымывание несвязавшегося 

материала в быстрой последовательности. Данный процесс может 

быть повторен для нескольких (до пяти) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на целевой 

белок. Затем производится последовательное элюирование 

целевых белков из каждой колонки в режиме линейного градиента. 

Affinity (1 ml) - Step (Manual Load) 

(Аффинность (1 мл) - шаг 

(ручная загрузка)) 

Данный метод используется для быстрой очистки множества 

образцов. С помощью клапана с пробоотборной петлей (клапан 

переключения колонок, подключенный к инжекционному клапану в 

положении петли, с несколькими пробоотборными петлями) 

производится загрузка образца на отдельные колонки для 

аффинной хроматографии и вымывание несвязавшегося 

материала в быстрой последовательности. Данный процесс может 

быть повторен для нескольких (до пяти) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на целевой 

белок. Затем производится последовательное элюирование 

целевых белков из каждой колонки в режиме ступенчатого 

градиента. 

Affinity (1 ml) — Step Gradient 

(Аффинность (1 мл) — 

ступенчатый градиент) 

Данный метод используется для быстрой очистки множества 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка образца на отдельные колонки для 

аффинной хроматографии и вымывание несвязавшегося 

материала в быстрой последовательности. Данный процесс может 

быть повторен для нескольких (до пяти) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на целевой 

белок. Затем производится последовательное элюирование 

целевых белков из каждой колонки в режиме ступенчатого 

градиента. 

Affinity (5 ml) — Linear Gradient 

(Аффинность (5 мл) — линейный 

градиент) 

Данный метод используется для быстрой очистки множества 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка образца на отдельные колонки для 

аффинной хроматографии и вымывание несвязавшегося 

материала в быстрой последовательности. Данный процесс может 

быть повторен для нескольких (до пяти) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на целевой 

белок. Затем производится последовательное элюирование 

целевых белков из каждой колонки в режиме линейного градиента. 
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Таблица 7. Шаблоны многоколоночной последовательной очистки (продолжение) 

Имя шаблона Описание шаблона 

Affinity (5 ml) — Step Gradient 

(Аффинность (5 мл) — 

ступенчатый градиент) 

Данный метод используется для быстрой очистки множества 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка образца на отдельные колонки для 

аффинной хроматографии и вымывание несвязавшегося 

материала в быстрой последовательности. Данный процесс может 

быть повторен для нескольких (до пяти) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на целевой 

белок. Затем производится последовательное элюирование 

целевых белков из каждой колонки в режиме ступенчатого 

градиента. 
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Шаблоны многоколоночной тандемной очистки 

Тандемная очистка используется при объединении двух различных 

хроматографических методов в один. Сначала производится впрыск образцов, 

связывание на колонке и промывка для удаления основных загрязняющих примесей. 

Затем целевые фракции элюируются и либо последовательно попадают на другую 

колонку, либо временно хранятся в пробоотборной петле или контейнере. 

Находящиеся на хранении фракции впоследствии снова впрыскиваются на вторую 

колонку. В любом случае, со второй колонки затем производится элюирование, и 

очищенные фракции собираются коллектором фракций BioFrac или выходным 

клапаном. Шаблоны многоколоночной тандемной очистки программного 

обеспечения ChromLab используют методы аффинной и эксклюзионной 

хроматографии, а также обессоливания, но могут быть перенастроены на включение 

других технологий. 

Таблица 8 определяет шаблоны многоколоночной тандемной очистки. 

Таблица 8. Шаблоны многоколоночной тандемной очистки 

Имя шаблона Описание 

2-D Affinity (1 ml) > SEC (24 ml) (2-D 

аффинность (1 мл) > эксклюзионная 

хроматография (24 мл)) 

Данный метод используется для очистки до четырех 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка различных образцов на 

отдельные колонки для аффинной хроматографии и 

вымывание несвязавшегося материала в быстрой 

последовательности. Данный процесс может быть повторен 

для нескольких (до четырех) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на 

целевой белок. Затем производится последовательное 

элюирование целевых белков из каждой колонки в режиме 

ступенчатого градиента. Элюированная фракция хранится в 

клапане с пробоотборной петлей. Фракция затем 

впрыскивается на колонку для эксклюзионной хроматографии 

для финального аналитического или препаративного этапа 

очистки. 
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Таблица 8. Шаблоны многоколоночной тандемной очистки (продолжение) 

Имя шаблона Описание 

2-D Affinity (5 ml) > Desalting (50 ml)  

(2-D аффинность (5 мл) > 

обессоливание (50 мл)) 

Данный метод используется для очистки до четырех 

образцов. С помощью клапана выбора образца и насоса для 

образца производится загрузка различных образцов на 

отдельные колонки для аффинной хроматографии и 

вымывание несвязавшегося материала в быстрой 

последовательности. Данный процесс может быть повторен 

для нескольких (до четырех) колонок. Данный метод 

предназначен для ослабления воздействия протеаз на 

целевой белок. Затем производится последовательное 

элюирование целевых белков из каждой колонки в режиме 

ступенчатого градиента. Элюированная фракция хранится в 

клапане с пробоотборной петлей (клапан переключения 

колонок, подключенный к портам пробоотборной петли на 

инжекционном клапане, с несколькими пробоотборными 

петлями). Фракция затем впрыскивается на обессоливающую 

колонку для замены буфера или удаления солей. 

Аффинность (1 мл) > обессоливание 

(10 мл) 

Данный метод используется для очистки до пяти образцов.  

С помощью клапана выбора образца и насоса для образца 

производится загрузка различных образцов на отдельные 

колонки для аффинной хроматографии и вымывание 

несвязавшегося материала в быстрой последовательности. 

Данный процесс может быть повторен для нескольких (до 

пяти) колонок. Данный метод предназначен для ослабления 

воздействия протеаз на целевой белок. Затем производится 

последовательное элюирование целевых белков из каждой 

колонки в режиме ступенчатого градиента. Фракция затем 

немедленно проходит через обессоливающую колонку для 

замены буфера или удаления солей. 

Аффинность (5 мл) > обессоливание 

(50 мл) 

Данный метод используется для очистки до пяти образцов.  

С помощью клапана выбора образца и насоса для образца 

производится загрузка различных образцов на отдельные 

колонки для аффинной хроматографии и вымывание 

несвязавшегося материала в быстрой последовательности. 

Данный процесс может быть повторен для нескольких (до 

пяти) колонок. Данный метод предназначен для ослабления 

воздействия протеаз на целевой белок. Затем производится 

последовательное элюирование целевых белков из каждой 

колонки в режиме ступенчатого градиента. Фракция затем 

немедленно проходит через обессоливающую колонку для 

замены буфера или удаления солей. 
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Выполнение многоколоночной хроматографической 
очистки 

Для выполнения многоколоночной хроматографической очистки на системе NGC 

необходимо: 

■ Подключить систему NGC 

■ Заполнить систему NGC 

■ Выбрать и сохранить шаблон метода 

■ Выполнить анализ по выбранному методу 

Подключение системы NGC 

Способ настройки и подключения системы NGC зависит от типа метода, который вы 

планируете использовать. В данном разделе приведена информация о подключении 

системы для работы с шаблонами многоколоночной очистки. 

Подключение систем NGC Discover Pro 

Данная таблица приводит перечень задач, которые необходимо выполнить при 

подключении систем NGC Discover™ Pro. Подробные инструкции приведены в 

главе 5 «Подключение и заполнение хроматографических систем NGC» в 

руководстве по установке программного обеспечения хроматографических систем 

NGC. 

Подключение систем NGC Discover Pro 
 

 Задача 

1. Трубка 6 – между выходным портом клапана выбора образца и 

входным портом насоса для образца 

Примечание: Отсоедините входную трубку от впускного коллектора 

насоса для образца, если она установлена. 

2. Выполните одно из следующих подключений: 

■ Трубка 4 – от входного порта Common отводного клапана 

коллектора фракций BioFrac к порту 1 выходного клапана 

■ Сливная трубка – к порту 1 выходного клапана 

3. Входные трубки – к оставшимся портам клапана выбора образца 

4. Выходные трубки – к оставшимся портам выходного клапана 
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Подключение системы NGC Discover Pro для работы с шаблонами 
многоколоночной очистки 

Таблицы в данном разделе перечисляют дополнительные задачи для подключения 

систем NGC Discover Pro для выполнения процедур многоколоночной очистки. 

Перед продолжением убедитесь, что выполнены все задачи по подключению, 

перечисленные в разделе «Подключение систем NGC Discover Pro» на стр. 295. 

Совет: Для данных шаблонов требуется использование схемы жидкостного тракта 

или NGC Discover Pro, или NGC Discover Pro +1CSV (клапан переключения колонок). 

Шаблоны многоколоночной аффинной последовательной очистки в режимах 

ступенчатого и линейного градиента 

 Задача 

► Колонки для аффинной хроматографии – порты 1-5 клапана 

переключения колонок 1 (C1) 

Шаблон многоколоночной аффинной последовательной очистки в режиме 

ступенчатого градиента (ручная загрузка) 

 Задачи 

1. Установите второй клапан переключения колонок (именуемый «клапан с 

пробоотборной петлей») рядом с инжекционным клапаном на приборе 

NGC и пометьте его как «C2» 

2. Короткая трубка – от порта F инжекционного клапана к левому входному 

порту клапана с пробоотборной петлей (C2) 

3. Короткая трубка – от порта F инжекционного клапана к правому 

входному порту клапана с пробоотборной петлей (C2) 

4. Одна трубка пробоотборной петли 5 мл для каждой колонки для 

аффинной хроматографии – к верхнему и нижнему портам клапана с 

пробоотборной петлей (C2) 

Например, если ваша система включает две колонки для аффинной 

хроматографии: 

■ Подсоедините трубку пробоотборной петли к верхнему порту 

колонки 1 и нижнему порту колонки 1 

■ Подсоедините трубку пробоотборной петли к верхнему порту 

колонки 2 и нижнему порту колонки 2 

5. Трубка от порта 2 выходного клапана – к порту насоса для образца на 

инжекционном клапане 

6. Колонки для аффинной хроматографии – к портам 1-5 клапана C1 
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Шаблоны многоколоночной 2-D аффинной тандемной очистки 

 Задачи 

1. Установите второй клапан переключения колонок (именуемый «клапан 

с пробоотборной петлей») рядом с инжекционным клапаном на 

приборе NGC и пометьте его как «C2» 

2. Короткая трубка – от порта F инжекционного клапана к левому 

входному порту клапана с пробоотборной петлей (C2) 

3. Короткая трубка – от порта F инжекционного клапана к правому 

входному порту клапана с пробоотборной петлей (C2) 

4. Одна трубка пробоотборной петли 5 мл для каждой колонки для 

аффинной хроматографии – к верхнему и нижнему портам клапана с 

пробоотборной петлей (C2) 

Например, если ваша система включает две колонки для аффинной 

хроматографии: 

■ Подсоедините трубку пробоотборной петли к верхнему порту 

колонки 1 и нижнему порту колонки 1 

■ Подсоедините трубку пробоотборной петли к верхнему порту 

колонки 2 и нижнему порту колонки 2 

5. Трубка от порта 2 выходного клапана – к порту шприца на 

инжекционном клапане 

6. Колонки для аффинной хроматографии – к портам 1-4 клапана C1 

7. Обессоливающая колонка или колонка для эксклюзионной 

хроматографии – порт 5 клапана C1 

Шаблоны многоколоночной аффинной тандемной очистки 

 Задачи 

1. Установите второй клапан переключения колонок (C2) на прибор NGC 

2. Короткая трубка системы капилляров – от выходного порта клапана 

C1 к входному порту клапана C2 

3. Короткая трубка системы капилляров – от выходного порта клапана 

C2 к УФ-детектору 

4. Колонки для аффинной хроматографии – к портам 1-5 клапана C1 

5. Обессоливающая колонка – порт 5 клапана C2 
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Заполнение системы NGC 

Важно: Каждый раз при добавлении или удалении модуля, или изменении, или 

обновлении аппаратной конфигурации вашей системы NGC необходимо 

производить повторное подключение системы капилляров и повторное заполнение 

системы. 

Для заполнения системы 

1. Включите систему NGC и подключенный к ней компьютер. 

2. Для перехода на ручной режим выполните одно из следующих действий: 

■ На компьютере щелкните на Manual Run (Анализ в ручном режиме) в окне 

Home ПО ChromLab или щелкните на закладке System Control, а затем – 

на схеме жидкостного тракта. 

■ На сенсорном экране щелкните на Enter Manual Mode (Перейти на ручной 

режим), если система еще не находится в ручном режиме. 

3. (Опционально) Если аппаратная конфигурация была изменена, выберите 

схему жидкостного тракта, соответствующую текущей конфигурации системы. 

а. Выберите Tools > Change Fluidic Scheme. 

б. Выберите соответствующую схему жидкостного тракта в секции Fluidic 

Scheme Selector. 

в. Щелкните на Select (Выбрать) для выбора схемы жидкостного тракта в 

ручном режиме. 

4. Опустите соответствующие впускные линии в буфер, раствор для хранения 

и/или очищающие растворы, которыми будет заполнена и промыта система. 

5. Заполните систему. 

Подробные инструкции приведены в главе 5 «Подключение и заполнение 

хроматографических систем NGC» в руководстве по установке 

хроматографических систем NGC и программного обеспечения ChromLab. 
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Выбор и сохранение шаблона 

Совет: Перед использованием шаблона необходимо сохранить его в качестве 

метода. 

Для выбора шаблона метода и сохранения его в качестве метода 

1. В ПО ChromLab на компьютере выполните одно из следующих действий: 

■ В окне Home щелкните на Open Method Template (Открыть шаблон 

метода). 

■ В окне Method Editor щелкните на Open Template на панели инструментов. 

Появится диалоговое окно Open Template. Шаблоны стандартных методов 

располагаются в папках по методикам. 

 

2. В левой секции окна щелкните или на папке Multicolumn Sequential, или на 

папке Multicolumn Tandem, и выберите шаблон из списка, который появится в 

верхней правой секции окна. 
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В нижней правой секции окна: 

■ Закладка Overview содержит графическое представление шагов очистки 

для выбранного шаблона. 

■ Закладка Gradient отображает градиентную кривую для выбранного 

шаблона. 

■ Закладка Notes отображает пояснительный текст, который можно 

отредактировать в представлении настроек метода. 

3. Для открытия шаблона в окне Method Editor дважды щелкните на его имени. 

4. В представлении настроек метода в секции Phase Parameters отредактируйте 

общие настройки, такие как тип колонки, базовые единицы измерения метода и 

длину волны. 

5. Выберите File > Save As для открытия диалогового окна Save Method As. 

6. Выберите папку проекта или создайте новый подпроект или корневой проект, в 

котором будет сохранен метод. 

7. Введите имя для нового метода и щелкните на Save. 

Выполнение анализов по выбранным методам 
многоколоночной очистки 

Анализы по методам многоканальной очистки выполняются аналогично анализам по 

регулярным методам. Подробные инструкции приведены в разделе «Выполнение 

анализа по выбранному методу и сбор фракций» на стр. 177. 
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